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BY DOWNLOADING, INSTALLING OR USING THE SOFTWARE, YOU
AGREE TO BE BOUND BY THIS END USER LICENSE AGREEMENT
(THE “AGREEMENT"). IF YOU DO NOT AGREE, DO NOT INSTALL,
COPY OR USE THE SOFTWARE; YOU MUST DELETE OR DESTROY
ANY COPY IN YOUR POSSESSION OR CONTROL. This Agreement is
between you (“you” or “your”) and UTC Fire & Security Americas
Corporation, Inc. (“Licensor”) for the Software that accompanies this
Agreement, including all associated media, printed or electronic
documentation (collectively, the “Software”).

LIMITED ACCESS SOFTWARE: IF YOU HAVE OBTAINED A TRIAL
VERSION OF THE SOFTWARE, YOUR ACCESS TO THE SOFTWARE



WILL BE LIMITED AND YOU WILL NOT BE ABLE TO TAKE
ADVANTAGE OF ALL OF THE SOFTWARE FEATURES UNLESS YOU
OBTAIN A FULL LICENSE. TO OBTAIN ACCESS TO ADDITIONAL
FEATURES, YOU MUST PURCHASE A FULL LICENSE FROM
LICENSOR AND OBTAIN A KEY/CODE TO UNLOCK THE ADDITIONAL
FEATURES.

FOR THE SAKE OF CLARITY, THE AGREEMENT SHALL APPLY TO
THE SOFTWARE, WHICH INCLUDES BOTH THE TRIAL VERSION AND
THE FULL LICENSED VERSION.

1. License Grants. During the term of this Agreement and conditioned
upon your full compliance with all of the Agreement’s terms and conditions,
Licensor grants to you the following licenses:

1.1. Software. Licensor grants to you a personal, nonexclusive,
nonsublicensable, nontransferable revocable license to install and use
the Software on any computer or similar device, such as a network
server used to install or run the Software on other computers over a
computer network.

1.2 Documentation. Licensor grants to you a personal, nonexclusive,
nonsublicensable, nontransferable, revocable license to make and use
a reasonable number of copies of documentation provided with the
Software for your internal use in connection with your use of the
Software; provided that you reproduce all copyright and other
proprietary notices that are on the original copies.

2. License Limitations. The license(s) granted in Section 1 are
conditioned upon your compliance with the following limitations:

2.1 Reverse Engineering. You may not decompile, decipher, disassemble,
reverse engineer or otherwise attempt to access source code of the
Software, or circumvent any technical limitations in the Software that
limit or restrict access to or use of the Software or any content, file, or
other work, except as expressly permitted by applicable law
notwithstanding this limitation.

2.2 No Distribution, Rental or Transfer. You may not distribute, publish,
rent, lease, lend, transfer, sublicense, disclose or otherwise provide the
Software to any third party, except that the initial user of the Software
may make a one-time permanent transfer of this Agreement and
Software to another end user, provided the initial user retains no copies
of the Software. This transfer must include all of the Software
(including all component parts, the media and printed materials,
documentation, any upgrades and this Agreement). The transfer may
not be an indirect transfer, such as a consignment. Before the transfer,
the end user receiving the Software must agree to all the terms and
conditions of this Agreement. Prior to any such transfer, you must
notify Licensor in writing of the name and address of the new end user.

2.3 No Modification or Derivative Works. You may not modify or create
derivative works of the Software, in whole or in part.

2.4 Proprietary Notices. You may not remove any proprietary notices or
labels on the Software or any copy thereof.

2.5 Non-Permitted Uses. Without limiting any of the foregoing, you may not
make any use of the Software in any manner not expressly permitted
by this Agreement.

2.6 Not for Resale Software. Software identified as “Not For Resale” or
“NFR,” may not be sold or otherwise transferred for value, or used for
any purpose other than demonstration, testing or evaluation.

3. Reservation of Rights and Ownership. Licensor, its parent or its
suppliers own all right, title and interest, including all intellectual property
rights, in and to the Software and reserve all rights not expressly granted to



you in this Agreement. The Software is protected by copyright and other
intellectual property laws and treaties. All trademarks, logos, and service
marks (collectively, “Marks”) displayed on the Software are the property of
Licensor or of their respective holders. You are not permitted to use any of
the Marks without the applicable prior written consent of Licensor or such
respective holders.

4. Additional Software or Services. This Agreement applies to any
updates, supplements or add-on components to the Software as well as
any services accessed through the Software or internet-based service
components (if any) of the Software that Licensor may, in its sole
discretion, provide or make available to you (“Update”). If Licensor provides
additional terms along with the Update, those terms will apply to the
Update. If Licensor provides you an Update, Licensor may, at its sole
discretion, require you to use Update and cease use of early versions.
Licensor reserves the right to discontinue any internet-based service (if
any) provided or made available to you through the use of the Software.

5. Termination. This Agreement will automatically terminate upon your
breach of any of this Agreement’s terms and conditions. You may
terminate this Agreement by removing the Software from your device(s). In
the event of termination, you must immediately destroy all copies of the
Software, whether on your device or otherwise in your possession. The
following Sections of this Agreement will survive termination: Sections 2, 3
and 5to 11.

6. WARRANTIES AND DISCLAIMERS.

6.1. Limited Warranty. Licensor warrants that, for a period of one (1) year
from the date of receipt of the Software, the Software will perform
substantially in accordance with the documentation that accompanies
the Software. If the Software fails to comply with this limited warranty,
Licensor will at its option either (a) repair or replace the Software or (b)
return the price you paid. This limited warranty is void if failure of the
Software results from accident, abuse, modification, misapplication,
misuse, abnormal use or a virus. This warranty will apply to any
replacement Software for the remainder of the original limited warranty
period or 30 days, whichever period is longer. You agree that the
limited warranty in this Section is your sole and exclusive warranty and
remedy with respect to the Software.

6.2 DISCLAIMER OF WARRANTIES. EXCEPT AS SET FORTH IN
SECTION 6.1, TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW THE SOFTWARE IS PROVIDED AS IS AND
WITH ALL FAULTS. LICENSOR AND ITS PARENT, AFFILIATES
AND SUPPLIERS HEREBY DISCLAIM ALL OTHER WARRANTIES
AND CONDITIONS, WHETHER EXPRESS, IMPLIED OR
STATUTORY, INCLUDING ANY IMPLIED WARRANTIES, DUTIES
OR CONDITIONS OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. ALSO, THERE IS NO WARRANTY OR
CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION,
CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT,
LACK OF VIRUSES OR BUGS, ACCURACY OR COMPLETENESS
OF RESPONSES OR RESULTS WITH REGARD TO THE
SOFTWARE. LICENSOR AND ITS PARENT, AFFILIATES AND
SUPPLIERS DO NOT WARRANT THAT THE OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE OR
THAT ANY DEFECTS WILL BE CORRECTED. THE ENTIRE RISK
ARISING OUT OF THE SOFTWARE REMAINS WITH YOU.

7. EXCLUSIONS OF CERTAIN DAMAGES; Limitations of Liability. In
no event WILL Licensor or its parent, affiliates OR suppliers be liable
for any special, incidental, punitive, indirect or consequential



damages (including damages for loss of profits, DAMAGES TO ANY
COMPUTER, DEVICE, OR SYSTEM, LOSS OF DATA, goodwill, use or
other losses) arising out of or in any way related to the SOFTWARE or
this AGREEMENT, REGARDLESS OF the CAUSE OF ACTION OR THE
BASIS OF THE CLAIM and even if Licensor has been advised of the
possibility of the damages OR REMEDIES FAIL OF THEIR ESSENTIAL
PURPOSE.

LICENSOR’S AND ITS PARENT'’S, AFFILIATES’ AND SUPPLIERS’
ENTIRE LIABILITY UNDER THIS AGREEMENT AND YOUR EXCLUSIVE
REMEDY WILL BE LIMITED TO THE ACTUAL DAMAGES YOU INCUR
IN REASONABLE RELIANCE ON THE SOFTWARE UP TO THE PRICE
YOU PAID FOR THE SOFTWARE. NO ACTION, REGARDLESS OF
FORM, relating to the software MAY BE BROUGHT BY YOU MORE
THAN ONE YEAR AFTER YOU HAVE KNOWLEDGE OF THE
OCCURRENCE WHICH GIVES RISE TO THE CAUSE OF ACTION.

8. (Outside of the USA) Consumer End Users Only. The limitations or
exclusions of warranties and liability contained in this Agreement do not
affect or prejudice the statutory rights of a consumer (i.e., a person
acquiring goods otherwise than in the course of a business). The
limitations or exclusions of warranties, remedies or liability contained in this
Agreement shall apply to you only to the extent such limitations or
exclusions are permitted under the laws of the jurisdiction where you are
located.

9. Third Party Software. The Software may contain third party software
which requires notices and/or additional terms and conditions. Such
required third party software notices and/or additional terms and conditions
are available from the third party software provider, and are more a part of
and incorporated by reference into this Agreement. Certain items of
independent third party code may be included in the Software that is
subjected to open source licenses (“Open Source Software”). The Open
Source Software is licensed under the terms of the license that accompany
such Open Source Software. Nothing in this Agreement limits your rights
under, or grants you rights that supersede the terms and conditions of any
applicable end user license for such Open Source Software.

10. Indemnification. You agree to defend, indemnify and hold harmless
Licensor and its parent, affiliates and suppliers and their respective officers,
directors and employees from all claims and expenses (including attorneys’
fees and costs) that arise out of or in connection with your use of the
Software, any breach of this Agreement, or your violation of any laws or
regulations or the rights of any third party.

11. U.S. Government License Rights. Software provided to the U.S.
Government pursuant to solicitations issued on or after December 1, 1995
is provided with the commercial license rights and restrictions described in
this Agreement. Software provided to the U.S. Government pursuant to
solicitations issued prior to December 1, 1995 is provided with “Restricted
Rights” as provided for in FAR, 48 CFR 52.227-14 (JUNE 1987) or DFAR,
48 CFR 252.227-7013 (OCT 1988), as applicable.

12. Compliance with Law; Export Restrictions. You will comply with all
applicable international and national laws, rules and regulations that apply
to the Software and your use of the Software, including the U.S. Export
Administration Regulations, as well as end user, end use, and destination
restrictions issued by U.S. or other governments. You acknowledge that the
Software is of U.S. origin and subject to U.S. export jurisdiction.

13. Governing Law and Jurisdiction. This Agreement will be construed
and controlled by the law of the State of New York, without giving effect to
its conflict of law provisions. Each party consents to exclusive jurisdiction

and venue in the state and federal courts in the State of New York for any



Licensor information

and all disputes, claims and actions arising from or in connection with the
Software and this Agreement. The United Nations Convention on Contracts
for the International Sale of Goods does not apply to this Agreement.
Notwithstanding the above sentences of this Section 13, if you are a state,
county, parish, or municipal governmental entity, division or unit within the
United States, then this Agreement will be construed and controlled by the
laws of your state and each party consents to exclusive jurisdiction and
venue in the state and federal courts in your state for any and all disputes,
claims and actions arising from or in connection with the Software and this
Agreement.

14. General. The section titles in this Agreement are used solely for the
parties’ convenience and have no legal or contractual significance. Any list
of examples following "including” or "e.g.," is illustrative and not exhaustive,
unless qualified by terms like "only" or "solely." Licensor’s failure to act with
respect to a breach by you or others does not waive its right to act with
respect to subsequent or similar breaches. No waiver of any provision of
this Agreement will be effective unless it is in a signed writing, and no
waiver will constitute a waiver of any other provision(s) or of the same
provision on another occasion. If a court of competent jurisdiction holds any
term, covenant or restriction of this Agreement to be illegal, invalid or
unenforceable, in whole or in part, the remaining terms, covenants and
restrictions will remain in full force and effect and will in no way be affected,
impaired or invalidated. You may not assign, transfer or sublicense this
Agreement or your rights (if any) under this Agreement. This Agreement will
be binding upon all successors and assigns. This Agreement constitutes
the entire agreement between you and Licensor with respect to the
Software and merges all prior and contemporaneous communications and
proposals, whether electronic, oral or written, between you and Licensor
with respect to the Software. All notices to Licensor in connection with this
Agreement must be in writing and will be deemed given as of the day they
are deposited in the U.S. mails, postage prepaid, certified or registered,
return receipt requested or sent by overnight courier, charges prepaid to
the address set forth below.

If you have any questions about this Agreement, or want to contact
Licensor for any reason, please direct all correspondence to:

UTC Fire & Security Americas Corporation, Inc.
3211 Progress Drive
Lincolnton, North Carolina 28092, USA

ATTN: Legal Department
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Chapter 1
Introduction

TruVision® Navigator by Interlogix® represents the latest advancement in video
management. The system delivers powerful software capabilities and allows users to
manage their TruVision-based video surveillance systems. TruVision Navigator can be
used as a standalone application or can be deployed as a client/server architecture,
making it scalable for deployment in either small- or large-scale commercial
environments.

Default credentials

The default credentials for TruVision Navigator are:
e User Name —admin
* Password —admin

See “Initial login” on page 19 for further information.

TruVision Navigator user interface

The Navigator user interface is comprised of main window panels and components as
well as buttons that launch program functions and options. See Figure 1 on page 11.

10 TruVision Navigator 8.0 SP2 User Manual



Chapter 1: Introduction

Figure 1: Main window

1 Navigator toolbar. Contains the Navigator main menu drop-down list (includes Settings,
Device Manager, Bookmark Manager, Tasks, Recurring Tasks, Open Exported
Video File, Help, and Logout), the Search field, and the Add Device and Add Folder
buttons

2 Navigator panel. Contains recorders, cameras, decoders, maps, websites, access
control points, intrusion panels, network switches, and logical views that can be
organized within folders.

3 Viewer panel. Multiple tabbed viewing panels (up to 10) can be added by clicking on the
+ button. Click the Custom View button to select and create different video tile layouts
up to 10x10.

4 Event Monitor. A detachable viewing window to view live video from cameras linked to
the notifier.

5 Notifier panel. View real time events coming from TruVision devices. Contains links to

video event notifications as well as the Details button that launches the Event Center
window. Also contains a Filters menu to filter event types shown in the Naotifier.

6 Collector panel. Contains all relevant video segments, snapshots, and local recordings
ready for export. Also contains the Export, Select All, and Trash buttons.

7 System indicators. Contains CPU and Memory usage meters as well as server and
keypad connection status. Move the mouse pointer over the meters to see the
percentage of CPU and amount of memory in current use.

8 Playback controls. Control playback and recording of video.

9 Timeline. Provides a graphical view of recorded video over a period of time. Contains
Live and Sub stream toggle controls, Zoom In/Out, Center TimeLine, Add Bookmark
to Video, Jump to the previous bookmark, Jump to the next bookmark, Bookmarks
show/hide on Timeline, Go To Date, Save Video, Snapshot, PTZ Controls, and Push
to Talk buttons. Color coded video tags are defined in the bottom left underneath the
timeline. See Appendix B “Device details” on page 151 for details on what types of video
tagging is available for applicable devices.

TruVision Navigator 8.0 SP2 User Manual 11



Chapter 1: Introduction

The Navigator and Notifier/Collector panels are resizable by dragging the vertical left or
right splitter bars. Arrow icons on the side of the panels hide or unhide the panel to
provide custom layout styles. Navigator remembers custom panel layouts on logout and
restores them after the next login (see “Custom view” on page 113).

User interface languages

The following languages are supported in Navigator: Arabic, Chinese (Simplified and
Traditional), Czech, Danish, Dutch, English, Finnish, French, German, Hungarian,
Lithuanian, Italian, Polish, Portuguese (Brazilian and European), Russian, Slovak,
Spanish, Swedish, and Turkish.

After launching the Navigator Setup.exe program, the InstallShield Wizard auto-detects
the language setting on the computer and, if it is supported, translates the user
interface to that language. If the language detected is not supported, the InstallShield
Wizard defaults to English. The same auto-detection conditions occur when launching
the Navigator client.

Buttons and indicators

The following table describes the function of each button and indicator in the top-level
view of the Navigator application.

Note: Not all buttons and indicators listed are supported by all devices.

Button Description

Navigator panel

Navigator menu drop-down list that contains the following:
-n- Settings. See “Settings” on page 22.

E Device Manager. See Chapter 4 “Device Manager” on page 51.

.H Bookmark Manager. Edit and delete bookmarks, or play back bookmarked
video. See “Bookmark manager” on page 47.

Tasks. Monitor scheduled tasks such as video exports, database backups,
= and database restores. See “Tasks” on page 47.

£ Recurring Tasks. Monitors video exports created according to a recurring
K./ schedule. See “Recurring tasks” on page 48.

Open Exported Video File. Browse for and launch an exported video in the
Viewer.

o Check for Updates... Click Restart Navigator to restart the application and
apply updates if required.

12 TruVision Navigator 8.0 SP2 User Manual



Chapter 1: Introduction

Button Description

Help. Includes a Help file as well as version, copyright, and end user license
agreement information. Custom Help or training links can be added to this
menu for specific uses. See “Custom Help” on page 26.
Logout. Log out of the Navigator program. Logging out permits another user
to log in on the same machine.

Add Device. Add recorders and cameras to the device panel. See “Adding

devices” on page 66.

— Add Folder. Organize devices in the device panel by adding folders. See “Adding

Viewer panel

folders” on page 90.

W <] =

]

Custom/sequence view. Use custom views to define and save view templates for
future use and set up camera sequencing. See “Custom view” on page 113.

Lock Current Layout. Prevents changes to the current viewer panel setup.

Select all. Select all tiles in the viewer or collector.

Toggle. Toggle between normal view and maximized view.

Close All. Close all tiles in the viewer.

New Viewer. Add a tabbed viewing panel (10 maximum)

Live and Playback stream toggle control.

Main and Sub stream toggle control. See “Stream” on page 123.

Add Bookmark. Add a bookmark with notes to the camera timeline for quick
navigation to a marked incident. See “Bookmarks” on page 111.

Save Video. Send a video segment of the time range selected and highlighted in
green in the timeline to the Collector for export. See “Timeline” on page 109.

Snapshot. See “Snapshot” on page 119.

PTZ control. Launches the PTZ window. See “PTZ control” on page 116.

TruVision Navigator 8.0 SP2 User Manual 13



Chapter 1: Introduction

Button Description

[ Push to Talk. Speak through an attached microphone into a selected recorder or
*x camera that has speakers installed.

Move to previous/Move to next bookmark on the timeline.

Show/Hide bookmarks on the timeline. These icons only appear when a single
video tile is selected.

Zoom In/Out on the timeline. Zoom out to the date level and zoom in to the minute
level.

Center the timeline to the location of the green timeline cursor.

Go To Date of recorded video

Notifier panel

|i| Filters. Select color coded notification filters to see notifications in the Notifier
based on specific criteria.

Event Center. Launches the Event Center, which contains a list of notifications
sent from Navigator devices.

Collector panel

|'_-""'I Export. See “Export video and snhapshots” on page 130.
Select/Deselect All. Select all items in the collector.
] Delete All Collector ltems. Delete all items in the collector.
Admin
s Server Online. Indicates that the server is online in a client/server installation.
|- Server Offline. Indicates that the server is offline. See Chapter 9 “Server offline

mode” on page 132.

— Keypad status. Indicates that the keypad is connected to the client computer.
(] Keypad Not Connected. Indicates that the keypad is not connected to the client
— computer.

Playback controls

The following table describes each playback control in the Navigator application.
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Chapter 1: Introduction

Button Description

Frame Step Reverse. Go to previous frame.

Rewind. Rewind video.

Pause. Pause video.

Play. Play back video. Clicking the Play button multiple times increases playback
speed.

Fast Forward. Fast forward video.

Frame Step Forward. Go to next frame.

Local Record. See “Local record” on page 110.

TruVision Navigator 8.0 SP2 User Manual 15



Chapter 2
Installation

Installation options

There are two installation options for TruVision Navigator. The core features and
functions remain the same regardless of which of the two installation options are
selected.

Standalone model — This installation option permits the client and database to reside
on the same computer. No other clients on the network can connect to the database on
this computer. This installation option is ideal for small, standalone systems.

Multi-client model (traditional client/server) — This installation option permits the
client and server to reside on the same or separate computers. This installation option
is ideal for larger systems with many geographically dispersed users, computers, and
recording devices.

Administrator rights are required to install Navigator on a computer, but the application
is available to any user that successfully logs in to a Windows® account on that
computer.

Installation prerequisites

For each computer:

* Download the latest operating system service pack from the Microsoft Download
Center.

* Check for Windows updates at http://update.microsoft.com.
* Download the latest video driver.

* For the minimum software and hardware requirements, see Appendix A “Minimum
system requirements” on page 144.

16 TruVision Navigator 8.0 SP2 User Manual



Chapter 2: Installation

Installation — standalone mode

To install a new standalone instance of TruVision Navigator:

1.

7.
8.
9.

Double-click the TruVision Navigator Setup.exe installer to begin the installation.
Right-click on the Setup.exe file and select Run as Administrator.

If necessary, click Yes in the User Account Control window to make changes to the
computer.

Ensure that the RSTP port used by all recorders is open so that live video can be
viewed. The default RSTP port is 554.

The End User License Agreement window appears. Select the | Accept these
terms and conditions check box and then click Next to continue.

The Welcome window appears. Select Typical or Advanced (to change the default
installation location), and then click Next.

Advanced installation only: Accept the default installation folder or click ... to select a
different location and then click the Next button.

The Confirm Selections window appears. Click Install.
The WinPcap Setup Wizard appears. Click Next to continue.

The WinPcap License Agreement window appears. Click | Agree to continue.

10.The Installation options window appears. The Automatically start the WinPcap

driver at boot time check box is selected by default. Click Install to continue.

11.Click Finish to continue.

12.Click Close to complete the installation.

Installation — client/server mode

To install a new client/server instance of TruVision Navigator:

1.

Double-click the TruVision Navigator Setup.exe installer to begin the installation. If
prompted, right-click on the Setup.exe file and select Run as Administrator.

Click Yes to make changes to the computer.

The End User License Agreement window appears. Select the | Accept these
terms and conditions check box and then click Next to continue.

The Welcome window displays. Select Advanced for a client/server installation, and
then click Next.

The Installation Folder window appears. Click the Next button to accept the default
installation folder or click ... to select a different location.

The Configuration window appears. Select Client/Server Mode and click Next to
continue.

TruVision Navigator 8.0 SP2 User Manual 17



Chapter 2: Installation

7. The Type of Database window appears. Select Use internal database
(recommended option) and then click Next. If the organization requires use of
Microsoft SQL Server and it is already installed, select Use Microsoft SQL Server
and then click Next.

Note: Interlogix will not be responsible for SQL Server errors or issues.
8. The Confirm Selections window appears. Click Install.
9. The WinPcap Setup Wizard appears. Click Next to continue.
10.The WinPcap License Agreement window appears. Click | Agree to continue.

11.The Installation options window appears. The Automatically start the WinPcap
driver at boot time check box is selected by default. Click Install to continue.

12.Click Finish to continue.
13.Click Close to complete the installation.

Note: Recorders connected to the network must be reachable over the network
from the Navigator server computer. If there are firewalls between the server
computer and the recorder network, make sure to open the following inbound ports
into the recorder network:

1. The HTTP ports used by all recorders on the network.
2. The Command ports used by all recorders on the network.

By default, recorders use 80 for HTTP and 8000 for Command traffic. If the server
computers can’'t connect to the recorders, the following features will not work:

« Automatic Diagnostic Polling.
* Device Health Checking.

Connection details

Click Connection Detalls in the login screen in client/server mode to view and/or
change the default server name and port number, and to test the server connection.

18 TruVision Navigator 8.0 SP2 User Manual



Chapter 2: Installation

Initial login

To log into TruVision Navigator for the first time:

1. After successful installation, launch TruVision Navigator using one of the following
methods:

* Double-click the TruVision Navigator icon on the desktop.
e Go to Start > All Programs/Apps > TruVision Navigator.

2. When TruVision Navigator launches, a login window appears. Log in as the default
administrator by typing in the following default credentials:

+ User Name — admin
« Password — admin

Note: The user name and password are masked by default. Click to reveal the
user name and password.

3. Click Login. After initial login, the Change Password window appears and prompts
you to change the default password for security purposes.

Type the new password in the Password field.
Retype the password in the Confirm Password field.

Select a question from the Challenge Question drop-down list.

N o o B

Type the answer to the challenge question in the Challenge Answer field.
8. Click OK.

If you forget the password set up during initial login, click the Forgot? button in the
Login window to answer the challenge question, change the password, and re-enter the
application without calling for assistance.

If the Challenge Answer cannot be obtained to recover the password, click the
Forgot? button again and call the UTC technical support team with the “tech support
key” automatically provided in the related field. The technical support team can recover
the Challenge Answer with this information.
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Upgrading an existing installation

1.

Double-click the new TruVision Navigator Setup.exe installer to begin the
installation. Right-click on the Setup.exe file and select Run as Administrator.

Click Yes to make changes to the computer.

The End User License Agreement window appears. Select the | Accept these
terms and conditions check box and then click Next to continue.

The Welcome window appears. Select Typical (standalone installation) or
Advanced (for a client/server installation or to change the default installation
location), and then click Next.

Note: See the TruVision Navigator 8.0 SP2 Software Upgrade for Client Computers
Addendum for instructions on upgrading a client computer in a client/server
configuration.

Advanced installation only: The Installation Folder window appears. Click the Next
button to accept the default installation folder or click ... to select a different location.

Advanced installation only: The Configuration window appears. Select the required
configuration mode and then click Next to continue.

The Select Database window appears. Select the Use existing database option
(recommended) and then click Next. If the organization requires use of Microsoft
SQL Server and it is already installed, select Use Microsoft SQL Server and then
click Next.

10.The Confirm Selections window appears. Click Install.

11.Click Close to complete the installation.

Uninstall

To uninstall Navigator:

1.
2.
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Launch the Programs and Features application from the Windows Control Panel.

Navigate to TruVision Navigator and click Uninstall.
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3. Click Yes to make changes to the computer.

4. The Uninstaller window appears. If required, select the Also delete the TruVision
Navigator database check box before clicking Uninstall.

5. The Uninstalling Product window appears, followed by the Product Uninstalled
window. Click Close and restart the computer.

Note: This process removes all TruVision Navigator files and logs from the computer.
No registry edits are necessary to remove Navigator from the computer. The NTP
service and WinPcap programs should also be uninstalled for complete removal of all
files installed during Navigator installation.

TruVision Navigator 8.0 SP2 User Manual
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Click the button at the top of the Navigator panel to display the Navigator main menu
drop-down list.

Settings

For both the standalone and multi-client installation models, the TruVision Navigator
client and server can be configured for specific features using the Settings window.

To access the Settings window, click the Navigator menu button in the Navigator title
bar and then select Settings.

Note: User and/or group permissions are required to see all tabs in the Settings
window. See “Permission models” on page 36 for further information.

The following configuration tabs are available in the Settings window:

22

Client — Includes a variety of settings that apply to each client station.

Server — Includes the SMTP server settings, permission settings, instant replay
duration custom help link settings, and server/client URL information.

Notifications — Includes the port settings necessary to receive events from each
device, email notification settings, and a filter of specific notification types.

Health Diagnostics — Includes a filter of diagnostics to be received, as well as
email settings to receive notifications of diagnostics information. Automatic
diagnostic polling can also be scheduled from this menu.
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Groups and Users — Add new users and user logins, assign permissions, and
create groups in this tab.

Audit History — Set event filters and a time range for viewing user activity.

Logical Event Filtering — Set customized, interdependent notifications from
cameras and TruPortal access control systems.

Client

Client settings apply to each client station. These settings include:

Notifier Sound — Enable the alert sound when new device notifications are
received in the Notifier panel. Click the k button next to the Notifier Sound drop-
down list to preview the selected sound.

Camera Order — Arrange cameras in the Navigator panel by title or number.

Aspect Ratio — Enable the aspect ratio (4:3 or 16:9) for live and playback video in
the Viewer.

Maximum Number of Live Main Streams — Set the maximum number of live main
streams. When set to 0 (zero), only substreams display.

Limit Maximum CPU Usage to — Set the maximum CPU threshold to prevent the
client machine CPU from reaching 100% during video rendering.

Enable Audio From Devices — Turn on audio from applicable devices.

Show Grid Lines in Viewer — Remove/show gridlines between video tiles in the
Viewer.

Display Video Tile Information — Remove/show camera title and time and date.

Pause Background Video — Pause video not running in the current view in
Navigator. This selection closes the video streams that are not currently being
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viewed. Use this setting if bandwidth usage is an issue. There will be a slight delay
when switching to the background views.

Note: Background video remains active for 30 seconds before pausing.

Restore Last View State — Cameras, views, and tile layouts are restored to their
previous state after exiting and restarting Navigator.

Use GPU — Use the computer’s video card to decode video.

Bring Event Monitor Forward — Displays the Event Monitor tab in the Viewer panel
in front of the current view whenever an event occurs. See “Assign to Event
Monitor” on page 104 for details.

Language — Select the preferred language for the user interface in this drop-down
list.

Units — Select Imperial or Metric units of measure.

Server

The Server tab includes the following server settings:

24

SMTP Setup (SMTP Server, Port, Username, Password, Sender Name, SSL,
Test)

Permission Model (see “Permission models” on page 36)
Authentication Complexity

Disable Devices Offline Check checks if recorders are offline. If selected, no
notifications will be received.

Instant Replay Duration
Custom Help Title and Custom Help Link

Database Backup and Database Restore
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e Server URL: Multi-client installations (client/server) only

* Client Download URL: Multi-client installations (client/server) only
» Export Navigator Data and Import Navigator Data

 LDAP Servers: Add and Remove LDAP servers

SMTP setup

Simple Mail Transfer Protocol (SMTP) is a de facto standard for email transmissions
across the Internet. The Navigator server can be configured to use an SMTP server to
send automated email messages (with client download URL, username, and password)
to users when they are created in TruVision Navigator and when their login credentials
(username, password) need to be reset in the system by an administrator. If SMTP is
not set up, this information must be delivered via an alternative method such as phone
or personal email.

To set up SMTP:

1. Typethe SMTP Server IP address, the Port, and any Username and Password
credentials required by the SMTP server.

2. The default email sender name is “TruVision Navigator Server.” Change the sender
name if necessary and select SSL if required by the server.

3. Test this setup by clicking Test and typing a destination email address for the test
message. Check the application status bar for feedback on the test. Also check the
email account to ensure there is a test message from the Navigator server
confirming proper setup of the SMTP server.

4. An email similar to the one below is sent. If not received after several minutes,
check the Junk Mail folder to see if the email was classified and stored there.

Authentication complexity

TruVision Navigator has three authentication complexity standards — Low, Medium, and
High. The default authentication for a new installation is Low. To change the
authentication complexity, select an option from the drop-down list and click OK.
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All new users are required to meet the new authentication complexity standard.
However, existing users of the application are not prompted to change their credentials
to meet the new standard once it is changed. Therefore, the administrator must reset
each of the existing user accounts for the standard to take effect. This reset only affects
the password for that user, not the username. To avoid resets, we recommend setting
the authentication complexity before any users are created in the system.

Table 1 on page 26 outlines the components of each of these standards.

Table 1: Authentication complexity

Authentication [Maximum Username Password Password Password
complexity login failure  |complexity complexity reuse expiration
attempts

Low n/a At least six /At least six n/a n/a
characters characters

Medium 3 At least six At least eight  [n/a n/a
characters alphanumeric
characters

High 3 At least 12 At least eight  [Cannot use the [User must
characters characters with [last password [change
at least: password every

One Upper- 60 days
case letter

One lower-case
letter

One numeric

One special
character (~, !,
@, #, $, %, ",
&, +, =)

Instant replay duration

Navigator supports instant replay from the video tile. This feature rewinds video in a tile
by a user-defined, pre-configured amount of time (30 seconds default, 99 minutes and
59 seconds maximum).

To set instant replay time, type the minutes and seconds or click the spin wheels to
enter the required value in the Instant Replay Duration fields and click OK.

See Appendix B “Device details” on page 151 for limitations on instant replay for each
device.
Custom Help

Custom Help access allows individual organizations to provide their own additional
content to facilitate use of the software. This content is completely user-defined,;
Navigator simply provides a pathway for users to access it.

26 TruVision Navigator 8.0 SP2 User Manual



Chapter 3: Navigator main menu

To add a custom Help link:

1. Inthe Server Settings screen, type the name of the Help title to share with users in
the Custom Help Title field.

2. Type the link to the Help file in the Custom Help Link field.
3. Click OK.

4. Open the Help window by clicking the Navigator main menu button and selecting
Help. The custom Help title appears in the Help screen.

5. Click on the link to access the content.

Database backup and restore (standalone installations only)

Navigator database backup should be backed up in a separate location by an
administrator for safekeeping. If there is a problem with the computer where the
TruVision Navigator database resides, the administrator can install that same version of
TruVision Navigator and restore the database with the backup file. This brings the
system back into operation quickly without manual re-entry of device, user, group,
permission, or other system configuration data.

Note: Data backup and restore is not intended for use when upgrading to a newer
version of Navigator. It will only work with the same version of Navigator used for the
database backup.

To back up the Navigator database:

1. Select the Server tab in the Settings window and then click the Database Backup
button. The Backup Database window appears.

2. Type a database backup name (no file extension is necessary) and take note of the
path where the database backup file will reside. The administrator should copy or
move this file to a safe location.

3. Click Schedule to schedule the backup or click Backup Now. Upon initiation of the
backup, refer to the Tasks window for status (see “Tasks” on page 47)

4. After successful completion, the database backup file resides at the designated
location.
To restore the Navigator database:

1. Select the Server tab in the Settings window and then click the Database Restore
button. The Restore Database window appears. Ensure that a copy of the backup
database file has been placed in the directory listed on the form.
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Restore Database 124

Before restoring your database, please inform all users to
log out of Tru¥ision Navigator. The application will shut
down automatically upon completion of the process.
Please restart your Services upon next login.

Enzure that your backup file iz located at 'C:\Program Files
[#8E)\Microsaft SAL
ServersM550L10_50.50LSERVEREXPRESS\MS5ALBackup' on
machine HF'WORKSTATIOMT.

Please enter the full backup filenanme belaw:

SOL Authentication
| Uze default SOL authentication

Uzer Mame:

Pagzsword:

Cancel

2. Type the exact name of the file in the text field provided. If restoring the database to
a SQL instance that requires SQL authentication credentials, enter them here.
Otherwise, use the default setting.

3. Upon initiation of the restore, refer to the Tasks window for status. After Restore
Task appears in the Task window, log out of the application. Log back in and the
database is restored.

Multi-client (client/server) installations

Client download URL
The Client Download URL field only appears in client/server installations.

For multi-client installations (client/server), the client download URL is the network
location of the Navigator client software package. Administrators can deliver this URL
to new users so they can download the client software remotely from the Navigator
server. If SMTP is in use, this is done automatically for the administrator during user
setup.

For standalone installations (direct database connection), this field is disabled since no
other networked Navigator clients can connect to this instance of the Navigator server.
User management and client software delivery

With multi-client (client/server) installations of Navigator, computers on the same
network with the Navigator server have the ability to download the Navigator client.

Note the following:

» Remote distribution of client software is NOT available for the standalone (direct
database connection) installation option.

» The person installing the client software must have administrator rights on the
computer to perform the client installation.

* When a new user is added to the system, that user does not have any permissions
assigned and therefore cannot log in to Navigator. User permissions must be
assigned before the user can log in (see “User management” on page 33).

28 TruVision Navigator 8.0 SP2 User Manual



Chapter 3: Navigator main menu

» After installation of the client software, all items that the user has permission to
access appear in the Navigator panel.
Fully automated client software delivery

Navigator can be configured to use an SMTP server to send automated email
messages (with client download URL, username, and password) to new users or when
an existing user’s login credentials (username and password) need to be reset in the
system by an administrator (see “SMTP setup” on page 25).

To distribute the client software remotely to a new user, first configure TruVision
Navigator with an SMTP server, and then add the new user and grant permission to the
new user (see “User management” on page 33).

Partially automated client software delivery

If SMTP capability is not used, there are alternate methods that can be used to deliver
the client software.

To deliver client software remotely without access to SMTP, do the following:

1. Ensure that the SMTP Server field is empty in the Settings window Server tab.

2. Add the user (see “User management” on page 33).

3. The administrator delivers the user’s login credentials and client download URL to
the user via phone or private email. Cut and paste the URL from the Client
Download URL field in the Server tab in the Settings window. Remember to assign
the user’s permissions or he/she will not be able to log in.

4. Copy or type the client download URL into a browser, or click on the link in an email.

5. Click Go on to the webpage (not recommended). See the TruVision Navigator 8.0
SP2 Software Upgrade for Client Computers Addendum for details.

6. Follow the instructions in the Client Software Download page to download the
ClientOnlySetup.exe file.

7. Run the ClientOnlySetup.exe file (the ClientOnlySetup.exe file is preconfigured to
point to the server that it was obtained from) and follow the installation prompts.

8. Launch Navigator and log in with the credentials provided via phone or email.

9. Enter the required information in the Change Password window (see “Initial login”
on page 19 for further information).

To manually install the client software on computers, do the following:

1. Download the ClientOnlySetup.exe file from the Client Installation web page and
place it on a thumb drive or other media.

2. Physically deliver the .exe file to the specific computer.

3. Run the ClientOnlySetup.exe file (the ClientOnlySetup.exe file is preconfigured to
point to the server that it was obtained from) and follow the installation prompts.

4. Launch Navigator and log in with the user credentials.
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5. Enter the required information in the Change Password window (see “Initial login”
on page 19 for further information).
Import/export Navigator data

A Navigator address book stores the title, IP address, and credentials of recorders and
cameras, as well as website pages, TruPortal panels, Interlogix intrusion panels, IFS
network switches, and logical views in the Navigator panel. This data can be imported
or exported into Navigator as needed to save and restore these settings.

* Click Export Navigator Data to save Navigator settings in the CSV file format.

e Click Import Navigator Data to import previously configured Navigator panel
settings in the CSV file format.

LDAP servers

The Lightweight Directory Access Protocol (LDAP) is commonly used to provide a
repository for storage of user names and passwords. Adding an LDAP server to
Navigator provides a way to validate users that permits them to bypass the Navigator
login window.

To add an LDAP server:

1. Type the LDAP server domain name in the Server box, and then click Add to test
the server connection. This can be done for multiple domain names. The domain
name must be reachable from the computer used to add the LDAP server.

2. Click on a domain name in the Domain Names box, and then click Remove to
remove an LDAP server.

3. Click OK in the Settings tab when finished to add the LDAP server(s) to Navigator.

Notifications

The Notifications tab in the Settings window includes the following server settings:
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» Select events for notification by email to send to specific email addresses.
* Notification ports
* Primary and alternate email addresses

* Length of notification preservation

Notifications and notifier

Devices can push notifications out to an IP address and port for proactive issue
resolution. These notifications typically include alarm, video loss, motion, etc. See
Appendix B “Device details” on page 151 for details on which notifications are
supported by each device.

To receive notifications from devices in the Notifier panel, configurations are required at
both the device and Navigator service level.

Device configuration — Each device must be set up to push its available notifications
to the IP address and port of the Navigator server. See Appendix B “Device details” on
page 151 for detailed instructions for each device.

Navigator service configuration — The TruVision Navigator service or TruVision
server settings must be configured to listen on that same port for those notifications.

Note: Routers and firewalls may have to be configured accordingly to allow for this
traffic. Ensure that either the TCP listener port or the email listener port (SMTP) on the
Settings window Notifications tab matches the port setup on the device itself.

Navigator provides the ability to limit the notification data in the database to keep the
size down. Set the retention period in number days for this data in the Preserve
notifications for field.

If any of these values are changed, restart the Navigator program (standalone
installations) or restart the TruVision Navigator service (client/server installations) for
the changes to take effect.
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Health diagnostics

The Health Diagnostics tab in the Settings window provides the following server
settings:

» Select health events for email notification
* Primary and alternate email addresses
* Automated diagnostic polling

Note: Changes made in the Health Diagnostics tab won’t take effect until a restart of
the Navigator program (standalone installations) or the TruVision Navigator server
(client/server installations).

Email notifications
Select check boxes for any of the following notifications to receive them via email:

Abnormal Device Health — This notification indicates that either the hard drive is
corrupt or the device cannot encode or record video (DVRs only).

Cameras in Alarm — Any cameras that are in an alarm state.

Cameras in Video Loss — Any camera that is not transmitting video.

Change in Recording Status — A recording has stopped or started.

Disk Status — Health status of the hard drive.

Disk Temperature Threshold — Temperature has exceeded the set threshold.

Device Offline — A device is offline during polling after having previously been online.

Email addresses

Enter valid email addresses in the Primary email and Alternate email fields. If SMTP
has been set up in the system, click Test to send test emails.
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Automated diagnostic polling

To run automated health diagnostic polling on an interval across all of the devices in
the system, the diagnostic polling service must first be configured.

To configure the diagnostic polling service:

1. From the Health Diagnostics tab in the Settings window, type the Automated
Diagnostic Polling Start Time and Interval (retention period).

2. Select Days or Hours for the length of time to keep the health diagnostic polling
data in the database.

3. Restart Navigator to begin the automated polling. If any of these values are
changed, restart the Navigator program (standalone installations) or restart the
TruVision Navigator server (client/server installations) for the changes to take effect.

After manual snapshots or automated health diagnostic data have been captured, the
data is stored in the Navigator database. The data is now searchable by users to aid in
maintaining system up-time.

Groups and users

The Group and Users tab of the Settings window provides the following server
settings:

e Details

* Permissions

User management

Note: Adding or assigning permissions to a user requires that the individual performing
those functions has the “Manage user permissions” permission assigned to them in
Navigator.
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To add aregular user:
1. Click on the Groups and Users tab in the Settings window.

2. Right-click the Users node in the Navigator and select Add User or click the Add
User button. The Add User window appears.

3. Type the required user information in each field. The Username, Password, and
Confirm Password fields are disabled if SMTP is configured in the system.

4. Click OK. The new user is added under the Users node in the Navigator panel.

5. To install Navigator on the new user’s client computer: If SMTP is set up in the
system, follow the instructions under “Fully automated client software delivery” on
page 29. For systems without SMTP set up, follow the instructions under “Partially
automated client software delivery” on page 29.

To add an LDAP user:

1. Click on the Groups and Users tab in the Settings window.

2. Right-click the Users node in the Navigator and select Add User or click the Add
User button. The Add User window appears.

3. Click Add LDAP User.

4. The Add LDAP User window appears. Select a domain name from the Domain
Name drop-down list (see “LDAP servers” on page 30 for details).

5. Type the user name in the Search By box and click Search. All matching data
appears as shown below.

6. Click the Add link next to the user name to add an LDAP user. The Add User
window reappears with the user information automatically populated.

7. Click OK to add the LDAP user. The user now appears in the Show all users list as
an LDAP user.

8. If necessary, assign at least one permission to the LDAP user so that they can use
Navigator (see “To assign permissions to a user” below).

Note: LDAP users are automatically logged in to Navigator when opening the
application. An LDAP user must log out of Navigator to log in as a different user.

To assign permissions to a user:

1. Click on the user icon in the Groups and Users tab and click the Permissions tab.
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2. Highlight the TruVision Server node or any sub nodes, folders, devices, or other
items in the permissions panel and allow/deny permissions for this user in the
Permissions tab. If the Permission Model is set to Simple (only users), only the
Allow column appears. If the Permission Model is set to Advanced (both users and
groups), both the Allow and Deny columns appear.

3. When finished, click OK.

Permission indicators

When assigning permissions, specify whether the permission is applied at the parent or
child node. Granting permissions at a parent node cascades those permissions down to
the child nodes. For example, granting permissions at the Navigator server level
cascades down over all folders, devices, and cameras beneath it. These are indicated
by a blue dot. Conversely, granting permissions at the child node does not change
permissions at the parent node. In this case, the child node displays a blue dot and the
parent displays a gray dot.

Table 2: Permission indicators

Permission Indicator Description

Blue A blue dot indicates express permissions granted on that node. These
permissions are inherited by the children nodes underneath the parent
node.

Gray A gray dot indicates express permissions assigned to a child of the

parent node, but not at the parent node itself.

This serves as a quick visual cue for the administrator to find express
permissions granted to a user on devices in the permission panel.

If all of the gray dot nodes are expanded, the camera or device with
one or more express permissions appears, indicated by a blue dot.
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Permission models

TruVision Navigator has two permission models — Simple or Advanced. The default for
a new installation is the Simple model.

Simple model — Administrators only have the ability to create, edit, and delete users
and their corresponding permissions.

Advanced model — Administrators have the ability to create, edit, and delete both
users and groups. Groups allow the scaling of user permissions across many users.
For instance, many users can be placed into a single group, and that single group can
be assigned permissions against the folders and devices in the system. Without
groups, the administrator would have to grant permission to each user individually.

To change the permission model to advanced, go to the Settings window, select the
Server tab, select Advanced in the Permission Model drop-down list, and click OK.
Groups now appear as a node in the Navigator panel. The table below outlines the
actual permissions that can be granted to users or groups within Navigator, the user
interface impact of that permission, and the dependencies of specific permissions.

Table 3: Permission matrix

Permission

User Interface Impact

Dependent Permissions

Acknowledge notifications

Configure client

Configure server

Export video

View access control panel
notifications
Manage access control panels

Manage decoders

Manage device folders

Show/hide Acknowledge All
button in Notifier dialog

Enable/disable Client tab in
Settings

Enable/disable right-click
options on TruVision Navigator
Server node (i.e., Properties
and Database Backup and
Restore)

Enable/disable Local record
button in Controller

Enable/disable Snapshot and
Video buttons in the Controller

Show/hide Collector Panel

Show/hide Tasks Panel (panel
may also be visible due to
other permissions)

Enable/disable notifications
from TruPortal in the Notifier

Enables/disables access
control context menus

Enables/disables configuration
of scenes

Show/hide Add Folder button
and context menus in
Navigator

Watch live video
Watch playback video

Operate access control panels

Operate decoders
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Permission

User Interface Impact

Dependent Permissions

Manage devices

Manage intrusion areas

Manage intrusion panels

Manage network switches

Manage maps

Manage user permissions

Manage website

Show/hide Folder (folder may
also be visible due to other
permissions or parent/child
permissions)

Show/hide Address Book
Import context menu for
Devices node

Show/hide Add Device button
and context menus (rename
and delete) in Navigator

Show/hide Folder (folder may
also be visible due to other
permissions or parent/child
permissions)

Show/hide Device (device may
also be visible due to other
permissions or parent/child
permissions)

Show/hide Camera (camera
may also be visible due to
other permissions)

Show/hide Bulk Tasks
(Firmware Upload and
Configuration) context menus
for Devices node

Enable/disable Device
Properties (Connection,
Details, Capabilities) dialog on
device

Show/hide Camera Search
and Configuration context
menus

Show/hide Firmware Upload
context menu for device

Show/hide Tasks Panel (panel
may also be visible due to
other permissions)

Showr/hide intrusion area
context menus

Showr/hide intrusion detection
context menus

Show/hide network switches
context menus

Show/hide map context menus

Show/hide Users and/or
Groups nodes in Navigator

Show/hide website context
menu

Operate intrusion areas

Operate intrusion panels

Operate network switches

View maps

View website
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Permission

User Interface Impact

Dependent Permissions

Operate access control panels

Operate decoders

Operate intrusion areas

Operate intrusion panels

Operate network switches

Pan tilt zoom

Trigger outputs

View device diagnostics

View disk analysis

View intrusion areas

View intrusion panel
notifications

View intrusion panels

View maps

View notifications

Show/hide door icon context
menu

Enable/disable scene
activation

Show/hide arm/disarm
selections in context menus

Show/hide intrusion panel
context menu

Show/hide network switch
context menu

Enables/disables PTZ control
in camera tile

Show/hide PTZ button in
timeline (PTZ settings access)

Showr/hide Trigger Outputs
selection in device context
menu

Show/hide Run Health
Diagnostics in Device node
and specific device context
menus in Navigator

Show/hide Folder (folder may
also be visible due to other
permissions or child
permissions)

Show/hide Device (device may
also be visible due to other
permissions or child
permissions)

Show/hide Disk Analysis
context menu for device

Show/hide camera row in Disk
Analysis dialog

Show/hide intrusion areas in
maps

Showr/hide intrusion areas in
the Navigator panel

Show/hide intrusion panel
notifications in Notifier dialog

Showr/hide the intrusion
detection node

Show/hide the map node

Show/hide Folder (folder may
also be visible due to other
permissions or child
permissions)

View intrusion panels

View intrusion panels

Watch live video

Watch live video
Watch playback video

View intrusion panels

View intrusion panels
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Permission

User Interface Impact

Dependent Permissions

View websites

Watch live video

Watch live video main stream

Watch playback video

Show/hide Device (device may
also be visible due to other
permissions or child
permissions)

Enable/disable Notifier icon in
application status bar

Show/hide Device Notification
in Notifier dialog

Show/hide Camera
Notification in Notifier dialog
for permissioned device

Shows/hides the website node

Show/hide Folder (folder may
also be visible due to other
permissions or child
permissions)

Show/hide Device (device may
also be visible due to other
permissions or child
permissions)

Show/hide Camera (camera
may also be visible due to
other permissions)

Allow/Disallow Open Video
from Camera (all methods:
double-click and drag-and-
drop operation in Navigator)

Show/hide PTZ and in-tile
mouse controls

Enable/disable Main/Sub
switch in playback controls

Show/hide Folder (folder may
also be visible due to other
permissions or child
permissions)

Show/hide Device (device may
also be visible due to other
permissions or child
permissions)

Show/hide Camera (camera
may also be visible due to
other permissions)

Enable/disable Controller
Playback controls including Go
To, Playback, Live, double-
click on timeline)

Enable/disable notifications in
Notifier dialog

Watch live video
Watch playback video

Watch live video
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Permission User Interface Impact Dependent Permissions
Watch playback video main Enable/disable Main/Sub Watch live video
stream switch in playback controls Watch playback video

Deactivate a user

Deactivation revokes all user rights to the system but does not delete users from the
database.

To deactivate a user:

1. Right-click on the user under the Users node and select Deactivate User.

2. Click Yes when prompted with “Are you sure you want to deactivate this user?”

3. Deactivated users are removed from the Users node in the Navigator unless
Include Deactivated Users is selected by right-clicking the Users node. The
Inactive User icon is shaded gray while the Active User icon is shaded blue.

4. To view all active or deactivated database users in a list, click the Users node and
select Show all users. The Users screen appears. All of the columns in this dialog
are sortable. Double-click any user row to view that user’s details dialog.

Restore a deactivated user

To restore a deactivated user in the system (three possible methods):
* Right-click the deactivated user under the Users node and select Activate User.

* Right-click the deactivated user under the Users node, select Properties, and click
the Reset Account button on the Details tab.

* From the user list, double-click the user icon to launch the Details tab, and then
click the Reset Account button.

If SMTP is in use, the user automatically receives an email with a temporary login
password. The user is prompted to change this password upon initial login.
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If SMTP is not in use, the administrator must provide the user with a new temporary
password in the Change Password window. These temporary credentials must be
delivered to the user via phone or email.

Reset a user after lockout

If a user forgets his or her username or password and challenge question, that user can
be locked out of the system. If a user has been locked out for login failures, they must
answer the challenge question in the User Account Challenge window.

If a user cannot remember the challenge question, the administrator must reset the
account. Follow the instructions under “Initial login” on page 19.
Force a user to log out

From the user list, double-click the user icon to launch the Details tab, and then click
the Force Logout button. This logs the user out immediately. The user making the
change must have the Manage Users Permissions permission granted to execute this
function.

Group management

The advanced permission model permits group management in Navigator. Groups
allow the scaling of user permissions across many users. For instance, users can be
placed into a single group, and that single group can be assigned permissions against
folders, devices, and other items in the system. Without groups, the administrator would
have to grant permission to each user against those same devices.

To create a group:

1. Click the Server tab in Settings and ensure that the Permission Model drop-down
list is set to Advanced.

2. Right-click the Groups node in the Groups and Users tab and select Add Group.
3. Type a name for the group in the Add Group window and click OK.
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4. Click on the group name and then click the Details tab to change the group name
and add users to the group.

5. When finished, click OK.

To assign permissions to a group:

1. Click on the group icon in the Groups and Users tab and then click the
Permissions tab.

2. Highlight the TruVision Server node or any sub nodes, folders, devices, or other
items in the permissions panel and allow/deny permissions for the group in the
Permissions tab. Group permissions affect all of the specific users that are
members of the group.

3. When finished, click OK.
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To add a user to a group:

1.
2.

3.

Click on the group icon in the Groups and Users tab and click the Details tab.

Select one or more users in the Users field and then click Add All or Add to add
users to the Group Members field.

When finished, click OK.

Group permission override

Users with group permissions can have the permissions overridden by the
administrator. In this way, the administrator can customize the permissions of a group
member.

To override group permissions for a user:

1.
2.

Click on the user icon in the Groups and Users tab and click the Permissions tab.

If necessary, add the user to a group by selecting one or more group check boxes in
the Groups panel.

Highlight the TruVision Server node or any sub nodes, folders, devices, or other
items in the permissions panel and allow/deny permissions for this user in the
Permissions tab.

Select the Group Permission Override check box and then click OK.

Search

Use Search to find any user or group in the Groups and Users panel.

To perform a Groups and Users search:

1.

Type any alphanumeric string into the Search field at the top of the Navigator panel
and press Enter. Focus goes instantly to the user or group that matches the string.
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2. Press Enter again to move to the next object that matches the string until each item
matching the search criteria has been found. Type a different alphanumeric string
into the Search field to perform another search.

Group summary

After one or more groups have been created, click on the Groups node to view a list of
all groups and their Active status. Click on a group name to rename a group.

Audit History

The Audit History tab logs all user activity which can be searched using Filters
selections. Click OK when finished making selections.

Click Export Audit History to save the list of configured events in the CSV file format.

44 TruVision Navigator 8.0 SP2 User Manual



Chapter 3: Navigator main menu

Logical event filtering

Logical event filtering provides a way to create customized, interdependent notifications
from cameras connected to recorders as well as, optionally, doors connected to
TruPortal access control systems.

To create a customized notification in Logical Event Filtering:

1.

5.

Click on the Logical Event Filtering tab in the Settings window.

2. Type in a title for the notification in the Title field.
3.
4

. Highlight each camera in the list and select the required Video notifications for each.

Drag cameras from the Logical Event Filtering navigator panel into the device list.

Note that the number of people detected as Entered, Occupants, or Exit before
sending a notification under Object Counting can be configured by typing a number
into those fields or clicking the spin wheels. Also note that the VCA Alarms
notification can be customized by selecting specific VCA alarm events.

Optional: To include doors in a Logical Event Filtering notification, highlight each
door in the list and select the required Access notifications for each.
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6. Optional: To include intrusion panels in a Logical Event Filtering notification,

highlight each panel in the list and select the required Intrusion notifications for
each.

7. Type or click the spin wheels to enter a value in seconds in the Notification
Timespan field. Logical Event Filtering generates a notification when all

notifications configured in the list occur within the length of time specified in the
Notification Timespan field.
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8. If necessary, click on an item in the list and click Remove Item before saving the
custom notification.

9. When finished configuring the notification, click Save and configure another
notification, or click OK to exit Logical Event Filtering.

Bookmark manager

The Bookmark Manager window is a central location that contains all device-level
bookmarks. When bookmarks are added, edited, or deleted on the timeline, the
Bookmark Manager automatically updates. Deleting the device or camera associated
with one or more bookmarks removes them from the Device list in the Bookmark
Manager.

See “Adding bookmarks” on page 111 for details on adding bookmarks and “Export
video” on page 110 for details on exporting bookmarked video.

The following operations are available in the Bookmark Manager:
« Edit — Double-click on a bookmark to edit the title, time, and notes.
* Delete — Press the Delete key on the keyboard to delete the bookmark.

» Play — Click the bookmark’s play icon to play video associated with the bookmark in
the timeline.

Note: Bookmarks are stored in application memory, so all bookmark data is erased
when Navigator is closed.

Tasks

The Tasks window is a central location that monitors tasks created and scheduled in
the system. These tasks include both executed and scheduled/pending video exports,
database backups, and database restores. Tasks provides a real-time status of the
tasks in the queue, and the reason if a task was unsuccessful.

Click the Navigator main menu button and select Tasks to access the Tasks window.
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Click Clear to clear the list of tasks or Export to export the list of tasks in CSV file
format.

Recurring tasks

The Recurring Tasks window is a central location that monitors video exports created
according to a recurring schedule set in the Export Video window (see “Recurring
schedule” on page 97).

These tasks include both completed and scheduled/active video exports. The window
provides device (camera) descriptions, scheduled date and time (including days of the
week and start and end times), and the real-time status of the tasks in the queue.

Click the Navigator main menu button and select Recurring Tasks to access the
Recurring Tasks window.

Recurring Task *

Status Delete

Device (Camera) Mext Scheduled Date/Time Days Stant Time: EndTime

Location - E-\MyRecumingfolder

Features of the Recurring Task window:

* Recurring tasks also appear in the Tasks window, where recurring task download
success or failure is indicated.

« The download folder where the recurring task directory resides appears in the
lower-left corner of the window.
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* Click Clear to clear the list of tasks or Export to export the list of tasks in CSV file
format.

Open exported video file

Click the Navigator main menu button and select Open Exported Video File to browse
for and launch an exported video in the Viewer. See “Export video” on page 97 for
details about video export.

Updates

Click the Navigator main menu button and select Check for Updates... Click Restart
Navigator to restart the application and apply updates if required.

Check for Updates... X

Player
Version 8.0.2.9 (20181101)

Language Pack
Version 8.0.2.16 (20181101)

Restart Navigator

Note: Language packs do not install automatically and must be installed by the user by
clicking Restart Navigator.

Help

Click the Navigator main menu button and select Help to access the Help dialog. The
version number displays along with links to launch Help and view the End User License
Agreement. Custom Help links also appear if they have been configured (see “Custom
Help” on page 26).
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Logout

To log out of Navigator:

1. Click the Navigator main menu button and select Logout to access the Please
Confirm dialog.

2. Click Yes to log out of Navigator. Logging out permits another user to log in on the
same machine.
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The TruVision Device Manager can discover Interlogix IP devices on a network such as
IP cameras, DVRs, NVRs, encoders, decoders, IFS switches, TruPortal access panels,
and intrusion panels.

This chapter explains how to use Device Manager to find and configure network-related
settings of TruVision devices, use the New System Setup Wizard, and upgrade the
firmware of individual devices or perform a bulk upgrade.

Device Manager capabilities

The following Device Manager features are compatible with the following Interlogix
device types. Go to www.interlogix.com or www.firesecurityproducts.com for
information about specific model compatibility.

Device Type Device Change Change Firmware Change Device Upload IP Reset
Discovery P Password  Upgrade Date & Config Camera Password
Address Time Backup & Information
Restore
Recorders YES YES YES YES YES YES YES YES
Cameras YES YES YES YES YES YES N/A YES
Encoders/Decoders  YES YES YES YES YES YES N/A YES
IFS YES YES NO NO NO NO N/A NO
TruPortal YES YES NO NO YES NO N/A NO
Intrusion panels YES NO NO NO NO NO N/A NO

Getting started

To access Device Manager, click the button at the top of the Navigator panel and select
Device Manager from the Navigator main menu drop-down list. The Getting Started
window appears.
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Note: The New System Setup Wizard is intended only for setting up devices that have
not previously been connected to the network.

Click on a button in the Getting Started window to perform Device Manager tasks:

e Activate Device — Activate one or more inactive devices as shown in the button.
See “Activate an inactive device” on page 57.

* Device Discovery — Launch the Device Manager main window and discover
devices on the local network. See “Device discovery” on page 53.

* Storage Calculator — Create a storage capacity requirement report. See “Storage
calculator” on page 59.

* Help — Open the Device Manager user manual.

* Firmware Updates — Upgrade the firmware of one or mores devices. See
“Firmware upgrade” on page 58.

* Setup Wizard for New Systems — Set up new devices that have not previously
been connected to the network. See “New system setup wizard” on page 54.
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Device Manager window

The Device Manager window contains the Discovered Devices and Navigator tabs
along with the following buttons:

Button icon  Name Description

Refresh the list of discovered devices. See “Device

Refresh : "
discovery” below.

Export the list of discovered devices to the CSV file

Export to CSV format.

Add Device Add a device manually. See “Add device” on page 54.

Tools for Device Manager configuration. See “Device

Device Manager Tools Manager tools” on page 60.

Device discovery

Device Manager searches for online devices within the local network and displays
network information for the devices. It automatically searches every 15 seconds for the
online devices in the computer’s local network and then displays the information for the
found devices.

IMPORTANT: A wired network connection is required for device discovery. A device
cannot be discovered or activated via a Wi-Fi network connection.

Note: Unmanaged devices do not support the discovery feature.
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Search for active devices online

After launching Device Manager, click the Device Discovery button in the Getting
Started window. The Device Manager window appears.

The device information that appears in the Discovered Devices tab (shows only the
devices that have not been added to the Navigator panel) includes the device type, IP
address, port number, gateway, firmware version, serial number, MAC address, etc.
Discovery results can be filtered by clicking the Navigator tab (which shows only the
devices that have been added to the Navigator panel), and/or by making a selection
from the device filter drop-down list (Camera, Recorder, TruPortal, etc.)

Note:

* Click the Refresh button to perform a new search for online devices. When the
Refresh button appears with a yellow dot, it indicates that new devices have been
added in the background. Click  to add the newly found devices to the list.

* Click on a column heading button to sort the information.

Add device

If a TruVision IP device connected to the network does not appear in the Device
Manager’s list of discovered devices, it can added by clicking the Add Device button.

Type in the appropriate device location information along with the device’s user name
and password, and then click OK.

Select the Add cameras connected to this device check box to add cameras under a
recorder in the Navigator panel. Type the user name and password for each camera, or
select Use this credential for all devices in the Credentials Required window.

New system setup wizard

Use the New System Setup Wizard to set up new devices that have not previously
been connected to the network.
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To set up devices using the Wizard:
1. Click the New System Setup Wizard button in the Getting Started window.

2. Select a recorder and one or more cameras to set up in the Recorder Selection
window.

Setup Wizard for New Systems

Recorder Selection

etiings
5 on to the recorder. NOTE: This overwrites the existing configuration
6. Add the recorder to TruVision Navigator

Recorders

Requires
Modsl 1P Address Serial Number Adtivation

Requres

Activation

[ TVN22 182.168.1.82 TVN2216P 1620160525CCRRO90176597WCVU TVB-5502 192168170 TVB-550220170621AAWRTB36075..
TVW-3101

10042 TVD-310420130824CCWR431
1721610034 TVD-

ecorder and then sel

3. In the Activate Device window, select one or more devices to continue with setup. If
multiple devices are selected, IP addresses are automatically assigned in sequence
(in this case, all devices must have the same password). Select individual devices to
assign specific IP addresses to each. Type in a new IP address, subnet, and
gateway manually or click on an IP address to use default settings.

4. Type ‘admin’ as the user name and type in a new password for the device(s). Click
Apply to determine if the IP addresses are available. Click Next when finished.

5. The Credentials Required window appears. Select the check box next to each
device, type the user name and password, and then click Apply. Click Next when
finished.
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6. The Networking Parameters window appears. Change the IP addresses for any
devices with network parameters that are not compatible with your network by
typing addresses into the Subnet Mask and Gateway fields according to your
network requirements. Selecting check boxes next to multiple devices assigns IP
addresses to those devices in sequential order, starting with the address you type in
the New IP Address field. The system skips addresses that are already in use in
your network. Click Apply after all networking parameters are set correctly.

7. Click Yes to confirm the IP address changes. When finished, click Next again and
wait several seconds for the storage calculator window to appear.

8. Select resolution and frame rate. If necessary, change the camera name and add
substream information. The bitrate number auto-calculates and can also be
changed if required. Click Next.

9. The Alarm Host Setup window appears. Optional: Select Enable Alarm Host to set
the IP address of the client or server that will receive alarm notifications. The Alarm
Host IP box is prepopulated with the IP address of the computer that the Wizard is
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running on. Type a different IP address in the Alarm Host IP box if required. If
multiple NIC cards are present, the Alarm Host IP box has a drop down list
containing the IP address of each NIC card. Click Next.

10. The Summary window appears, showing the device information along with the
location of the recorder configuration file. Click Next.

11.Click Yes to send the new configuration to the recorder.

12.The completion dialog appears. Click Complete to finish setup.

Activate an inactive device

Newer TruVision devices appear as “Inactive” in the Device Manager window upon
initial connection to the network.

IMPORTANT: A wired network connection is required to activate an inactive device. A
device cannot be activated via a Wi-Fi network connection.

To activate an inactive device:

1. Click Activate Device in the Getting Started window. A list of inactive devices
appears in the Device Activation/Change IP Address screen.

2. Follow the steps under “Change IP address” on page 60.
Note: The device is not activated until it is given a new password.
3. An activate device success message appears.
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Firmware upgrade

Use the Firmware Upgrade window to upgrade the firmware of the selected device or
devices.

Note: The local computer must be connected to the internet to connect with the
firmware server.

To select devices for firmware upgrade:

1.

5.

58

Click the Firmware Updates button in the Getting Started window. The Updates
Available dialog appears.

Select Download All Firmware to download all firmware files. If this check box is
not selected, only firmware files that have not already downloaded will download to
the local computer. Click OK in the Updates Available dialog to proceed.

The Firmware Download screen appears. Wait for the firmware files to download to
the local computer.

The Firmware Upgrade screen appears. In the Model list, click a device to select it
or hold the Ctrl or Shift key to select multiple devices.

Click Apply, and then click Yes to start the firmware upgrade process. The
Credentials Required dialog box appears.

Type the User Name and Password for the device(s) (if necessary, select Use this
credential for all devices), and then click OK to begin the firmware upgrade.

Firmware upgrade progress appears in the Firmware Upgrade window. When
upgrading is complete, the updated version information of the device(s) appear in
the device list.
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Storage calculator

Storage calculator is a tool that permits the creation of a storage capacity requirement
report for TruVision recorders that can be printed or exported to Microsoft Excel (XLS
file format).

IMPORTANT: Storage requirement calculations provided by the calculator are only an
estimation based on medium quality video settings. More storage capacity could be
needed depending on the scene complexity of images captured by the cameras.

Note: Storage calculator only supports the TruVision recorders listed in the Recorder
drop-down list in the TruVision Storage Calculator window.

To generate a storage calculator report:

1.

S

Click the Storage Calculator button in the Getting Started window.
Type a value into the Project Name field.

Select the recorder model from the Recorder drop-down list.

Select the number of camera channels in the Channels drop-down list.

Type camera names into the Camera Name fields as necessary and enter values

for each camera in the Main Stream and Substream (if applicable) sections. Use the

Copy Channel 1 Settings, From Channel, and Range fields to copy values
between cameras.

The Storage per day (GB) columns and the Total Storage per Day and Total
Storage Capacity fields populate with storage requirement calculations. When
finished configuring the storage calculator project, click the Print Report or Export
to Excel button to generate a storage calculator report for future reference.
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Device Manager tools

Click on the Device Manager Tools button in the Device Manager window to access
the tools.

Change IP address

1.

3.
4.

60

Click the Change IP Address tool button to bring up the Device Activation / Change
IP Address window.

Select one or more devices to continue with setup. If multiple devices are selected,
IP addresses are automatically assigned in sequence (in this case, all devices must
have the same password). Select individual devices to assign specific IP addresses
to each. If a device has one or more Network Interface Cards (NICs) to share the
network load when using a number of HD cameras, an IP address can be assigned
to each by selecting the corresponding number of the NIC from the Network drop-
down list. Type in a new IP address, subnet, and gateway manually or click on an IP
address to use default settings.

Note: Credentials must be entered before assigning an IP address to a NIC card.

Click Test

If the IP addresses were recognized as available, click Apply.
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5. Click Yes to change the IP address for the selected devices.

Change password

1. Select one or more devices the main Device Manager window (if multiple devices
are selected, all must have the same password), click Device Manager Tools, and
then click the Change Password tool button.

2. Type the correct information in the Old Password, New Password, and Confirm
Password fields. Select the Include cameras connected to this recorder check
box to change the password(s) for connected cameras.

3. Click Apply.

Manual firmware update

Follow these instructions only if the firmware update file has already been downloaded
to the local computer.

To perform a manual firmware update:

1. Select one or more devices for firmware update in the main Device Manager
window.

2. Click Device Manager Tools, and then click the Manual Firmware Update tool
button. The Firmware Upgrade window appears.

3. Click Browse to locate the firmware file, and then type in the user name and
password for the highlighted device in the Device List.

4. Click Add to add the highlighted device to the Tasks Summary list, or click Add All
to add all the devices in the Device List to the Tasks Summary list.

5. Click Apply, and then click Yes to start the firmware upgrade process.

6. Firmware upgrade progress appears in the Firmware Upgrade window. When
upgrading is complete, the updated version information of the device(s) appear in
the device list.

Date and time sync
Use this tool to set the time and date across multiple devices.

Network Time Protocol (NTP) is a protocol for synchronizing the clocks of network
devices such as IP cameras and computers. Connecting network devices to a
dedicated NTP time server ensures that they are all synchronized.

Note: For a list of IFS switches that support date and time sync, see the TruVision
Navigator Compatibility with IFS Switches Addendum.
To perform date and time sync:

1. Select one or more devices for date and time sync in the main Device Manager
window.
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2.

3.

5.

Click Device Manager Tools, and then click the Date and Time Sync tool button.
The Date and Time Sync window appears.

Select Enable NTP and then type in an address in the NTP Server field, a time
interval in the Interval field, and an NTP Port number in the NTP Port field as
necessary.

From the Time Zone drop-down list, select the time zone that corresponds to the
device’s location.

Note: You can also select the Sync to PC Time check box to synchronize the time
of the device with the time of the computer.

Type in the User Name and Password credentials for each device or for multiple
devices, and then click Apply after the credentials are accepted for all the devices
in the list.

Device configuration backup and restore

Use these tools to backup and restore device configurations.

To back up a device configuration:

1.

62

Select a device in the main Device Manager window, click Device Manager Tools,
and then click the Device Configuration Backup tool button.

If required, click Browse to select a new backup location.

Enter the device user name and password and select Start to begin the backup
process.
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Click Close when backup is complete.

To restore a device configuration:

1.

Select a device in the main Device Manager window, click Device Manager Tools,
and then click the Device Configuration Restore tool button.

2. If required, click Browse to select the location of the backup file.

Enter the device user name and password and click Apply.

4. Click Yes to restore the device configuration.

Upload camera information

Use this tool to restore the device configuration for IP cameras only.

Note: Not all cameras support this feature.

The list of recorders that can upload camera information is as follows:

TVN11
TVN21
TVN22
TVN70
TVN71
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* TVR15HD (IP cameras only)
e TVR45HD (IP cameras only)
* TVRA46 (IP cameras only)

To upload camera information:

1. Select a supported recorder in the main Device Manager window, click Device
Manager Tools, and then click the Upload Camera Information tool button.

2. Click Browse to select the location of the configuration file.

3. Type in the recorder user name and password and click Apply.

4. Click Yes to upload the camera information.

Reset password

If an admin (not a specific user) device password is lost, contact Technical Support to
restore the password. There are two ways to restore the password. The method to be
used depends on the device and its currently installed firmware.

To restore the default password (method 1):
1. Select the device for password reset in the main Device Manager window.

2. Click Device Manager Tools, and then click the Reset Password tool button.

3. Copy the complete serial number from the Device Serial No. field in the Device
information panel and paste it into an email to send to Technical Support. Also
provide Technical Support with the date shown in Live View. For some devices
(e.g., TVR60), the hour shown in Live View is also required.. Technical Support will
provide a security key by email.
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4. Enter the security key received from Technical Support in the Security Code field
and click OK to restore the default password. The default password is 1234.

Note: The security key provided is related to the date (or hour in the case of TVR60)
the serial number was sent to Technical Support and expires the day it was created.
We recommend resetting the device password immediately after receiving the reset
code.

To set a new password using an XML file (method 2):

1. Select the device for password reset in the main Device Manager window.

2. Click Device Manager Tools, and then click the Reset Password tool button.

3. Click the Reset Password button.

4. Click Export Reset File in the Reset Password window to save the XML file, and
then email the file to Technical Support. Technical Support will provide a new XML
file.

5. Save the XML file received from Technical Support on the computer, click Browse,
and select the new XML password file.

6. Type a new password and then confirm it in the New Password and Confirm
Password fields. Click Apply.

Note: Do not restart the device after the password recovery XML file has been
exported, otherwise the steps above must be repeated. The password recovery XML
file expires after 48 hours.

Add device to Navigator

1. Select one or more devices in the main Device Manager window (if multiple devices
are selected, all must have the same password), click Device Manager Tools, and
then click the Add Device to Navigator tool button.

2. Type the correct information in the User Name and Password fields in the
Credentials Required window.

3. Click OK. The device is added to the Navigator panel.
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The Navigator panel is the central administration area of the application where
recorders, cameras, maps, websites, access control systems, intrusion detection,
network switches, and logical views are added, listed, and configured.

Items in the Navigator panel can be located quickly by typing a device name into the
Search field at the top of the Navigator panel and pressing Enter.

Move the mouse pointer over a camera in the navigator panel to view the digital or
analog channel number. Cameras that are ONVIF-compliant display their IP address.

Note: The Navigator panel is permission-based, so if a user does not have rights to
perform certain actions, they will not see the options.

Adding devices

Add a single or multiple devices (such as recorders, cameras, and decoders) to the
Navigator panel by choosing one of the following options:

* Add manually

* Add via discovery tool

Adding devices manually

1. Click the Add Devices button E¥ in the Navigator panel and select Add Manually,
or right-click the Devices icon and then select Add Device > Add Manually from
the drop-down list. The Add Device window appears.
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2. Select the appropriate model from the Device Type drop-down list.

Note: Select TruVision Recorder or TruVision Camera from the drop-down list for
any TruVision device. Using one of these drivers enables the device’s browser-
based configuration page. Some functions do not work as designed if either of these
generic device types are selected. We recommend selecting the specific device
model if possible.

3. Type a name in the Device Title field. Values are alphanumeric.

4. Based on the device type, a selection from the Streaming Type drop-down list may
be required. For some devices, there is only one option for the Streaming Type so
it is selected by default. Streaming types are defined as follows:

e TCP - TCP is a reliable stream delivery service that guarantees delivery of a
data stream sent from one host to another without duplication or losing data.

* UDP — The application connects to the device and asks the device to stream
video back to the application on a UDP address and port. For this option, the
firewall must be configured to allow the device to stream to the application on
that specific port.

* Multicast — This type of streaming only requires one stream and one user
connection to the recording device and can be connected to many clients. This
saves connections and network bandwidth. Multicast is supported in live view
only.

5. Type the device’s IP address or the EzDDNS URL (e.g., http://hostname.tvr-
ddns.net) in the Device Address field.

Note: A recorder can be added using a Domain Name System (DNS) name as well
as a static IP address by typing the DNS name in the Recorder Address field.

6. The Port field is pre-populated with a default value based on the type of device
selected. If the port assigned to the device is different from the default value, type
the correct port value in this field.

Note: The port number must be added to the device address when using DynDns
with a HTTP port other than port 80 (e.g., mydvr.dyndns.org:2222 if the HTTP port
being used is 2222). When using No-IP instead of DynDNS, also add the HTTP port
number.
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9.

Type the required values in the Username and Password fields.

Select the Add Device Offline check box to add the device to the Navigator if it is
currently offline. Bring an offline device online by right-clicking on the device in the
Navigator panel and selecting Connect.

Click OK.

Note: After clicking OK, fields highlighted with a red exclamation point indicate rejected
values. Move the mouse pointer over the exclamation points for tips on why the values
were invalid. All fields must be valid to successfully add a device.

Adding devices using the discovery tool

Navigator is equipped with an embedded device discovery tool that discovers devices
such as recorders, cameras, and decoders in the network and permits the addition of
one or more of those devices.

IMPORTANT: A wired network connection is required for device discovery. A device
cannot be activated via a Wi-Fi network connection.

1.

4.

68

Click the Add Device button in the Navigator or right-click the Devices icon, and
then select Add Device > Add via Discovery Tool from the drop-down list.

The Device Discovery window displays and provides a list of available devices in
the network. You can filter these results by selecting All, Recorders, Cameras, or
Decoder in the drop-down list.

Note: For recorders, the first two characters after the alpha model number prefix
indicates model number, and the last two characters indicate channel count. For
example, a TVR4616 model number indicates a 16-channel TVR46 recorder.

To add devices to the Navigator, select one or multiple devices from the list using
the mouse and Citrl key, and then click Add. The device(s) appear under the Device
node in the Navigator panel.

Type the Username and Password and then click OK.
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5. After the recorder or TruVision camera appears online, expand the Device icon to
view all devices added to the system. Upon successful connection, the Navigator
populates the respective cameras under the device.

To remove a cameraicon from the Navigator panel:

1. Right-click the recorder icon associated with the camera and select Properties.

2. Click on the camera to be removed and select the Camera Not in Use check box.

3. Click Save. Repeat these steps, deselect the Camera Not in Use check box, and
then click Save to add the camera back to the Navigator panel.

To remove arecorder or decoder icon from the Navigator panel:
1. Right-click the device icon and select Delete Device.
2. Click Yes.

Configuring discovered devices

Discovered devices can be configured either in Navigator or through the device’s
internal configuration web page.

TruVision recorder browser configuration is currently available for the recorders listed
below:

Table 4: Browser configuration compatibility

Recorder Model Firmware version
TVN 10 2.0 and above
TVN 21 3.0 and above
TVN 22 1.0 and above
TVR12HD All versions
TVR15HD All versions
TVR44HD All versions
TVRA45HD All versions
TVR46 All versions
TVN 11 All versions
TVN 70 All versions
TVN 71 All versions

To configure a device using the device’s internal configuration web page:

1. Right-click a device in the Navigator panel and select Configure Device or
Configure Camera.

Note: If configuring a device remotely, the device HTTP port must be forwarded
through the router, along with the control and RTSP ports. Without HTTP port
forwarding, the browser of the device cannot be viewed.

TruVision Navigator 8.0 SP2 User Manual

69



Chapter 5: Navigator panel

2. If necessary, click OK to update the plug-ins.

Note: The plug-in should already be installed if the device has been connected to
and previously configured through the device’s internal web browser

3. Follow the instructions in the Setup-UTC Web Components window. When
complete, restart Navigator.

WARNING: Close all browser windows when instructed and close Navigator
before continuing.

4. Right-click the TruVision device and select Configure Device. Navigator opens the
device’s internal configuration web page.

5. Configure the device with the required preferences. See the device’s user manual
for all configuration options.

Note: For cameras not connected to a recorder, enter the camera’s login credentials
to proceed.

6. When complete, click the Close button to save any configuration changes and
return to Navigator.

Notes:
1. Some devices cannot be configured remotely using Navigator.

2. The trusted source for camera titles is the device itself. When adding a device for
the first time, Navigator does not display the device’s configuration information at
the time of connection. The cameras in the Navigator panel may display generic
camera titles (Camera 1, Camera 2, Camera 3, etc.). Camera names are
updated after performing device configuration for the first time. Afterwards, any
changes to camera titles through Navigator updates both the Navigator and the
device.

3. For protocol configuration of analog PTZ cameras attached to an embedded
NVR via an encoder, use encoder web administration rather than the embedded
recorder configuration menu.

Adding a TruVision 360° camera

Navigator supports Interlogix 360° fisheye cameras. These cameras can be added to
TruVision NVRs as a regular IP camera either manually or using the discovery tool.

Each fisheye camera provides five streams to the user.
« 1 x Raw 360° image (also contains a substream)

* 1 x Two 180° bands in one video stream

* 3 x120° streams with digital PTZ capability

When a fisheye camera is added to a device, the camera appears in the Navigator
panel and has its own device node with up to five channels listed under it. By default,
the fisheye camera is added with only the 360° mode enabled.
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To add the rest of the views:

1. Ensure that the Fisheye Mode in the camera configuration menu is set to Multi
Channel Mode. See the camera’s user manual for details.

2. Right-click on the camera’s device node and select Properties.

3. Inthe Properties menu, click the Cameras tab and select the Show Camera check
boxes for the views to display.

4. Click OK.

For information about dewarping 360° cameras, see “Dewarp views” on page 119.

Adding a V-Stream

V-Streams combine output from all camera channels in a recorder into a single stream.
V-Streams only appeatr if they are configured in the recorder.

To view a V-Stream, click on a V-Stream icon in the Navigator panel and drag it to a
video tile in the Viewer panel.

Adding maps
Maps or floor plans can be added as PNG, JPEG, GIF, or BMP files.

To add a map:
1. Right-click the Map icon in the Navigator panel and select Add Map.

2. The Open Map File window appears. Navigate to the image file for the map required
and click Open. The map appears in the Navigator panel under Maps.

3. Double-click the map name or drag and drop to open it in a video tile. Clicking the
camera icons placed on the map launches the selected camera’s video. When the
camera receives a notification, a color-coded box appears around the camera icon.
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4. Click the left mouse button inside the video tile to move the map in any direction
inside the tile.

5. Right-click on the map and select Zoom to fit to re-center the map and have it fill
the video tile.

To rename or delete a map:

Right-click on the map name in the Navigator panel and select Rename Map or Delete
Map.

Configuring maps

Camera, recorder, access control door, access control panel, intrusion panel, and
intrusion sensor icons can be added to maps to represent their physical locations.
Cameras can be connected to doors to enable the launching of video whenever a door
is opened. Cameras can also be connected to intrusion areas and sensors and
generate video that can be launched from the Notifier.

Selecting any element in a map while pressing the Alt key highlights other elements
associated with the selection. Clicking on the map itself while pressing the Alt key
highlights all elements on a map. Pressing Ctrl while rotating the mouse wheel permits
zooming in to the cursor on a map.

Note: The recommended map image size should be between 800600 and
1920x1080. Smaller images will cause markers to appear overly large. Conversely,
larger images will make markers appear very small.

Map icon definitions:

Icon Description

Video icons (green)

IP camera

PTZ dome camera

360° fisheye camera

Alarm output trigger on

Alarm output trigger off

Recorder
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Icon Description

Access control icons (gold)

TruPortal access control panel

Access control panel door closed

Access control panel door open

Network switch icons (red)

O IFS network switch

Intrusion icons (blue)

Interlogix control panel

Intrusion sensor ready

Intrusion sensor not ready

Intrusion sensor alarm

Intrusion sensor bypass

Other icons

Web site. Double-click to launch a web site from a map.

Submap. Double-click to launch a secondary map.

Adding and positioning icons:

1. Right-click the map name in the Navigator panel and select Configure Map.

2. Click and drag a camera, recorder, digital output, access control panel (if a
TruPortal system has been added to Navigator), access control point (door icon), a
website, or another map from the Navigator panel to any point on the map.
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3. Right-click on a camera and select Orientation to change the position of the
camera to mimic its physical orientation.

4. To manually rotate an IP camera icon, press Ctrl and click on the icon. The rotation
of the camera icon follows the mouse, and the icon changes color during rotation.
The cursor also changes to indicate the direction set for the camera.

5. Click OK to save.

6. To remove an icon, right-click on it and select Delete.

Viewing associated items on a map:

1. Hold down the Alt key and click on a recorder icon (1). Orange boxes appear
around all cameras (3) and alarm outputs (2) associated with the recorder.

2. Hold down the Alt key and click on a camera icon (1). Orange boxes appear around
all recorders (3) and alarm outputs (2) associated with the camera.
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Connecting an access control point to cameras on a map:

1.

In the Configure Map window, right-click on an access control point (door) and
select Link Cameras.

Select all cameras on the map to link to the door (or select Select All), and then
click OK.

To see which cameras and access control panels on the map are linked to a door,
hold down the Alt key while clicking on the panel icon (1) and orange boxes appear
around the door (2) and connected camera (3) icons.

Whenever the door is opened, notifications from linked cameras appear in the
Notifier panel (see Chapter 7 “Notifier panel” on page 127). Click the camera
notification in the Notifier panel to launch video recorded when the door was opened
in the Viewer panel (see Chapter 6 “Viewer panel”’ on page 106). If a linked camera
has been assigned to the Event Monitor, video from the camera displays in the
Event Monitor if the door’s reader is swiped or if the door is opened. Doors can be
opened from maps in the Viewer Panel by double-clicking on a door icon.

Configuring or viewing recent activity—access control panel icon:

Right-click on an access control panel icon and select View Recent Activity to view
a list of recent events associated with the panel. Click the Microsoft Excel® icon to
export the list of events to a spreadsheet.

Right-click on an access control panel icon and select Configure to bring up the
TruPortal login page. Refer to the TruPortal Software User Guide or TruPortal Help
for configuration instructions.

Configuring a map for intrusion notifications:

See “Configuring a map for intrusion notifications” on page 83.
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Launching maps and websites from a map in the Viewer Panel:

In a map in the Viewer Panel that has been configured to include one or more submaps
and/or websites, double-click on a submap or website icon to launch it in a Viewer
Panel tile.

Operating alarm outputs:

In a map in the Viewer Panel that has been configured to include one or more recorder
or camera alarm outputs, double-click on a output icon to turn it on or off. A small green
circle appears on the digital output icon when an output is triggered (on).

To delete a digital output from a map, right-click on the icon and select Delete.

To see which cameras on the map are linked to an output, hold down the Alt key while
clicking on the output icon and orange boxes appear around the connected camera
icons

Adding websites

Websites can be added to the Navigator panel for viewing and navigating in the Viewer
panel.
To add a website:

1. Right-click on the Websites node in the Navigator panel and select Add Website.
The Add Website window appears.

2. Type atitle for the website in the Title field, and then type or copy/paste the
website’'s URL into the URL field.

3. Double-click on the website icon or drag it to a tile in the Viewer panel to view and
navigate the website.

Navigate the website in the Viewer panel tile using the pointer, scroll bar, and the icons
in the top menu (Forward, Back, and Refresh). To delete a website, right-click on the
website icon in the Navigator panel and select Delete Website.

To configure a website in the Navigator:

1. Right-click on the website icon in the Navigator panel that requires configuration and
select Configure Website. The Configure Website window appears.

2. Type a new title for the website in the Title field or type or copy/paste a new URL
into the URL field.

Adding TruPortal access control systems

TruPortal™ is an IP appliance-based access control system that integrates with
TruVision Navigator.
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After installing the TruPortal SDK, add TruPortal systems to the Navigator panel by
choosing one of the following options from Access Control:

e Add manually

e Add via discovery tool

Installing the TruPortal SDK

Note: The TruPortal SDK 1.1.54 or later plug-in must be installed before Navigator
can communicate with the TruPortal panel.

To download and install the TruPortal SDK plug-in:

1. Go to www.interlogix.com/library.

2. Type “TruPortal SDK” into the Search Download Library field.

3. Download the TruPortal SDK plug-in Zip file and extract the contents to a folder on
the local computer.

4. Launch Internet Explorer 9 or later and type the IP address of a TruPortal panel
installed in the local network into the Address bar.

Log into the system as a user with Plugins > Modification permissions.
Select System Administration > Plugins.

Click the Install button.

Click the Select File button.

© ©o N o o

In the Open dialog box, navigate to the folder containing the plug-in package (the
file has a .LFF extension), select the file, and then click Install.

Note: Plug-in installation may take up to 10 minutes. The panel restarts after successful
installation. The plug-in automatically starts after the panel restarts.

Adding TruPortal systems manually
1. Follow the instructions under “Installing the TruPortal SDK” above.

2. Right-click the Access Control node, and then select Add Panel > Add Manually
from the drop-down list. The Access Control Panel Properties window appears.

Note: There is only one option for the Panel Type so it is selected by default.

3. Type a name in the Panel Title field. Values are alphanumeric. The default panel
title is My TruPortal.

4. Type the device’s IP address in the Panel Address field.

5. The Port field is pre-populated with a default value based upon the type of device
selected. If the port assigned to the device is different from the default value, type
the correct port value in this field.
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6. Type the required values in the Username and Password fields. These fields are
only required if the device being added has been configured to require a username
and password.

7. Select the Enable SSL check box if required by the server.
8. Click OK.

Note: After clicking OK, fields highlighted with a red exclamation point indicate rejected
values. Move the mouse pointer over the exclamation points for tips on why the values
were invalid. All fields must be valid to successfully add a device.

Adding TruPortal systems using the discovery tool

Navigator is equipped with an embedded device discovery tool that discovers devices
such as recorders, cameras, and encoders in the network and permits the addition of
one or more of those devices.

IMPORTANT: A wired network connection is required for device discovery. A device
cannot be activated via a Wi-Fi network connection.

1. Follow the instructions under “Installing the TruPortal SDK” on page 77.

2. Right-click the Access Control node, and then select Add Panel > Add via
Discovery Tool from the drop-down list. The Discovered Access Control Panels
window appears and provides a list of available control panels in the network.

3. .To add control panels to the Navigator, select one or multiple panels from the list
and click Add. The panel(s) appear under the Access Control node in the Navigator
panel.

Note: The discovery tool attempts to add access control panels by using their
default credentials. If the credentials of a panel are previously changed from default
values, the panel still gets added to the Navigator panel, but it is shown as offline. In
this case, updated credentials need to be applied manually by right-clicking on the
panel and selecting Properties or Configure.

4. Expand the Access Control node to view all panels added to the system. Upon
successful connection, the Navigator populates the respective doors under each
panel. To unlock a door, right-click on the door icon and select Unlock.

Access Control configuration requires that Adobe Flash be installed on the computer
performing the configuration. See the TruPortal Software User Guide for instructions on
configuring TruPortal.

Performing lock and unlock operations

Right-clicking on the Access Control node provides the following lock/unlock
operations:

* Global Lockout — Lock out all doors of all panels.

 Global Reinstate — Reinstate all doors of all panels.
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Right-clicking on an Access Control panel provides the following lock/unlock
operations:

* Reinstate All Doors — Restores all doors to their normal state, unless a designated
unlock input is active (see the TruPortal Software User Guide for details).

e Lockout All Doors — Locks all doors and ignores credentials, so that nobody can
enter or exit. After issuing this command, reinstate all doors so that individual doors
can be controlled directly.

e« Unlock All Doors — Releases the locks on all doors, allowing free access and
egress. After issuing this command, reinstate all doors so that individual doors can
be controlled directly.

Right-clicking on a door icon provides the following lock/unlock operations:

 Unlock — Releases the lock on the door, allowing free access and egress until the
door state is changed by either a reader schedule or a global (“all doors”) command.

* Reinstate — Restores the door to default behavior based on the schedule.
* Lockout — Locks the door and ignores credentials so that nobody can enter or exit.

e Secure — Locks the door.

Recent activities

Select Recent Activities in the Access Control panel context menu to view a list of time
stamped events associated with each door in the panel. Click the Export List button to
export the list of recent activities in the CSV file format.

TruPortal multisite configuration

Under the Access Control node, a single user credential can be assigned to multiple
TruPortal panels grouped into one site by using folders to separate sites. Using this
logic, panels grouped under a folder belong to a single site or group of sites. See the
example below:
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Notes:

1. The panel or panels under each folder operate as a single system, and each system
can accept a maximum of eight card formats simultaneously. Card format refers to
the format of data containing credential ID information (standard 26-bit, for example)
encoded in door/entrance access cards/badges.

2. The name of each card format must be unique within a system since the card format
name is the identifier, not the format itself.

3. Card formats of the same name are considered the same card format in TruPortal.

4. We suggest renaming access control panels in Navigator with site-specific names
(see example above) to make user access assignment easier.

To assign user access levels:

Note: Users must be added and configured with credentials in the TruPortal web Ul
before assigning access levels in Navigator. We suggest that user names be as unique
as possible, using a middle name or initial when applicable. See the TruPortal Software
User Guide for instructions on configuring TruPortal.

1. Right-click on an access control panel or folder and select Assign User Access.

2. The Assign User Access window appears. If necessary, find a user by typing their
name into the Search box and click Search. Select the check box next to the user
image. Only one user can be selected at a time.

3. Select the check box next to the credential number(s) associated with the user.
Panels appear in the Assign User Access window, and those associated with the
user display a green bar across the top (select Show Assigned Permission in the
Filter drop-down list to show only these panels).
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4. Select individual panels or click the Select All Panels button to assign access
levels for the user. Click Remove All Access Levels to remove all access, or
Refresh to update recently assigned access levels.

5. When finished, click Apply.

To assign an event notification:

Right-click on a panel door icon and select Assign Event Notification. When the user
accesses the door, an access control notification pop-up window appears with the
user’'s name, associated picture, and a notification description such as “Access
Granted.”

Adding intrusion detection

Supported Interlogix intrusion panels can be added to the Navigator panel. Intrusion
areas and sensors can be monitored in the Navigator panel and/or the viewer panel.

Setup prerequisites for adding an intrusion panel to
Navigator

1. The Interlogix intrusion panel must run one of the following firmware versions for
interoperability with Navigator:

UltraSync Self-Contained Hub BO403001A58P002011-33 or later

UltraSync Modular Hub B0403001A56P002005-01 or later
ZeroWire B0403001A58P002010-31 or later
xGen B0403001A56P002005-16 or later

2. The discoverable Interlogix intrusion panel (see step 1 for information) must be fully
set up and functioning with intrusion areas and sensors installed and/or defined
prior to adding it to the Navigator panel. Go to www.interlogix.com or
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www.firesecurityproducts.com and download the appropriate reference manual
and/or installation guide for details.

The Interlogix intrusion panel web Ul must have the Enable Status Broadcast
setting enabled in order for it to communicate effectively with Navigator. See one of
the reference manuals listed above for further details.

Adding intrusion panels manually

1.

5.
6.

Right-click the Intrusion Detection node, and then select Add Panel > Add
Manually from the drop-down list. The Intrusion Panel Properties window appeatrs.

Note: There is only one option for the Panel Type so it is selected by default.
Type a name in the Panel Title field. Values are alphanumeric.
Type the device’s IP address in the Panel Address field.

Note: The Port field is pre-populated with a default value based upon the type of
device selected. If the port assigned to the device is different from the default value,
type the correct port value in this field.

Type the required values in the Username and Password fields. These fields are
specific to intrusion detection and unique to each individual, and must be assigned
by the intrusion panel administrator. The user name must begin with “TruNav-.”

Select the Enable SSL check box if required by the server.
Click OK.

Note: After clicking OK, fields highlighted with a red exclamation point indicate rejected
values. Move the mouse pointer over the exclamation points for tips on why the values
were invalid. All fields must be valid to successfully add a device.

Adding intrusion panels using the discovery tool

IMPORTANT: A wired network connection is required for device discovery. A device
cannot be activated via a Wi-Fi network connection.
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Right-click the Network Switches node, and then select Add Panel > Add via
Discovery Tool from the drop-down list.

The Discovered Devices window displays and provides a list of available intrusion
panels in the network.

To add intrusion panels to the Navigator panel, select one or multiple panels from
the list and click Add.

Type the required values in the Username and Password fields. These fields are
specific to intrusion detection and unique to each individual, and must be assigned
by the intrusion panel administrator. The user name must begin with “TruNav-.”

Expand the Intrusion Detection node to view all panels added to the system. Upon
successful connection, the Navigator populates the respective sensors under each
switch.

Configuring a map for intrusion notifications

A map can be configured for intrusion notifications that will appear in the Notifier (see
Chapter 7 “Notifier panel” on page 127) and the Navigator panel. Notifications from
cameras linked to intrusion sensors or areas appear in the Notifier as video links.

To add an intrusion area to a map:

1.
2.

Right-click on a map in the Navigator panel and select Configure Map.

Expand the Areas folder under the intrusion panel name, and then drag and drop an
intrusion area icon onto the map.

Resize and move the intrusion area as needed. The fill color of the intrusion area
defaults to gray, but it can be changed by right-clicking on the area and selecting
Color.

To add an intrusion sensor to a map:

1. Right-click on a map in the Navigator panel and select Configure Map.
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2. Expand the Sensors folder under the intrusion panel name, and then drag and drop
an intrusion sensor icon onto the map. A green icon appears on the map.

3. Move the intrusion sensor on the map as needed. Sensors should be placed within
a defined intrusion area.
To link a camera to an intrusion area or sensor:

1. In the Configure Map window, right-click on an intrusion area or sensor and select
Linked Cameras.

2. Select the cameras to link to the intrusion area or sensor (or select Select All) and
then click OK.

3. To see which cameras on the map are linked to an intrusion area or sensor, hold
down the Alt key while clicking on the area or sensor icon and orange boxes appear
around the connected camera icons.

To configure a sensor:

Right click on a sensor icon on a map in the Viewer panel and make the following
selection:

* Bypass — Permits arming of the panel while ignoring this sensor.

To arm/disarm an intrusion area:

» Right-click on an intrusion area in either the Navigator panel or a map in the Viewer
panel and select Arm > Away or Arm > Stay to arm the area.

» Right-click on an intrusion area in either the Navigator panel or a map in the Viewer
panel and select Disarm to disarm the area.

* Right-click on the Intrusion Detection node and select Global Arm > Away or
Global Arm > Away, or Global Disarm to apply settings to multiple intrusion areas
and/or panels.

Intrusion area status

Intrusion area icon definitions are as follows:

E Disarmed

_ﬁ_ Armed in Stay mode. The area will be ignored
by the intrusion panel.

E‘] Armed in Away mode.

In addition to the icon changing in the Navigator panel, intrusion area status is also
shown on maps in the Viewer panel. The border around the intrusion area changes
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according to the armed or disarmed state. For example, an intrusion area armed in the
Away mode appears as follows:

Configuring the intrusion panel

1. Right-click on an intrusion panel and select Configure Panel. A video tile containing
the intrusion panel interface appears in the Viewer panel.

2. Type in the required name and password and click Sign In. Go to
www.interlogix.com or www.firesecurityproducts.com and download the appropriate
reference manual and/or installation guide for details on using the intrusion panel
web Ul.

Adding network switches

Interlogix IFS® network switches can be added to the Navigator panel. Port status and
statistics for each port on a network switch can be monitored in the navigator panel
and/or the viewer panel.

Adding network switches manually

1. Right-click the Network Switches node, and then select Add Device > Add
Manually from the drop-down list. The Network Switch Properties window appears.

Note: There is only one option for the Panel Type so it is selected by default.
2. Type a name in the Panel Title field. Values are alphanumeric.
3. Type the device’s IP address in the Panel Address field.

4. The Port field is pre-populated with a default value based upon the type of device
selected. If the port assigned to the device is different from the default value, type
the correct port value in this field.

5. Type the required values in the Username and Password fields. These fields are
only required if the device being added has been configured to require a username
and password.

6. Select the Enable SSL check box if required by the server.
7. Click OK.

Note: After clicking OK, fields highlighted with a red exclamation point indicate rejected
values. Move the mouse pointer over the exclamation points for tips on why the values
were invalid. All fields must be valid to successfully add a device.
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Adding network switches using the discovery tool

IMPORTANT: A wired network connection is required for device discovery. A device
cannot be activated via a Wi-Fi network connection.

1.

Right-click the Network Switches node in the Navigator panel, and then select Add
Device > Add via Discovery Tool from the drop-down list, or click the Add
Devices button B® and then select Add via Discovery Tool.

The Discovered Devices window displays and provides a list of available network
switches in the network.

To add network switches to the Navigator panel, select one or multiple switches
from the list and click Add. The switch(es) appear under the Network Switches node
in the Navigator panel.

Note: The discovery tool attempts to add network switches by using their default
credentials. If the credentials of a switch are previously changed from default
values, the switch still gets added to the Navigator panel, but it is shown as offline.
In this case, updated credentials need to be applied manually by right-clicking on
the panel and selecting Configure Device.

Expand the Network Switches node to view all switches added to the system. Upon
successful connection, the Navigator populates the respective ports under each
switch.

Port information and display
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Note: An ONVIF-compliant camera or recorder connected to an ONVIF-compliant
network switch port displays the model name and IP address in the Navigator panel. If
an attached camera is in the Navigator panel, the camera name also appears here.

Network switch icon definitions are as follows:

Switch port active with PoE.
Switch port active.

E Switch port inactive.

ﬁ ONVIF-compliant network switch.

To view a network switch front panel in the Viewer panel:

1. Click the Custom View button in the Viewer panel and select a one-up or stacked
horizontal view (see “Custom view” on page 113 for details).

2. Right-click on a network switch in the Navigator panel and select Display Front
Panel.

3. Type the user name and password for the switch in the security window and click
OK. The front panel of the switch appears in the Viewer panel.

To view network switch statistics:
1. Right-click on a network switch icon and select Run Network Statistics.

2. Select Bar Chart or Line Chart to view incoming and outgoing bandwidth per port.
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To view port statistics:

Right-click on a port icon and select Port Statistics. A line chart appears that shows
incoming and outgoing bandwidth for the port.

Configuring network switches

1. Right-click on a network switch icon in the Navigator panel and select Configure
Device.

2. Type in the user name and password for the switch. The configuration main web
page appears. See the user manual for the specific IFS switch model for
instructions on how to use the web Ul to manage and configure the switch.
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Note: If a switch is plugged into a switch via an RJ45 connector, it must be properly
configured so that it appears in the Navigator panel. Go to Port Identification >
Configuration in the switch’s web Ul and select Switch from the drop-down list next to
the port number that the switch is connected to.

To power cycle a device connected to a PoE port:

Right-click on a port in the Navigator panel and select POE Reset. The port color will
turn green and then turn orange again after 30 seconds.

To reboot a network switch:

Right-click on a network switch icon and select System Reboot to power cycle the
switch.

Adding logical views

Logical views provide the flexibility to display the physical devices in any configuration
required.

To add a logical view:

1. Right-click on the Logical View node in the Navigator panel and select Add Logical
View. The Configure Logical View window appears.

2. Type atitle for the view in the View Name field, and then drag and drop cameras
from the Logical View panel into the Camera List field.

3. Use the up and down arrow buttons to move cameras within the list. When finished,
click OK to create the new logical view. To delete a logical view, right-click on the
logical view icon in the Navigator panel and select Delete.
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Search

Use Search to find any recorder, camera, map, website, access control point, intrusion
panel, network switch, or logical view in the Navigator panel.

To perform a Navigator panel search:

1.

Type any alphanumeric string into the Search field at the top of the Navigator panel
and press Enter. Focus goes instantly to the object that matches the string.

Press Enter again to move to the next object that matches the string, and so on,
until each item matching the search criteria has been found. Type a different
alphanumeric string into the Search field to perform another search.

Adding folders

Adding folders provides a way to organize Navigator panel items in a logical manner.

To organize the Navigator panel:

1.

Click on a top-level node (Devices, Maps, Websites, Access Control, Intrusion
Detection, Network Switches, or Logical Views) and click the Add Folder button
=7. This creates a new folder.

Type a name for the new folder and press Enter.

To add a sub-folder within the previously created folder, right-click the parent folder
and select Add Folder.

Click and drag items into folders or folders within folders. Cameras always stay
attached to their respective devices.

Devices context menu

Right-click on the Devices node to bring up a context menu. Available selections are as
follows:

Add device
See “Adding devices” on page 66.

Add folder

See “Adding folders” above.
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Run health diagnostics

Right-click on the Devices node and select Run Health Diagnostics to review health
diagnostic data across all of the devices in the system. Move the scroll bar at the
bottom of the window to the right to see all health diagnostic information.

Use the filters and date parameters to pinpoint the search. Export the contents of the
dialog to the CSV file format for case management, work orders, or issue resolution
documentation by clicking the Export to CSV button.

Note: For devices to appear in the Diagnostics window, health diagnostics must be run
at the device level first. See “Automated diagnostic polling” on page 33 for information
on setting automatic diagnostic polling for recorders or “Run health diagnostics” on
page 93 for manual, device-level generation of health diagnostics.

Open exported video file

Right-click on the Devices icon and select Open Exported Video File to browse for
and launch an exported video in the Viewer.

Recorder context menu

Right-click on a recorder’s device icon to bring up a context menu. Available selections
are as follows:

Run tampering monitor

Navigator is equipped with a tampering monitor that compares the current image with a
reference image taken during the installation. The tampering monitor keeps a record of
each camera by taking a reference snapshot and storing it in the database.
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To open the tampering monitor, right-click a recorder and select Tampering Monitor.
The Tampering Monitor window appears.

Reference images are listed with the date and time they were taken in the Reference
Image column. For the first time applications of this feature, the reference images are
empty. In this case, click Update All to save the reference images. Tampering activity
on each camera can be monitored by comparing reference images with live images
located on the right side of the window.

Run device report

Navigator permits export of health diagnostics information by generating a device
report.

To generate the device report:

1. Right click a recorder icon in the Navigator panel.

2. Select Run Device Report. The device report displays in a new window.

Note: It may take up to a minute to complete the device report depending on the
number of cameras recording to the device and the network connection.

3. Click Export to PDF to save the report as a PDF.

As a part of the report, tampering monitor images are also provided at the bottom of the
report in the Camera Check section. For more information on the tampering monitor,
see “Run tampering monitor” on page 91.
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Run health diagnostics

To run a manual health diagnostic snapshot on a single recorder, right-click the device
in the Navigator panel and select Run Health Diagnostics.

The Device Diagnostics window appears and displays the full set of health diagnostic
data for that particular device. See Appendix B “Device details” on page 151 for more
details on the different health diagnostics available for each device.

Run network statistics

Right-click the device in the Navigator and select Run Network Statistics to launch the
Network Statistics window. The outgoing and incoming network bandwidth limit and
usage appear in a graphical format. The number of open video streams on the system
at the device level also appears.
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Select or deselect items under Outgoing Bandwidth and Incoming Bandwidth. Click
Close to exit the Network Statistics window.

Note: Incoming bandwidth statistics do not appear when running network statistics on
DVRs.

Run disk analysis

Disk analysis provides a timeline view of video recorded to disk on all connected
cameras. Color coded video tags are defined in the bottom of the Disk Analysis
window.

Note: Areas in the timeline tagged as Other (gray) may or may not contain recorded
video. The device may have been offline or not configured to record video during the
period of time indicated.

To run disk analysis and play back video:

1. Right-click on the device icon in the Navigator panel and select Run Disk Analysis.
The disk analysis window appears.

2. Select a time range of recorded video in the Start Time and End Time fields.
3. Select cameras for disk analysis in the Select Cameras section and click Search.

4. Select check boxes to the left of each camera name as necessary. Video from all
cameras selected play back simultaneously in the Viewer during playback.

5. If necessary, click the Zoom In and Zoom Out buttons or click on the timeline and
slide it to the left or right to locate a specific point in time.

6. Double-click anywhere on the disk analysis timeline to play video in the Viewer from
that point in time.
To export video from the Disk Analysis window:

1. If necessary, click the Zoom In and Zoom Out buttons or click on the timeline and
slide it to the left or right to locate a specific point in time

2. Slide the beginning and ending timeline markers to highlight a segment of time in
green on the timeline bar.

3. Right-click a disk analysis track and select Export Video from the menu or click the
Export Video button.
To view video thumbnail images in the Disk Analysis window (TVR46):

Hover the cursor over a point in a camera timeline with recorded video to see a
thumbnail image of the video.
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Trigger outputs

Note: This feature is only supported for TruVision devices. Refer to Appendix B “Device
details” on page 151 to see which devices have trigger outputs.

Some TruVision recorders have alarm output ports that can connect to external
devices. Alarm outputs can be configured to be triggered by an event, such as camera
motion detection.

There are two types of trigger outputs: (A-> — Analog) and (D-> — Digital). Alarm type
(A->) are alarms from the trigger through the back of the recorder. Alarm (D->) are the
alarms triggered out of the IP camera. Only NVR/Hybrid devices have the (D->) type
alarms.

To set trigger outputs:

1. Right-click a recorder and select Trigger Outputs. Alarm output numbers are
replaced with alarm output names when configured in the device’s configuration
interface (see the device’s user manual for details).

2. Toggle the trigger output switches to the on position (green) as necessary.
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Note: TVR 60 and TVN 20 do not support (D->) types alarm. This is a hardware
limitation.

Manage IP cameras (IP camera recorders only)

Right-clicking a recorder and selecting Manage |IP Cameras launches the IP Camera
Status page in the Configuration interface. See the recorder’s user manual for details
about IP camera configuration.

Search

Search multiple cameras for alarms, alarms plus events, motion, and point-of-sale text-
related video in the Search window. Searchable cameras must be configured for the
search criteria specified.

Select check boxes in the Search by and Select Cameras areas to customize a search,
and then click Search when finished. If a camera is set to record a substream in
Navigator, search criteria can only be located by clicking Search Substream.

To search for video tagged with text:

1. Ensure that the device being searched for is working in conjunction with a legacy
ProBridge 3 text converter or via the NPCII, a third party converter. See “POS
mode” on page 123 for further details.

2. Click the Text check box, type the text string in the Text field, and click Search.

Select or deselect the text overlay feature in the camera or recorder configuration
settings to overlay the text on the video or place it beside the video (see the device’s
user manual for details). This check box is dynamic and, if selected or deselected
during playback, the text switches from overlay to side-by-side and vice-versa (the
switch takes a few seconds).

Different devices support varying levels of search capabilities. See Appendix B “Device
details” on page 151 for further details on what types of video data are available for
each device.
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Export video
Export video from one or more cameras either immediately, at a specified time in the
future, or on a recurring basis in the Export Video window.

Export Now/Schedule

To export video from the recorder on a one-time basis:
1. Right-click on a recorder icon in the Navigator panel and select Export Video.

2. Accept the default location or click Browse and specify a destination location for the
export.

Note: Ensure that the destination location for the export has enough disk space
capacity to store the exported video. We recommend that this location be different
than the location specified for recurring schedule video downloads.

3. Select one or more cameras for video export in the Select Cameras list.

4. To start the export process immediately, select Export Now. The export task is
automatically added to Tasks. Move the mouse pointer over the status column in
the Tasks window to see detailed progress of the export.

5. To schedule the export process, select Schedule and specify a date/time to start
the export process. An export task is automatically added to Tasks. To remove the
record of the scheduled export from Tasks, select the Remove this task when
complete check box.

6. Click OK.

7. When export tasks are complete, the exported video can be found at the location
specified along with the TruVision Navigator Player program. See Chapter 10
“TruVision Navigator Player” on page 136.

Recurring schedule

We recommend creating a separate folder for recurring task video exports, which are
downloaded and stored in their own directory. The full download folder structure is as
follows:

C:\[VideoDownloadFolder]\AutoArchive\[DeviceTitle]\Cameras\[CameraNames]
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When scheduling a recurring task, an alert appears showing the estimated available
storage space in the target location. Available space for video export is calculated each
day before video download. If there is insufficient space in the target location, a warning
alert is sent to the administrator via email if Video Export Failure is selected in the
Settings > Notifications window.

To export video from the recorder on arecurring basis:

1. Right-click on a recorder icon in the Navigator panel and select Export Video.

2. Click Browse and specify a destination folder for the export.

Note: Ensure that the destination folder for the export has enough disk space
capacity to store the exported video. We recommend that this folder be used
exclusively for recurring video downloads.

3. To schedule the export process, select Recurring Schedule and select Everyday
or individual days of the week for the recurring video export.

4. Specify a daily time range for the video export (24 Hour or Custom Time). Specify
the start and end times for each day if selecting Custom Time.

5. To remove the record of the scheduled export from Recurring Tasks and Tasks,
select the Remove this task when complete check box.

6. Select one or more cameras for video export in the Select Cameras list.

7. Select the range of recurring dates from the Recurring Start Date and Recurring
End Date drop-down lists.

8. Click OK. An export task is automatically added to Recurring Tasks and Tasks.

9. When export tasks are complete, the exported video can be found in the directory
under the download folder in the camera name folders.
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Configure device

Right-clicking a recorder icon in the Navigator panel and selecting Configure Device
launches the recorder’s configuration interface. See the recorder’s user manual for
details on recorder configuration.

Upgrade firmware

Devices that support the upgrade firmware function are listed in the “Supported
Devices” row in the device details tables (see Appendix B “Device details” on page
151).

Follow the instructions below to upgrade firmware on TruVision recorders with the
newer recorder configuration.

To upgrade firmware to device(s):

1.
2.
3.

Right-click a recorder icon in the Navigator panel and select Configure Device.
Select Upgrade Firmware under Device Management.
Click Browse to find the applicable firmware file.

Note: Since TruVision Navigator does not do a file format check on the firmware file,
ensure it is in the proper file format for that device type. In addition, the firmware file
must reside on the local computer. It cannot be accessed across network paths.

Click the Upgrade button.
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Download/upload configuration

Devices that support the download/upload function are listed in the “Supported
Devices” row in the device details tables (see Appendix B “Device details” on page
151).

Use the Download Configuration and Upload Configuration selections to transfer
recorder configurations between individual devices.

* Right-click on the recorder and select Download Configuration to save the
recorder’s configuration in CFG file format.

» Right-click on the recorder and select Upload Configuration to upload a different
recorder configuration to the selected recorder in CFG file format.

Reboot device
1. Right-click a recorder icon in the Navigator panel and select Reboot to reboot it.

2. Click Yes to confirm reboot of the device. The recorder icon changes to [ in the
Navigator panel to indicate that it is offline.

3. After the device reboots, right-click on its icon in the Navigator panel and select
Connect to reconnect it.

Restore factory defaults

Devices that support the restore factory defaults function are listed in the “Supported
Devices” row in the device details tables (see Appendix B “Device details” on page
151).

1. Right-click a recorder icon and select Restore Factory Defaults to have the device
default to factory settings (the same settings on the device when it was shipped).
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2. Click Yes to confirm reboot of the device. The recorder icon changes to [l in the
Navigator panel to indicate that it is offline.

3. After the device reboots, right-click on its icon in the Navigator panel and select
Connect to reconnect it.

Delete/rename device

* Right-click on the recorder icon and select Delete Device to remove the recorder
from the Navigator panel.

» Right-click on the recorder icon and select Rename Device to change the name of
the recorder in the Navigator panel.

Properties

Right-click on the recorder icon in the Navigator panel and select Properties to display
the Properties window.

* The Connection tab shows all of the information previously entered when adding
the device. Make changes as appropriate and click OK to save changes.

* The Details tab provides an area to type in contact information and notes to help
facilitate management of the system. If the device was imported from an address
book that contained information in this window, data appears in these fields. Type in
data as appropriate and click OK to save changes.
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e Use the Cameras tab to hide or show cameras, enable or disable PTZ and fisheye
controls, and set the mount type. When finished, click OK to save changes.

Camera context menu

Search

This function is the same as searching from a recorder, but only the camera selected
can be searched (smart search excepted). See “Search” on page 96.

Selecting the Smart Search box includes a search for motion detection and dynamic
analysis, both of which must be enabled in the TruVision recorder or camera
configuration page. Certain recorders require the drawing of an area to be used for
smart search in the grid that appears on the Motion Detection page. See the user
manual for the specific recorder for further information.
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Export video

This function is the same as exporting video from a recorder, but video can only be
exported from the camera selected. See “Export video” on page 97.

Configure camera

Devices that support the configure camera function are listed in the “Supported
Devices” row in the device details tables (see Appendix B “Device details” on page
151).

Right-click on an analog camera and select Configure Camera to access the camera
configuration menu. See the camera’s user manual for further information on camera
configuration.

Preset sequences

A PTZ camera’s presets can be built into a sequence based on a specific order and
dwell time. These sequences can be created, managed, and tested by right-clicking on
the PTZ camera in the Navigator and selecting Preset Sequences > Manage
Sequences.

To create a preset PTZ sequence:

1. Click the % button to add a sequence.

2. Type a name for the sequence or leave the default name as-is.

3. Click on a preset number in the Presets list and then click the right arrow button to
add the preset to the Preset Order list.

4. Repeat step 3 as necessary and use the up and down arrows to change the order of
presets in the Preset Order list.

To test a preset sequence:

1. Create a preset sequence following the steps above.

2. Click Test. The sequence deploys in a video tile in the Viewer.
3. Click Stop to finish the test.
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To stop or start a preset sequence:

Right-click the PTZ camera icon in the Navigator panel and select Preset Sequences,
and then the name of the sequence to be stopped or started.

Assign to Event Monitor

The Event Monitor tab in the Viewer panel plays video of events and alarms
configured on individual cameras as soon as they occur. As a possible action for an
event, set up "Notify Alarm Host." The alarm host is set up under Alarm Settings. This
function is not supported by all cameras. See the camera’s user manual for instructions
on camera configuration.

For further details about the Event Monitor, see “Event Monitor” on page 109.

To assign a camera to the Event Monitor:

1. Right-click on a camera and select Assign to Event Monitor. An orange border
surrounds the camera icon in the Navigator panel.

2. Right-click on a camera assigned to the Event Monitor and click the check mark
next to Assign to Event Monitor to remove the camera from the Event Monitor.

Decoder context menu

Decoders convert compressed IP video streams from recorders to analog video outputs
such as HDMI, VGA, and BNC. Use the decoder context menu to add a scene to the
decoder. Configure Device, Reboot Device, Delete Device, Rename Device, and
Properties have the same functionality as in the recorder context menu.

Add scene

A scene is a custom view preset that outputs to one or more monitors. Each decoder
added to the Navigator panel has a default “scene01” already created. Other scenes
previously configured in the decoder also appear.

To add a scene:

1. Right-click on the decoder device icon and select Add Scene.

2. Type a name for the scene in the Title box.

3. Configure the scene as described in the next section.
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Scene context menu

Use the scene context menu to activate, configure, preview, rename, refresh, and
delete scenes. Scenes must be activated before they can be configured or previewed.
Only one scene can be activated at a time.

Note: Other users with the operate decoders permission can activate a scene and
deactivate your activated scene while you are working in Navigator.
To configure a scene:

1. Ensure that the scene is activated. If necessary, right-click on the scene icon and
select Activate Scene.

N

Right-click on the activated scene and select Configure Scene.

3. Click the HDMI, VGA, or BNC tab to configure a scene for the required monitor
output.

4. Click on a custom view (see “Custom view” on page 113 for details about custom
views).

Note: The O button selects a display of zero video tiles. If the maximum of 16 video
tiles are displayed in one tab, the number of tiles in the other tabs must be set to
zero.

5. Drag cameras from the Scene View panel into the custom view.

6. Click Save.

To preview a scene:

1. Ensure that the scene is activated. If necessary, right-click on the scene icon and
select Activate Scene.

2. Right-click on the activated scene and select Preview Scene.

3. Click the HDMI, VGA, or BNC tab to preview a scene for the required monitor
output.
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The Viewer panel displays both live and recorded video that can be launched from the
Navigator panel, Notifier, or Collector. Maps and websites can also be loaded into the

Viewer panel. With Custom Views, the Viewer panel can display one of 18 different tile
layouts.

Populating video tiles

To add an item to a single tile:

* Double-click a camera, map, or website in the Navigator panel to add it to the next
open video tile.

« Drag a camera, map, or website from the Navigator panel to an open video tile.

* Double-click an applicable event in the Notifier or a Collector panel video or
snapshot to add it to the next open video tile.

» Drag an applicable event in the Notifier or a Collector panel video or snapshot to an
open video tile.

To add items to multiple tiles:

» Drag a recorder or logical view from the Navigator panel to an open video tile.

* Hold down Shift while clicking the right mouse button or hold down Ctrl while
clicking the right mouse button to select multiple cameras, maps, or websites in the
Navigator panel and drag them to an open video tile.

When adding multiple items, tiles automatically increase in number and the layout
adjusts based on how many items are being added, unless the layout has been locked
with the Lock Current Layout button.

Double-clicking in any single tile enlarges it to full screen. Double-clicking the full
screen tile restores the previous tile layout.

Note: To ensure that a web page displays correctly in full screen mode, double-click on
the green bar at the top of the web page’s video tile.
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Organize/swap items in the Viewer by dragging a video tile’s status bar to another
video tile.

Tabbed viewer panels

Multiple tabbed viewer panels can be added to the Viewer (up to 10). These additional
viewer panels can also be detached and become free floating windows.

Videos in tabs not in the background can be paused to improve system performance.
See “Client” on page 23.

Note: A maximum of 75 substream video tiles with H.264 compression can be added to
tabbed viewer panels. Running too many videos in tabbed viewer panels may degrade
system performance.

To add a tabbed viewer panel:

1. Click the New Viewer button to add a new layout panel. A new viewing panel is
added as a tab in the Viewer panel title bar.

2. Populate the new viewing panel as described above. Drag a viewer tab out of the
Viewer title bar to turn the viewing panel into a free-floating window accessible in
the Windows taskbar. Drag the free-floating panel back into the title bar to access it
again as a tab.

3. Right-click on a viewing panel tab to access the tab’s context menu (Delete Tab or
Rename Tab).
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Viewer tab button functions

Custom/sequence view. Use custom views to define and save multi-site view
templates for future use.

]

Lock Current Layout. Prevents changes to the current viewer panel setup.

[<]

Select all. Select all tiles in the viewer.

]

Toggle. Toggle between normal view and maximized view.

]

Close All. Close all tiles in the viewer.

+ New Viewer. Add a tabbed viewing panel (10 maximum).

Video tile properties

Status bars at the top and bottom of camera video tiles provide the following
information:

Top bar

* Camera name

« Date and time of currently streaming video (live or playback)
* Sync status (see “Sync to this video” on page 118)

e Close this video tile button

Bottom bar

» Tile selection check box (selecting the check box in multiple tiles permits the
simultaneous use of timeline controls for all tiles selected)

» Camera type icon
* Recorder name

* Video stream status (Live, Playback, Recording, Closed, Live Paused, and
Playback Paused)

Bar color
+ Green - Indicates that the tile is selected

* Gray — Indicates that the tile is not selected
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* Yellow — Indicates that the tile is playing back a local file.

Event Monitor

The Event Monitor tab in the Viewer panel plays video of events and alarms
configured on recorders and individual cameras as soon as they occur. See the
camera’s user manual for instructions on camera configuration.

Event Monitor features include the following:

* The Event Monitor tab turns orange as soon as video begins playing in the
monitor.

« If multiple events assigned to the Event Monitor occur simultaneously, additional
video tiles are added automatically.

* The latest Event Monitor video is indicated by a red border around the video tile.

» After the maximum number of cameras (100) appear in the Event Monitor, the
oldest video is replaced with the newest video.

« A maximum of 100 video tiles can be displayed in the Event Monitor.

Note: The Event Monitor cannot play back an event that has already happened. To
view the last event, drag the video from the Event Monitor into a video tile in the
Viewer.

Event Monitor tab button functions

The Event Monitor buttons have the same functions as the Viewer tab buttons. See
“Viewer tab button functions” on page 108.

Timeline

When a specific video tile is selected (indicated by a green outline around the video
tile), the timeline functions affect that video tile. See “Buttons and indicators” on page
12 and “Playback controls” on page 14 for details on the function of each button and
the toggle switches in the timeline area. Timeline buttons only appear when they are
available to be chosen. For example, the Archive button will not appear until at least
one camera is currently in Playback mode.

To find a specific point in time in the timeline:
Search for video at specific points in time using any of the following methods:

¢ Click the Zoom In and Zoom Out buttons to locate a date and time in the timeline.

TruVision Navigator 8.0 SP2 User Manual 109



Chapter 6: Viewer panel

» Click on the gray timeline bar and slide it to the left or right to find a specific point in
time.

* Click the Go To Date button to specify a date and time in the timeline.

To play back video in the timeline:

* Double-click anywhere on the timeline to automatically play back the selected video
at that specific date and time.

* Click and drag the current live/playback cursor, which appears as a green seek
triangle icon on the gray timeline bar, to play video from anywhere along the
timeline.

To view video thumbnail images in the timeline (TVR46):

Hover the cursor over a point in the timeline with recorded video to see a thumbnail
image of the video.

Export video

Note: The Export video permission is required to export video from the timeline.

To export video from the timeline to the Collector:

1. Slide the beginning and ending timeline markers to highlight a segment of time in
green on the timeline bar.

2. Click the Save Video button. A green progress bar appears under the exported
video that turns blue after exporting is complete.

Local record

Use the Local Record button to record live video to the client computer.

Note: Be sure to turn off local recording before it takes up too much storage space on
the client computer’s hard drive.

To create a local record video file, do the following:

1. Select a camera video tile in the Viewer.

2. Click the Local Record button (to the right of the playback controls) or right-click in
the tile and select Start Local Recording to begin recording. A thumbnail appears
with a start time along with a red dot in the Collector.

3. Thered Local Record button blinks when any camera is recording locally.
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4. Click the red Local Record button again to stop the recording. An end time for the
thumbnail automatically appears in the Collector.

5. Follow export operations as necessary to save the local recording. See “Export
video and snapshots” on page 130.

Bookmarks

Adding bookmarks

Add a bookmark to the timeline for quick navigation to an incident.

Note: Bookmarks are stored in application memory, so all bookmark data is erased
when Navigator is closed.

To add a bookmark, do the following:

1. Select a single video tile.

2. Right-click on the timeline and select Add Bookmark or click the Bookmark icon
in the timeline controls (clicking the icon places the bookmark at the same location
as the play cursor). The Edit Bookmark window appears.

3. Type atitle for the bookmark (16 characters maximum) in the Title field.

4. If necessary, the time stamp can be modified and text can be added into the Notes
field (256 characters maximum).

5. Click OK. The bookmark icon appears in the timeline at the specified time stamp.

Working with bookmarks

Right-click on a bookmark in the timeline to access the bookmark context menu.

* Edit — Opens the Edit Bookmark window.

* Delete — Deletes the bookmark.

» Play — Opens a new tile and starts playing the video from the bookmark time stamp
position.

Viewing bookmarks

«  Click the bookmark show/hide buttons [H]//" to hide or display bookmarks.
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Hover the cursor over a bookmark icon to display bookmark information, The
bookmark title and time stamp appear in the 1st line and the notes appear in the
second line.

Only bookmarks for the selected video tile are visible on the timeline bar — no
bookmarks display if multiple tiles are selected.

It is not possible to create more than one bookmark with the same time stamp on
the same camera.

It is not possible to edit a specific bookmark when the timeline is in Zoom In mode
and there are multiple bookmarks around the same time stamp.
Bookmarks in exported video

Exported video retains bookmarks if the time stamp of the bookmarks fall within the
time range of the video. Bookmarks are retained in videos in the Collector after exiting
Navigator. Videos in the Collector that contain bookmarks appear as follows:

Double-clicking on a Collector video with bookmarks opens a video tile. The bookmarks
appear in the video playback timeline as shown below:

Hover the cursor over a bookmark icon to display bookmark information during

playback of exported video.

Note: Bookmarks cannot be edited or deleted during Collector video playback.

Thumbnails

Select a video tile, and then and hover the cursor over a recording in the timeline to
show thumbnails of the recording at the specified point in time. Thumbnails can also be
seen on the timelines in the Disk Analysis window (see “Run disk analysis” on page
94).

112 TruVision Navigator 8.0 SP2 User Manual



Chapter 6: Viewer panel

Note: This feature is only available with TVR46 recorders.

Custom view

Use custom views to define and save multi-site view templates for future use. Custom
views are available by clicking the Custom View button in the Viewer header bar .

Several different tile layouts can be chosen when arranging the video sources.
Standard tile layouts include 1x1, 2x2, 3x3, etc., up to 10x10. Other different custom
tile layouts are also available for additional flexibility. Click the Custom View button to
change the 3x3 default layout.

Note: A maximum of 20-30 custom views can be created. The maximum number
depends on the complexity of the custom views (factors such as tile layout, number of
videos in the tiles, and names of the custom views).

To define a custom view:
1. Load all the cameras to be included in the custom view into the Viewer.
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Click the Custom View button in the Viewer panel header bar.
Select Save custom view/sequence.

Type a title in the Title field.

Click OK.

Close all videos.

Select the Custom View title in the Viewer panel header bar drop-down list.

define a custom view as a camera sequence:

Load all the cameras to be included in the custom view into the Viewer.
Note: Maps and websites are ignored in camera sequences.

Click the Custom View button in the Viewer panel header bar.

Select Save custom view/sequence.

Type a title in the Title field.

Create a single-screen sequence of each tile from left to right by selecting the Save
as camera sequence check box.

If necessary, type a new value for dwell time in the Dwell Time field.
Click OK.
Close all videos.

Select the Custom View title in the Viewer panel header bar drop-down list. A
custom view camera sequence is indicated by the icon. A single video tile
displays each camera in sequence in the custom sequence.

edit a custom view:

Right-click on a custom view in the Custom View/Custom Layout window and select
Edit.

Type a new title in the New Title box and click OK. Make changes to the custom
view such as adding or removing an object from a tile, moving an object from one
tile to another, or editing the layouts of custom views if their layouts are also
custom.

Click Save when finished.
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To make a custom view public (client/server installations only):

Right-click on a custom view in the Custom View/Custom Layout window and select
Make Public to make the custom view available across the network.

Note: Public custom views cannot be made private, and only the user who created the
custom view can delete it.

Custom layout

In addition to the standard tile layouts provided, you can also create custom tile layouts.

To create a custom layout:

1. Click the Custom View button in the Viewer header bar, and then click the icon.
The Custom Layout window appears.

2. The Custom Layout window displays a 5x5 layout by default. This can be changed
by selecting 1x1, 2x2, 3x3, etc., up to 10x10.

3. Type atitle for the layout in the Title box and select cells to merge by clicking and
dragging inside the grid.

Note: A merge can only be performed on tiles that form a single square or
rectangle.

4. Click to complete the merge. Note that two previously merged cells can also be
merged.

5. Click on a merged cell and then click E to unmerge the cell.

6. Click Save to save the custom layout.

To edit a custom layout:

1. Ensure that the custom layout to be edited is closed in the Viewer Panel, and then
right-click on a custom layout in the Custom View/Custom Layout window and select
Edit.
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2. Make the required changes to the custom layout and click Save.

To make a custom layout public (client/server installations only):

Right-click on a custom layout in the Custom View/Custom Layout window and select
Make Public to make the custom layout available across the network.

Note: Public custom layouts cannot be made private, and only the user who created
the custom view can delete it.

Digital zoom

Navigator can perform digital zoom in/out functions in the live and recorded view. To
zoom in, select a tile and scroll up with the mouse wheel. Scroll down to zoom out.
When in digital zoom mode, click and hold the left mouse button to navigate in the
zoomed image.

Note: Press Ctrl before scrolling the mouse wheel to enable digital zoom on a PTZ
camera.

PTZ controls

To use PTZ controls, the camera must be identified to the recording device as a PTZ
camera.

To activate a camera for PTZ:

1. Right-click the recorder icon in the Navigator panel and select Properties.

2. Click the Cameras tab and select the PTZ Enabled check box next to the PTZ
camera.

3. Click OK. The camera’s icon in the Navigator panel changes from a fixed camera
icon to a PTZ camera icon.

To control a PTZ camera using the PTZ controls:

1. Drag a PTZ camera from the Navigator panel into the Viewer and select it.

2. Click the PTZ icon ™8 on the Controller toolbar above the timeline to open the PTZ
window.
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« PTZ button — Click and hold the arrows on the PTZ button to move the camera
in different directions.

¢ Zoom —Clickthe - and + buttons to zoom in and out inside the PTZ camera
video tile.

* Focus, Autofocus — Click the - and + buttons to manually focus the camera,
or click the {= button to autofocus.

* lIris —Click the - and + buttons to adjust the size of the camera iris. The
amount of light allowed into the camera increases as the iris opening gets larger.

* Speed — Set the speed to the appropriate level for the network and operations.

Note: PTZ control responsiveness varies depending on the frame rate, resolution,
and quality of the video stream. D1/ 30FPS/Quality 9 provides the most responsive
PTZ control over the network. Weigh PTZ control responsiveness against storage
requirements to find the best fit. The PTZ speed setting can also be balanced with
the stream configuration to find the best fit.

Preset positions

* Go to a camera preset by clicking the Preset Positions tab, choosing a preset
number from the drop-down list, and then clicking Go To.

» Create a new camera preset by using PTZ controls to find the required camera
view, clicking the Preset Positions tab, typing a name into the Preset Name field (if
required), and then clicking Set.

« Name or rename a preset by selecting the preset number from the drop-down list
and typing a new name into the Preset Name field.

Tours

A tour is a series of checkpoints assigned in a specific sequence with times assigned to
reach each point.

e Goto a tour preset by clicking the Tours tab, choosing a preset number from the
drop-down list, and then clicking Go To.

* Record a tour preset by clicking Record and performing a series of PTZ control
actions. When finished, click Stop.

Note: The tours function is not available for all PTZ cameras. See Appendix B “Device
details” on page 151 for applicable functionality.

To control a PTZ camera using mouse commands within the video tile:

1. Drag the PTZ camera from the Navigator panel into the Viewer and select it.

2. Place the cursor in the center of the Viewing tile.

3. Left-click and hold the mouse, then drag in any direction. Note that the further from
center the cursor is positioned, the faster the camera moves.
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4. Optical zoom: Scroll up with the mouse wheel to zoom in and scroll down with the
mouse wheel to zoom out.

5. Digital zoom: Press and hold Ctrl and scroll up with the mouse wheel to zoom in and
scroll down with the mouse wheel to zoom out. Press and hold Ctrl and zoom out as
far as possible to deactivate digital zoom.

Note: An Interlogix camera with a motorized lens can also be controlled as a PTZ
camera with the PTZ controls for iris and focus adjustments.

Cameratile context menu

Right-click on a video tile containing a camera to bring up a context menu. Available
selections are as follows:

Search

This function is the same as searching from a recorder, but only the camera selected
can be searched. See “Search” on page 96.

Instant replay

Right-click on a video tile containing a camera and select Instant Replay or click on the
Instant Replay button on the video tile to go from Live to Playback by a user-defined
and pre-configured period of time (30 seconds is the default setting) for quick viewing of
an incident. See “Instant replay duration” on page 26 for instant replay setup
instructions.

To start instant replay in a video tile, do one of the following:

» Click the Instant replay button in the lower left corner of the video tile.

* Right-click on the video tile and select Instant Replay.

» Set the Live/Playback toggle switch in the timeline to Playback.

To stop instant replay in a video tile, do one of the following:
* Right-click on the video tile and select Live.

» Set the Live/Playback toggle switch in the timeline to Live.

Sync to this video

This selection appears in the context menu for cameras in playback mode that are
connected to a recorder. Selecting Sync to this video plays back all videos in the
Viewer (up to a maximum of nine) at the same current playback time/date of the
camera being synced to. An “S” icon in the top status bar of the video tile indicates
synced videos.
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If a synced camera is set to record events instead of a continuous live stream, gaps in
recording are indicated by a display of the last frame recorded before the gap occurs.
The video resumes when it reaches the time that the next event was recorded.

Note: Certain cameras/conditions cannot be synced for playback:
» Local file playback and recording
e VStream

» Cameras connected as devices (e.g., using an SD card rather than a
recorder)

* No permission for camera playback

Live

Select Live in the context menu to return to the live stream.

Start local recording

See “Local record” on page 110.

Snapshot

Taking a snapshot of a selected video tile containing a camera sends a still image file
to the Collector for export.

To take and deploy a snapshot:

1. Click the Snapshot button above the timeline or right-click a video tile containing a
camera and select Snapshot.

2. Right-click on the snapshot in the Collector panel to Print Preview, Print, Email,
Rename, or Export the snapshot image. See “Export video and snapshots” on
page 130.

Dewarp views

Dewarping provides an alternate view other than the fisheye image normally associated
with 360° cameras. This feature only requires one fisheye view (live or playback) from
the device. The Navigator dewarps multiple views from a single dewarped view.

To enable dewarping:

1. Right click on the camera recorder and select Properties.

2. Select the Fisheye check box.

3. The Mount Type drop-down list is set to Ceiling by default. If required, select Wall
or Desktop.
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To access dewarped views:
1. Right click on the camera video tile and select Dewarp Views.

2. Select a view from the context menu. A new video tile opens with the dewarped
view type indicated in the video tile header bar.

PTZ
A maximum of 31 PTZ views can be dewarped from a single 360° camera.

Click the left mouse button inside the PTZ video tile and drag it in any direction to
change the view. A red square inside the camera tile indicates the position of the
dewarped view as the four-headed arrow cursor is moved inside the PTZ video tile.

Panoramic 180

This selection displays two 180° views inside a single video tile. Only one Panoramic
180 view can be dewarped from a single 360° camera, and then all other dewarp views
become unavailable.

Panoramic 360

This selection displays a 360° view inside a single video tile. Only one Panoramic 360
view can be dewarped from a single 360° camera, and then up to 30 additional PTZ
dewarp views become available.

Heat map

Note: The heat map function is only supported by TruVision 360° cameras. The 360°
camera must be added by itself to the Navigator panel (so that it has its own device
node) and must have a memory card installed to obtain heat map data.
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A heat map is a color-coded graphical representation of the movement of objects or
people through a scene. The colors correspond to the amount of traffic, and the amount
of time spent stationary in the configured scene.

To set up the heat map:

1. In the Navigator panel, right-click on the device icon associated with a 360° camera
and select Configure Device.

2. Type the user name and password and click Login.
3. Click the Configuration tab and then click Heat Map.

4. Select Enable Heat Map. For detailed instructions on heat mapping configuration,
follow the instructions in the heat map section of the TruVision 360° Camera
Configuration Manual.

To view heat map statistics:

1. After following the instructions above to set up a heat map, right-click on the video
tile of a 360° camera and select Heat Map. The heat map statistics window
appears.

2. Select a Report Type (Daily, Weekly, Monthly, or Annually), and then select a date
from the Statistics Time drop-down list.

3. With Image Heat Map selected under Statistical Results, click Export Image to
save a heat map image.

4. With Time Heat Map selected under Statistical Results, click Export to CSV to
save heat map statistics in Excel format.

Display analytics rules

Note: Display analytics rules (Motion, VCA, and Thermal OSD) only work with
cameras that support this feature. Devices that support display analytics rules are
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indicated in the “Stream Overlay” row in the device details tables by the “VCA Rules”
entry in Appendix B “Device details” on page 151.

Enabling analytics rules for motion and VCA provides dynamic display indicators in the
video tile for each selection. Motion and VCA indicators, as well as the on-screen
drawing that defines a region of interest, differ depending on the model of recorder.

Motion

To enable motion analytics for newer IP cameras:

1. Right click on the camera’s recorder and select Manage IP Cameras.
2. Under Camera Setup, click Motion Detection.

3. Select the camera to display motion from the Camera drop-down list.
4

. Select the Enable Motion Detection and Enable Dynamic Analysis for Motion
check boxes.

5. If necessary, draw a new area setting in the Area Settings tab and select Notify
Alarm Host in the Actions tab so that motion notifications display in the Notifier
panel. Close the configuration window.

6. Right-click the camera’s video tile and select Display Analytics Rules > Motion to
enable or disable motion analytics. Motion analytics may appear as green
rectangles in the video tile when they occur.

VCA

To enable VCA analytics for newer IP cameras:

1. Right click on the camera’s recorder and select Manage IP Cameras.

Under Camera Setup, click VCA.

Select the camera to display VCA analytics from the Camera drop-down list.
Select the Enable VCA Alarm check box.

A

If necessary, select Notify Alarm Host in the Actions tab to so that VCA
notifications display in the Notifier panel. Close the configuration window.
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6. Right-click the camera’s video tile and select Display Analytics Rules > VCA to
enable or disable VCA analytics. VCA analytics may appear as red rectangles in the
video tile when they occur.

Thermal OSD (thermal cameras only)

Note: The thermal camera must be added by itself to the Navigator panel (so that it has
its own device node).

Right-click a thermal camera’s video tile and select Display Analytics Rules >
Thermal OSD to enable or disable on-screen temperature display.

Stream

Change the Stream setting by clicking the Main/Sub toggle switch above the timeline
or by right-clicking on a video tile and selecting Stream > Sub or Stream > Main.

The Main setting provides the highest possible resolution while the Sub setting
activates a substream that provides lower resolution video that does not consume as
much bandwidth.

POS mode

This function enables point of sale (POS) data display (from a device such as a cash
register or ATM) in a video tile. The device providing the POS information must work in
conjunction with a the legacy ProBridge 3 text converter or via the NPCII, a third party
converter of SHL Systems (www.shlsystems.de).

The converter acts as a bridge between the recording device and the Point-of-Sale
(POS) device (a cash register or ATM, for example). It feeds the POS text data into the
recording device where it is tagged to the applicable video.

The NPCII is compatible with the following recorders:

* TVN21 (via RS-232)

* TVN22 (via RS-232 and IP)

e TVR45HD (only for analog cameras; via RS-232 and IP)
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To activate POS mode:

To display POS data on top of the camera view, right-click on the POS-configured
camera’s video tile and select POS Mode > In Band.

To display POS data on the side of the camera view, right-click on the POS-configured
camera’s video tile and select POS Mode > Out of Band.

Trigger outputs

This function is the same as the recorder context menu in the Navigator panel. See
“Trigger outputs” on page 95.

Assign to Event Monitor

This function is the same as the camera context menu in the Navigator panel. See
“Assign to Event Monitor” on page 104.

Object counting

Note: The object counting camera must be added by itself to the Navigator panel (so
that it has its own device node) and must have a memory card installed to obtain object
counting data.

This function can be used with cameras that support object counting. Available
selections are as follows:

Statistics

Right-click on an object counting camera tile and select Object Counting > Statistics.

View object counting statistics by Report Type (select from Daily, Weekly, Monthly, or
Annually), Graph Type (select Bar Chart or Line Chart), and Statistics Time.

Click Export to CSV to export statistics data to an external file.
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Reset

Right-click on object counting camera tile and select Object Counting > Reset. This
action resets the Enter and Leave numbers in the object counting on-screen counter to
zero.

Display Counter

Right-click on object counting camera tile and select Object Counting > Display
Counter to display the object counting on-screen counter (Enter and Leave numbers).

Close

Closes the camera tile.

Map tile context menu

Right-click on a map tile to bring up a context menu. Available selections are as follows:

Zoom to fit

Focuses to the map image, eliminating any white space around the map in the Viewer
tile.

Close

Closes the map tile.
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Website tile context menu

Right-click a website tile in the Viewer to access Internet Explorer options. See Internet
Explorer Help for further information on these options.
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The Notifier panel is the central repository for notifications in Navigator. Devices send
these notifications over the network via TCP to the IP address of the TruVision
Navigator server. The firewall must be configured on the server to accept these network
notifications. Refer to the recorder’s or camera’s user manual for information on
configuring notifications so that they appear in the Notifier panel.

View video for live notifications as they are received by double-clicking on the camera
name link in the Notifier panel. This launches the video in the Viewer.

Note: Video is indicated by a video icon (with an arrow) next to the notification. If the
video icon is not next to the naotification, no video for the event is available.

Live notifications can be set to make an audible sound. See “Client” on page 23 for
more information on this feature. After 1000 notifications occur in the Notifier panel, the
oldest notifications are purged in the system.
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Filters

The Filters feature allows customization of the Notifier panel so that it shows only
certain types of notifications.

To set filters in the Notifier panel:
1. Click the Filters button in the Notifier panel.

2. Select one or more notification types to show only those types of notifications in the
Notifier panel. The Filters button turns red when a filter is set.

3. Click Close. To remove filters, click the Filters button and select All or click on the
individual notification types to remove the check marks.

Event center

The Event Center window provides a record of all events, both acknowledged and
unacknowledged, over a specified time range.
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To find, view, and acknowledge events in the Event Center:
1. Click the Event Center button in the Notifier panel to launch the Event Center.
2. Select the View Unacknowledged or View Acknowledged radio button.

3. Set filters to see only certain event types by selecting the check box next to each
event type.

4. Set a date range using the From and To drop-down lists.

5. Click the top of each column in the list of events to sort events by Device, Camera,
Alarms, Device Time, Local Time, or Message.

6. Click on the camera link in an event to view it in the Viewer panel.

7. Click Acknowledge All to acknowledge all unacknowledged events. After a live
notification is acknowledged, it is considered a stored or historic notification that can
be searched.

8. Click Export to export a list of the events displayed in the Event Center in CSV file
format.
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The Collector panel contains video and snapshots from the timeline (see “Timeline” on
page 109), the camera context menu in the Navigator panel (see “Export video” on
page 103), and the camera tile context menu in the Viewer panel (see “Local record” on
page 110).

To view a video clip in the Collector, double-click on the video’s thumbnail to launch it in
the Viewer. Double-click on a snapshot to play video from the camera that provided the
shapshot at the point in time the snapshot was taken.

To delete items from the Collector, right-click on an individual item’s thumbnail and
select Delete or click the Delete All button at the top of the Collector panel.

Export video and snapshots

Export all collected video and snapshots in the Collector panel to a specific location
either on demand or via a schedule.
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To export video or snapshots from the Collector:

1.

Click the Export button at the top of the Collector panel to export all videos and
snapshots, or right-click on an item in the Collector panel and select Export to
export it individually.

Click Browse and specify a destination location for export. Click the Show files in
folder link to view the current contents of the folder (you can also click the Show
files in folder button in the Collector toolbar to view folder contents).

Note: Make sure there is enough disk space at the destination location for the
export. Use the file size estimate in the Collector as a guideline.

To start the export process immediately, click the Export Now button. The export
task is automatically added to Tasks (see “Tasks” on page 47). A progress bar
appears below each video thumbnail to indicate export progress. Exports in
progress appear as green and turn to blue after export is complete.

To schedule the export process, click the Schedule button and specify a date/time
to start the export process. An export task is automatically added to Tasks.

Note: The Local Scheduling Service must be running to execute these export tasks.
Refer to the Services window for status and actions on all services.

When export tasks are complete, exported video and snapshots can be found at the
location specified along with the TruVision Navigator Player program. See
Chapter 10 “TruVision Navigator Player” on page 136.

Collector context menu

Right-click on a snapshot to make any of the following selections from the context
menu:

Print Preview

Print

Email

Rename (also available in the Collector video context menu)

Export (also available in the Collector video context menu)
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The Navigator client can still operate in a client/server configuration when the server is
offline. However, some configuration options are not available in server offline mode.

A dialog appears when starting Navigator with the server offline. It states: “While you're
offline, you'll be able to access video normally. Changes to the system configuration will
be disallowed.”

Server offline mode is indicated by the FE icon next to Admin in the Navigator screen.
The Notifier is empty and notifications do not appear when in server offline mode.

Note: The Navigator client can take up to five minutes to recognize the Navigator
server after the TruVision Navigator service is started.

Available options, server online and server offline mode:

Function Online Offline Mode
Navigator main menu Settings Settings
Tasks Storage Calculator
Storage Calculator Help
Help Logout
Logout
Settings window Client tab Client tab
Server tab

Notifications tab

Health Diagnostics tab
Groups and Users tab
Audit History tab

Logical Event Filtering tab

Add Folder menu Enabled Disabled

Add Devices menu Enabled Disabled
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Run Health Diagnostics
Import Address Book
Export Address Book

Open Exported Video File

Tasks
Device Management

Function Online Offline Mode
Devices menu Add Device Open Exported Video
Add Folder File

Device folder menu

Add Device
Add Folder
Delete Folder
Rename Folder

Disabled

Device offline menu

Connect

Delete Device
Rename Device
Properties

Connect
Properties

Device online menu

Run Tampering Monitor
Run Device Report

Run Health Diagnostics
Run Disk Analysis

Assign to Event Monitor

Run Health Diagnostics Trigger Outputs
Run Network Statistics Search
Run Disk Analysis Export Video
Trigger Outputs Reboot Device
Manage IP Cameras Properties
Search
Export Video
Configure Device
Reboot Device
Delete Device
Rename Device
Properties
Export Video window Export Now Export Now
Schedule
Properties window Enabled Device or camera detail
are visible but cannot be
changed.
Camera menu (camera icon) Search Search
Export Video Export Video
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Function Online Offline Mode
Camera menu (device icon) Run Tampering Monitor Run Health Diagnostics
Run Device Report Trigger Outputs
Run Health Diagnostics Search
Trigger Outputs Reboot Device
Search Properties
Configure Device
Reboot Device
Delete Device
Rename Device
Properties
Multi selection menu, devices Delete Devices Disabled
Multi selection menu, folders Delete Folders Disabled
(devices, maps, websites, access
control)
Maps main menu Add Map Disabled
Add Folder
Maps folder menu Add Map Disabled
Add Folder
Delete Folder
Rename Folder
Map menu Configure Map Disabled
Rename Map
Delete Map
Multi selection menu, maps Delete Maps Disabled
Websites main menu Add Website Disabled
Add Folder
Website menu Configure Website Disabled
Delete Website
Website folder menu Add Website Disabled
Add Folder
Delete Folder
Rename Folder
Multi selection menu, websites Delete Websites Disabled
Access Control main menu Add Panel Global Lockout
Add Folder Global Reinstate
Global Lockout
Global Reinstate
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Function

Online

Offline Mode

Access Control panel menu

Configure Panel
Recent Activities
Delete Panel
Rename Panel
Reinstate All Doors
Lockout All Doors
Unlock All Doors
Properties

Reinstate All Doors
Lockout All Doors
Unlock All Doors
Properties

Access Control panel menu

Enabled

Enabled

Multi selection menu, access
control panels

Delete Panels

Disabled

Intrusion Detection main menu

Add Panel
Add Folder
Global Arm
Global Disarm

Disabled

Intrusion Detection panel menu

Configure Panel
Delete Panel
Rename Panel
Arm All

Disarm All
Properties

Disabled

Network Switches main menu

Add Device
Add Folder

Disabled

Network Switch menu

Configure Device
Delete Device
Rename Device
Display Front Panel
Run Network Statistics
System Reboot
Refresh

Properties

Run Network Statistics
System Reboot
Refresh

Logical Views main menu

Add Logical View
Add Folder

Disabled

Logical View folder menu

Add Folder

Add Logical View
Rename Folder
Delete Folder

Disabled

Logical View menu

Edit
Delete

Disabled
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TruVision Navigator Player

The TruVision Navigator Player is a standalone player that can be used to replay any
video clip exported using TruVision Navigator (proprietary file formats include .wvf,
.mpc, .asf, .mp4, and .drv). This player should be copied to media along with video clips
for authorities. It launches from the media itself and does not require installation to a
computer.

To play video with the TruVision Navigator Player:

1. After exporting video clip(s) from the Collector to the user-defined location, launch
the TruVision Navigator player by double-clicking the TruVision Navigator Player
icon in the file folder where the video clips are located.

IMPORTANT: The player.bin file must be in the same directory as the TruVision
Navigator Player.exe file for the TruVision Navigator Player to work.

2. The player automatically sweeps the directory and loads the associated video clips
in the Video File Selector panel from that directory. Double-click on a camera icon in
the Video File Selector panel to populate the next video tile. The default view is 9-up
with a maximum of 16-up. Other custom views are available.
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The features of the TruVision Navigator Player are as follows:

Toolbar, viewer, and panels

Open — Browse for a specific video clip in another directory and load it into the
Video File Selector panel.

Preserve Aspect Ratio — Click View > Preserve Aspect Ratio to see the video in
its original aspect ratio (not resized to fit the video tile).

Dewarp View — Click View > Dewarp View to access dewarped views. See
“Dewarp views” on page 119 for details.

Custom View — A total of 12 different video tile viewing configurations are available.
Default view is 9-up.

Maximize Screen — Launches a full screen view.

Audio — Listen to audio (if present) for only the selected video tile by right-clicking
on the tile and selecting Enable Audio. If all video tiles are selected, no audio will
play.

Video File Selector Panel — Contains a detailed list of video clips available for
playback. Double-click on a camera icon in this panel to populate the next video tile.

Select All — Select this check box to select all video tiles. After all video tiles are
selected, playback controls affect all video tiles and not just a single one. However,
each clip begins at its own start time and ends at its own end time. This holds true
for the snapshot capability as well.

Bookmarks Panel — Double-click on a bookmark in the Bookmarks panel to jump to
the bookmark during a selected video’s playback. Right-click on a bookmark in the
Bookmarks panel to view bookmark details.

Time/Date Stamp — Each video has a time/date stamp on it for evidentiary
purposes.

Double-click any video tile to go to full screen or use the maximize button in the tool
bar.

Double-click any video tile to return to the normal state.

When in full screen mode, right-click to hide/show the playback controls. Only the
video tiles display.

Timeline functions

Timeline — Jump ahead or back in time for a single selected video tile. Click the
Zoom In Timeline, Zoom Out Timeline, Center the Play Cursor, Scroll Left,
Scroll Right, and Go To buttons to manage timeline playback.

Playback Controls — FFWD, RWD, Play, Pause, Frame Reverse, Frame Advance,
and Loop.

Sync All — Click this icon to start all video clips at the same time.
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Note: As the video clips are played, there may be time gaps due to the different
video settings on each clip source (e.qg., different frame per second (fps) settings).
This function ensures that the initiation of playback for all tiles happens at the same
time to keep the time gaps between the clips at a minimum.

* Snapshot — Take a snapshot of the highlighted video tile(s) by clicking the Export
Snapshot button. Select the cameras to take snapshots from, and then click
Snapshot.

* Local File Information — View details about the selected video clip including the
device type and address, camera name, start and end times, and file location.
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Using a compatible keypad

Compatible keypads provide an alternate method of navigating the TruVision Navigator
user interface. A high level of usability and control can be achieved by connecting
keypads and using them with the Navigator client.

Compatible keypads are:
* Interlogix TVK-400USB

Connecting the keypad

The keypad must be connected to the client machine’s USB port before launching the
Navigator client. The keypad driver is installed automatically the first time the keypad is
connected.

A successful connection of the keypad is indicated by the keypad icon appearing in the
bottom right of the Navigator screen.

Calibrating the keypad

We recommend calibrating the keypad to avoid erratic PTZ movements.

To calibrate the keypad:

Follow the instructions above for connecting the keypad.

1. Goto Control Panel > Devices and Printers.

2. Right-click on the VM Desktop icon and select Game controller settings.

3. The Game Controllers window appears. Click Properties.
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4. Click the Settings tab, and then click Calibrate.

5. The Device Calibration Wizard appears. Click Next.

6. The Find Center Point window appears. Leave the joystick handle centered, press a
button on the keypad, and then click Next.

7. The Axis Calibration window appears. Move the joystick handle in complete circles,
press a button on the keypad, and then click Next.
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Note: Select Display Raw Data to see a numerical value for the current position of
the joystick.

8. The Verify Center Point window appears. Leave the joystick handle centered, press
a button on the keypad, and then click Next.

9. The Z Axis Calibration window appears. Twist the PTZ knob on top of the joystick
handle, press a button on the keypad, and then click Next.

10.The X Axis Calibration window appears. Move the joystick handle all the way up and
down, press a button on the keypad, and then click Next.
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11.Click Finish to save the calibration settings.

12.Click the Test tab in the VM Joystick Interface properties window.

13.Test the joystick by moving it and observing onscreen behavior. The Axes indicators
should indicate a value of 50% after moving the joystick or PTZ knob as far as
possible one way or the other.

14.Press buttons on the keypad to test their functionality. Pressing a button should
illuminate one of the circled numbers in the Buttons section.

15.Click Apply, and then click OK when finished.
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Keypad functions

Figure 2: TVK400USB keypad

Enter. Enters PTZ camera presets.

Sub/Main stream switching.

Number keys for selecting presets.

Snapshot

Go to playback.

Switch to live.

Scroll. Scrolls between video tiles in multi-

up view and scrolls the timeline in one-up

view.

8. Wheel. Rotate right to fast forward and
rotate left to rewind.

9. Fast forward

10. Pause/resume

11. Rewind

NooghswhpE
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Joystick. PTZ: Rotate knob to zoom
infout, joystick moves the camera. Non
PTZ: Rotate knob to zoom in/out, joystick
pans inside the zoom in view.

Zoom. Live: Zooms the camera in/out.
Playback: Zooms in/out on the timeline.
Iris open/close

Focus near/far

Set preset. Press this button, a preset
number, and Enter to enter a new PTZ
preset.

Toggle between one-up and multi-up
views.

Local record
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Minimum system
requirements

Software requirements

The following operating systems and other software components are prerequisites for

client and server installation:

Note: 32-bit operating systems are not compatible with TruVision Navigator 8.0.

Table 5: Client software requirements

Component Version

Notes

Operating System Microsoft Windows 7 SP1 64-bit
Microsoft Windows 8.1 64-bit

Microsoft Windows 10 64-bit
Microsoft Windows Server 2012 R2 64-bit
Microsoft Windows Server 2016

WInPCAP needs to be
installed separately and ran
in compatibility mode for
operation on Windows 8
systems

Other Microsoft .NET Framework 4.6 Packaged with the
installation

Table 6: Server software requirements

Component Version Notes

Operating System Microsoft Windows 7 64-bit
Microsoft Windows 8 64-bit

Microsoft Windows 10 64-bit

144

WInPCAP needs to be
installed separately and ran
in compatibility mode for
operation on Windows 8
systems.

SQL drivers need to be
installed for Windows 8
before Navigator installation.
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Component Version Notes
Microsoft Windows Server 2012 R2 64-bit
Microsoft Windows Server 2016
Database Microsoft SQL Server Express Go to www.microsoft.com
for details on version
compatibility with the
operating systems listed
above.
Other Microsoft .NET Framework 4.6 Packaged with the
installation
Other Microsoft Visual C++ 2010 x64 Redistributable Packaged with the
10.0.40219 installation
Other WIinPCAP 4.1.3 Packaged with the

installation

Server/client hardware guidelines

The following specifications are only meant to serve as a guideline as Navigator system
performance varies according to the robustness of the machine.

Table 7: Server hardware specifications

Component Recommended

Notes

3rd Gen Intel® Core i5-3470
Processor (6 MB, 3.2 GHz)

CPU

Memory 16 GB RAM

Hard Drive 500 GB — 7200 RPM, SATA 3.0

Gb/s, 16 MB Cache

Graphics Card Nvidia® GeForce GTX 1060

Resolution 1920 x 1080
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CPU power is directly related to the
performance of the application when
running and rendering video. The better
the CPU, the more responsive the
application will be.

RAM is related to the number of different
applications that can run simultaneously as
well as the number of different operations
that TruVision Navigator can perform at
once. The higher the RAM, the better the
performance of the application.

Optional - TruVision Navigator requires
approximately 800 MB of storage to install.
To store exported video from the devices
on the local machine, an increase storage
size may be required.

Video Card capability is directly related to
the video rendering performance within
TruVision Navigator. The better the video
card, the better the video rendering
performance.
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Component Recommended

Notes

Network Integrated PCIE 10/100/1000

The network interface card can be a
performance bottle neck depending upon
the throughput of the card. If the card’s
throughput is less than the amount of data
streaming to the machine, performance
issues may occur.

Supported recording devices

Table 8 shows the supported recording devices and related firmware versions.

Table 8: Supported recording devices

UTC Devices

Supported Firmware

TruVision NVR10 (TVN 10/10S/10C/10CS)

TruVision NVR21 (TVN 21)
TruVision TVN22

TruVision TVR12HD
TruVision TVR15HD
TruVision TVR44HD
TruVision TVR45HD
TruVision TVR46

TruVision NVR71 (TVN 71)
TruVision NVR70 (TVN 70)
TruVision NVR11 (TVN 11)
TruVision NVR20 (TVN 20)*
TruVision NVR50 (TVN 50)*
TruVision DVR10 (TVR 10)*

TruVision DVR11/11C (TVR 11/11C)*
TruVision DVR12/12C (TVR12/12C)*

TruVision DVR40 (TVR 40)*
TruVision DVR41 (TVR 41)*
TruVision DVR42 (TVR42)*
TruVision DVR60 (TVR 60)*
Interlogix DVSR-xU*

2.0b
3.1k
2.1b
1.2,
1.0
1.2
1.0
1.0
1.0e
1.2
1.0c
3.2a
2.2i
2.7
3.1b
1.2d
3.2d
3.0c
1.2d
4.7a
2.31s

* These models are in End of Life status and not actively supported.
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IMPORTANT: A wired network connection is required for device discovery. Do not use
a Wi-Fi network connection to discover devices.

Note: Unmanaged devices do not support the discovery feature.

Intrusion panels

Table 9 below shows the discoverable intrusion panels and related firmware versions.

Table 9: Discoverable intrusion panels

UTC Devices

Supported Firmware

UltraSync Self-Contained Hub
UltraSync Modular Hub

ZeroWire

xGen

B0403001A58P002011-33 or later
B0403001A56P002005-01 or later
B0403001A58P002010-31 or later
B0403001A56P002005-16 or later

Transmission products

Table 10 below shows the discoverable transmission products and related firmware

versions.

Table 10: Discoverable transmission products

UTC/GE Devices

Supported Firmware

ES2402-16P-2C
ES2402-24P-2C
ES2402-8P-2C
GE-DSSG-244-POE
NS3500-28T-4S
NS3500-24T-4C
NS3502-8P-2S
NS3503-16P-4C
NS3550-24T/4S
NS3550-2T-8S
NS3552-8P-2S
NS3552-8P-2S-V2
NS3553-4P-1T-2S
NS3601-24P/4S
NS3702-24P-4S
NS3702-24P-4S-V2
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1.5b150623
1.5b170503
1.5b150623
1.5b131203
1.5v140718
1.5b180308
1.5b131120
1.5b160906
1.0b120719
1.5b131120
1.5b160215
1.5b180920
1.5b180130
1.5b121207
1.5b140618
1.5b180706
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UTC/GE Devices Supported Firmware
NS4702-24P-4S-4X 1.5180129
NS4702-24P-4X 1.5b180129
NS4750-24S-4T-4X 1.5b140710
NS4802-24P-4S-2X 1.5b150713
POC2502-16CXP-2T-2S 1.5b160906
POC2502-8CXP-2T-2S 1.5b150717

Note: See the TruVision Navigator Compatibility with IFS Switches Addendum for
further information about supported features.

Internet Explorer plug-in requirements

The following ActiveX control settings are prerequisites for Navigator installation.

To enable the settings:

1. Open Internet Explorer.

2. Click the Tools menu, and then click Internet Options.
3. On the Security tab, click the Custom level button.
4

. Scroll down and select the Enable radio button under Automatic prompting of
ActiveX controls.

5. Select the Prompt (recommended) radio button under Download signed ActiveX
controls.
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6. Select the Enable radio button under Run ActiveX controls and plug-ins.
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Windows 8 installation requirements

Navigator can be installed on Windows 8 platforms with the prerequisites below met
before installation. Microsoft Windows 8 OS needs to fully support Microsoft SQL
database drivers before the TruVision Navigator installation starts. Therefore, these
prerequisites are required to make a system ready for TruVision Navigator installation.

Follow these instructions before installing Navigator in a client/server
configuration on Windows 8 platforms:

Windows 8 without SQL installed:
* Must install all the important updates from Microsoft.
« Manually install WinPcap 4.1.2 before or after installing Navigator.

* Navigator installs SQL 2008 express if it does not detect SQL installed in the
machine.

Windows 8 with SQL2008 Express R2 SP1 or SP2 installed:
e Must install all the important updates from Microsoft.
* Manually install WinPcap 4.1.2 before or after installing Navigator.

* Navigator allows the user to use existing SQL 2008 Express.

To make the WinPcap program compatible with Windows 8:
1. Right-click on the WinPcap.exe file and select Properties.
2. Click the Compatibility tab.

3. Select the Run this program in compatibility mode for: check box, select
Windows 7 from the drop-down list, and then click Apply.

4. Right-click on WinPcap.exe and select Run as Administrator.
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Summary

This appendix contains important compatible device information.

TruVision Camera

Feature Support Notes
Supported TVB, TVC, TVD, TVE, TVF, TVW,
Device(s) TVP, UVP, RS

(Interlogix Open Standard Cameras)
H.265 Support Depends on model (S4 or later)

Default Ports Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 80 (editable)
RTSP =554 (editable)

Default N/A Activation required
Username /

Password

Default IP 192.168.1.70

Address

Network Supported

Discovery

Compression H.264, H.265

Connection TCP

Types UDP

Streaming Limits  Depends on the actual device
capabilities

Stream Overlay =~ VCA Rules, Motion Rules, Camera
Name, Date and Time

High / Low No
Bandwidth
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Feature

Support

Notes

Dual Streaming

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot
Local Record
Instant Replay
Disk Analysis

Time Line Disk
Analysis

Video Export

TruVision
Navigator Player

PTZ Control
Focus, Iris, Zoom
Presets

Tours

Camera Search

Smart Search
Point-of-Sale Text
Motion

Audio

Bi-directional
Audio

Notifications

Health
Diagnostics

Firmware Upload
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Yes

The Main stream is referred to as:
TruVision Navigator = Main stream

The Substream is referred to as:
TruVision Navigator = Substream

Play

Pause

Frame Advance

Fast Forward (1x, 2x,4X, 8x)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Live and Playback*
Yes

Yes

Yes*

No

Yes

Yes*

Yes

Yes*
Yes*
Yes*
Yes*

Alarm
Event
Motion
VCA

No
No
Yes
Yes

Yes

No

Yes

Yes

Depends on the actual device capabilities.

Video jumps back four seconds after resuming
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile remains paused until the user clicks the
Live button in the Controller. No other playback
controls will work until the Live button is selected.

*For models that support SD cards.

*For models that support SD cards.

*For models that support SD cards.

.mp4 proprietary file format.

*For TVP and UVP models
*For TVP and UVP models
*For TVP and UVP models
*For TVP and UVP models

Via browser page.
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Feature Support Notes
Bulk Firmware No

Upload

Device Yes Via browser page.
Configuration

Bulk No

Configuration

Remote Reboot  Yes

Device log Yes Via browser page.
support

Trigger Outputs  Yes

Fisheye Dewarp  Yes

Sync Playback Yes

Get Thumbnail No

Change IP Yes

Activate Yes

Reset Password | Yes

Change Yes

Password

Excel No

Configuration

Push

HTTPS Yes

Reset Factory Yes

Default

Sync Time (NTP) | Yes

Network Storage | No

Backup & Yes

Restore System

Config

Dual NIC No

DDNS Yes

Mobile App Yes (TVRMobile)
RTSP Live Yes

RTSP Playback | Yes
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TruVision TVN71/ TVN70/ TVN21/ TVN22 /
TVR12HD / TVR44HD / TVR45HD / TVR46 /

Feature Support Notes
Supported 1.0e (TVNT71)
Firmware 1.2.j (TVN70)
versions 1.0c (TVN11)
3.1.m (TVN21)
2.1.b (TVN22)
1.2.9 (TVR44HD/TVR12HD)
1.1a (TVR45HD)
1.0 (TVR46)
1.1b (TVR15HD)
H.265 Support Yes (TVN71/TVN22 / TVR45HD
(for IP cameras only))
Yes (TVR46)
No (TVN70/ TVR44HD / TVR15HD /
TVR12HD / TVN21)
Default Ports Video = 8000 (editable)
Command and Control = 8000
(editable)
Configuration = 80 (editable)
Notifications = 5001 (editable)
RTSP =554 (editable)
Default N/A Activation required
Username /
Password
Default IP 192.168.1.82
address
Network Supported
Discovery
Compression H.264/H.265
Connection TCP
Types UDP

Streaming Limits

Stream Overlay

POS Text
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256 Live streams and 128 Playback
streams (TVN71)

128 Live or Playback streams
VCA Rules, Motion Rules, Camera
Name, Date and Time

TVN21 (via RS-232)

TVN22 (via RS-232 and IP)

TVR45HD (only for analog cameras;
via RS-232 and IP)
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Feature Support Notes
High / Low No

Bandwidth

Dual Streaming Yes

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot
Local Record

Instant Replay

Disk Analysis

Time Line Disk
Analysis

Video Export

TruVision
Navigator Player

PTZ Control
Focus, Iris, Zoom
Presets

Tours

The Main stream is referred to as:
TruVision Navigator = Main stream
The Substream is referred to as:
TruVision Navigator = Substream

Play

Pause

Frame Advance

Fast Forward (1x, 2x, 4x, 8X)
Slow motion (1.0x, 0.5x, 0.25x,

0.125x, 0.0625x)
Live and Playback
Yes

Yes

Yes

Alarm

Motion

Recorded

VCA

Text (except TVR45HD / TVR15HD)

Yes

Yes

Yes

Yes
Yes
Yes

Yes
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Frame reverse and rewind speeds directly depend
on the actual device capabilities.

Video jumps back four seconds after resume
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile will automatically switch to live view.

There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. After the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration in the TruVision Navigator
Settings window, Server tab. As a result, this time
should be set to an increment to greater than five
minutes. If a search is executed for video still in
the buffer, Live video appears.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 15-45 seconds
depending on the amount of recorded data on the
device.

Video Loss is only supported for Analog Channels
for TVR44HD / TVR12HD / TVR45HD / TVR15HD.

.mp4 proprietary file format.

Dependent on camera and device.
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Feature Support Notes
Camera Search  Alarm
Event
Motion
Text
VCA
Smart Search Yes
Point-of-Sale Text Yes
Motion Yes
Audio Yes
Bi-directional Yes
Audio
Noatifications Alarm To set up the device to send TCP notifications for
Video Loss (TVR44HD / TVR12HD /  cameras, right-click on the device in the Navigator
TVR45HD / TVR46 / TVR15HD) and select Configure Device. On the Camera
. tab’s Event Section, select the events and set the
Motion . ,
schedules as appropriate. On the Camera tab’s
VCA Rules Section, for each event type, ensure that
Disk Full “notify me” is selected. Repeat for each event type.
Disk Failure On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.
To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. For each notification type on
the Notification tab, ensure that “notify me” is
selected. Repeat for each notification type and
click Save. Ensure the notification port on the
device matches that of TruVision Navigator Server
as described above.
Restart both the Notification Writer and Notification
Processor for TruVision Navigator to process the
notifications.
Email notification is not supported at the device-
level.
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Feature Support Notes
Health IP Address
Diagnostics MAC Address

Model Name

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

IP Camera
Support

Device Log
Support

Trigger Outputs
Fisheye Dewarp
Sync Playback
Get Thumbnail
Change IP
Activate

Reset Password

Change
Password

Excel
Configuration
Push

HTTPS

Reset Factory
Default

Sync Time (NTP)

Network Storage

Serial Number

Firmware Version

Device Date/Time

Total Device Health

HDD Status

HDD Capacity

Cameras in Video Loss
Cameras in Alarm

Current Client Connections
Record Status

Yes Via browser page.

No

Yes Via browser page.

No

Yes

Yes (TruVision)
Onvif

Yes

Yes
Yes
Yes
Yes (TVR46)
Yes
Yes
Yes

Yes

Yes Newer NVRs

Yes

Yes

Yes

Yes
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Feature Support Notes

Backup & Yes

Restore System

Config

Dual NIC Yes Depends on model
DDNS Yes

Mobile App Yes (TVRMobile)

RTSP Live Yes

RTSP Playback | Yes

TruVision TVR10 (DVR)

Feature Support Notes
Supported 2.7

Firmware

Versions

H.265 Support No

Default Ports

Default
Username /
Password

Default IP
address

Network
Discovery

Compression

Connection
Types

Streaming Limits

Stream Overlay

High / Low
Bandwidth

Dual Streaming
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Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

admin /1234

192.168.1.82

Supported

H.264

TCP
UDP

24 Live or Playback streams
simultaneously with a maximum of
six streams per channel.

Camera Name
Date and Time

No

Yes

We recommend changing this default password at
the time of installation.

If users try to open more streams than a recorder
supports, they will get a black video tile containing
an error message.
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Feature Support

Notes

Stream The Main stream is referred to as:
Nomenclature
On-Screen-Display = Time Lapse
Web Browser = Main stream
TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = N/A
Web Browser = Substream
TruVision Navigator = Substream
Playback Play
Controls Pause
Frame Advance
Fast Forward (1x, 2x,4x, 8x 16x)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Digital Zoom Live and Playback
Snapshot Yes
Local Record Yes
Instant Replay Yes
Disk Analysis Alarm
Motion
Recorded

Time Line Disk Yes

Analysis

Video Export Yes
TruVision Yes
Navigator Player

PTZ Control Yes
Focus, Iris Yes
Control

TruVision Navigator 8.0 SP2 User Manual

Event Stream is not supported on the device.

Frame reverse and rewind speeds are not
supported.

Video jumps back four seconds after resuming
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile remains paused until the user clicks the
Live button in the Controller. No other playback
controls will work until the Live button is selected.

Pause during local record is not supported.

There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. Once the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration in the TruVision Navigator
Settings window, Server tab. As a result, set this
time increment to greater than five minutes. If a
search is executed for video still in the buffer, Live
video appears.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 15-45 seconds
depending on the amount of recorded data on the
device.

There will be approximately four seconds of
additional video exported prior to the specified start
time.

.mp4 proprietary file format.
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Feature Support Notes

Presets Yes

Tours GoTo Only one tour is supported (which is hard coded to

Record Tour 1 on the PTZ camera).

Camera Search  Alarm

Event
Motion

Smart Search No

Point-of-Sale Text No

Motion Yes Get the configuration for this device via TruVision
Navigator and set the active zones on a per camera
basis via the Motion Configuration option
associated with each camera.

Audio Yes There is one audio input per device. That input can
be mapped to any camera on the device simply by
enabling audio on that camera. Access the setting
by going to the device configuration, and enabling
the audio option for each camera. If enabled, as
soon as any camera from the device is added in the
TruVision Navigator Viewer and selected, the audio
plays.

Bi-directional No

Audio

Notifications Alarm To set up the device to send TCP notifications for

Video Loss cameras, right-click on the device in the Navigator

Motion and select Configure Device. On the Camera tab’s

_ Event Section, select the events and set the

Disk Full schedules as appropriate. On the Camera tab’s

Disk Failure Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.
To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. For each natification type on
the Notifications tab, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.

160 TruVision Navigator 8.0 SP2 User Manual



Appendix B: Device details

Feature Support Notes
Health IP Address
Diagnostics MAC Address

Model Name

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

IP Camera
Support

Device log
support

Trigger Outputs
Fisheye Dewarp
Sync Playback
Get Thumbnail
Change IP
Activate

Reset Password

Change
Password

Excel
Configuration
Push

HTTPS

Reset Factory
Default

Serial Number

Firmware Version

Device Date/Time

Total Device Health

HDD Status

HDD Capacity

Cameras in Video Loss
Cameras in Alarm

Current Client Connections
Record Status

Yes

Yes

Yes

Yes

Yes
N/A

Yes

Yes
N/A
No
No
Yes
No
Yes

Yes

No

No

Yes
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TruVision TVR11/TVR12 (DVR)

Feature Support Notes
Firmware 3.1.b (TVR11/11C)
Versions

H.265 Support

Default Ports

Default
Username /
Password

Default IP
Address

Network
Discovery

Compression

Connection
Types

Streaming Limits

Stream Overlay

High / Low
Bandwidth

Dual Streaming

162

1.2.d (TVR12/12C)
No

Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

admin /1234

192.168.1.82

Supported

H.264

TCP
uUbP

64 Live or Playback streams
including those used by the web

page.
Camera Name
Date and Time

No

Main streams and substreams are
available on live view mode only.

We recommend changing this default password at
time of installation.
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Feature

Support Notes

Stream
Nomenclature

The Main stream is referred to as:
On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = Alarm

Web Browser = Alarm

TruVision Navigator = Substream

The Event stream is referred to as:

On-Screen-Display = N/A
Web Browser = Event
TruVision Navigator = Event

The Schedule stream is referred to

as:
On-Screen-Display = Schedule
Web Browser = Schedule
TruVision Navigator = Schedule
Playback Play
Controls Pause
Frame Advance
Fast Forward (1x, 2x, 4x, 8x)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Rewind (1x, 2x, 4x) - Eight videos

simultaneously

Digital Zoom Live and Playback
Snapshot Yes
Local Record Yes
Instant Replay Yes
Disk Analysis Alarm
Motion
Recorded

TruVision Navigator 8.0 SP2 User Manual

Video jumps back four seconds after resuming
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or live video), the video automatically
switches to live view.

There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. Once the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration on the TruVision Navigator
Server Properties tab. As a result, set this time
increment to greater than five minutes. If a search
is executed for video still in the buffer, Live video
appears.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 15-45 seconds
depending on the amount of recorded data on the
device.
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Feature Support Notes

Time Line Disk Yes

Analysis

Video Export Yes There will be approximately four seconds of
additional video exported prior to the specified start
time.

TruVision Yes .mp4 proprietary file format.

Navigator Player

PTZ Control Yes

Focus, Iris, Zoom Yes

Presets Yes

Tours GoTo Only one tour is supported (which is hard coded to

Record Tour 1 on the PTZ camera).

Camera Search  Alarm

Event
Motion
Text

Smart Search Yes

POS Text Yes

Motion Yes Get the configuration for this device via TruVision
Navigator and set the active zones on a per camera
basis via the Motion Configuration option
associated with each camera.

Audio Yes There are four audio inputs per device. That input
can be mapped to any camera on the device simply
by enabling audio on that camera. Access the
setting by going to the device configuration, and
enabling the audio option for each camera. If
enabled, as soon as any camera from the device is
added in the TruVision Navigator Viewer and
selected, the audio plays.

Bi-directional Yes

Audio
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Feature

Support

Notes

Notifications

Health
Diagnostics

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

IP Camera
Support

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

Yes

Yes
N/A

TruVision Navigator 8.0 SP2 User Manual

To set up the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera tab’s
Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. On the Notifications tab, for
each notification type, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.

Restart the Notification Processor service for
TruVision Navigator to process the notifications.

Email naotification is not supported at the device-
level.
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Feature Support Notes
Device Log Yes

Support

Trigger Outputs Yes

Fisheye Dewarp  N/A

Get Thumbnail No

Change IP Yes

Activate Yes

Reset Password | Yes

Change Yes

Password

Excel No

Configuration

Push

HTTPS No

Reset Factory Yes

Default

TruVision TVR40 (DVR)
Feature Support Notes
Supported 3.2d

Firmware

Versions

H.265 Support No

Default Ports

Default
Username /
Password

Default IP
Address

Network
Discovery

Compression

Connection
Types

166

Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

Administrator / 3477

192.168.1.82

Supported

H.264

TCP
UDP

We recommend changing this default password at
time of installation.
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Feature

Support

Notes

Streaming Limits

Stream Overlay

High / Low
Bandwidth

Dual Streaming

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot

Local Record

24 Live or Playback streams
simultaneously with a maximum of
six streams per channel.

Camera Name

Date and Time

No

Yes

The Main stream is referred to as:
On-Screen-Display = Schedule
Web Browser = Main stream
TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = N/A

Web Browser = Substream
TruVision Navigator = Substream

The Event stream is referred to as:
On-Screen-Display = Event

Web Browser = Event

TruVision Navigator = Event

The Time Lapse stream is referred
to as:

On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Time Lapse

Play

Pause

Frame Advance

Fast Forward (1x, 2x,4x, 8x 16X)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Live and playback
Yes

Yes
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If users try to open more streams than a recorder
supports, they will get a black video tile containing
an error message.

The Substream, Event, and Time Lapse streams
are derivative configurations of the Main stream.

Typically, the Main stream is recorded on a
schedule, the Event stream is recorded on Event,
the Time Lapse stream is recorded continuously,
and the Substream can be viewed Live.

Frame Reverse and Rewind Speeds are not
supported.

Video jumps back four seconds after resume
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile remains paused until the user clicks the
Live button in the Controller. No other playback
controls will work until the Live button is selected.

Pause during local record is not supported.
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Feature Support Notes
Instant Replay Yes There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. After the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration on the TruVision Navigator
Settings window, Server tab. As a result, this time
should be set to an increment to greater than five
minutes. If a search is executed for video still in the
buffer, Live video appears.
Disk Analysis Alarm Video Loss is not supported in disk analysis.
Motion Disk analysis takes approximately 45 to 90 seconds
Recorded depending on the amount of recorded data on the
device.
Untagged
Timeline Disk Yes
Analysis
Video Export Yes There will be approximately four seconds of
additional video exported prior to the specified start
time.
TruVision Yes .mp4 proprietary file format.
Navigator Player
PTZ Control Yes

Focus, Iris, Zoom Yes

Presets Yes
Tours GoTo
Record

Camera Search  Alarm
Event
Motion
Text

Smart Search No

Point-of-Sale Text Yes

Motion Yes
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PTZ protocol GE RS-485 does not support Focus
and Iris commands in this release.

Only one tour is supported (which is hard coded to
Tour 1 on the PTZ camera).

Overlay on video only. To display POS data on top
of the camera view, right-click on the POS-
configured camera’s video tile and select POS
Mode > In Band.

Get the configuration for this device via TruVision
Navigator and set the active zones on a per camera
basis via the Motion Configuration option
associated with each camera.
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Feature

Support

Notes

Audio

Bi-directional
Audio

Notifications

Health
Diagnostics

Firmware Upload

Bulk Firmware

Upload

Yes

Yes

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

TruVision Navigator 8.0 SP2 User Manual

There are 16 audio inputs per device (one per
channel). Enabling audio on the device is a per
channel setting. Access the settings by going to the
device configuration, and enabling the audio option
on the Recording tab for each camera. If enabled,
as soon as any camera from the device is added in
the TruVision Navigator Viewer and selected, the
audio will play.

To set up the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera tab’s
Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. On the Notification tab, for
each notification type, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.

Restart the Notification Processor service for
TruVision Navigator to process the notifications.
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Feature Support Notes
Device Yes

Configuration

Bulk Yes

Configuration

Remote Reboot Yes

IP Camera N/A
Support
Device Log Yes
Support

Trigger Outputs  Yes
Fisheye Dewarp | N/A
Get Thumbnail No
Change IP Yes
Activate No

Reset Password | Yes

Change Yes
Password

Excel No
Configuration

Push

HTTPS No

Reset Factory Yes
Default

TruVision TVR41 / TVR42 (DVR)

Feature Support Notes
Supported 3.0c (TVR 41)
Firmware 1.2d (TVR42)
Versions
Support H.265 No
Default Ports Video = 8000 (editable)
Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

Default admin / 1234 We recommend changing this default password at
Username / time of installation.

Password

Default IP 192.168.1.82

Address
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Feature Support Notes
Network Supported

Discovery

Compression H.264

Connection TCP

Types UDP

Streaming Limits

Stream Overlay

High / Low
Bandwidth

Dual Streaming

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot

Local Record

64 Live or Playback streams
simultaneously including those used
by the web alarm.

Camera Name

Date and Time

No

Yes

The Main stream is referred to as:
On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = Alarm

Web Browser = Alarm

TruVision Navigator = Substream

The Event stream is referred to as:
On-Screen-Display = N/A

Web Browser = Event

TruVision Navigator = Event

The Schedule stream is referred to
as:

On-Screen-Display = Schedule
Web Browser = Schedule
TruVision Navigator = Schedule

Play Video jumps back four seconds after resume
Pause playback from Fast Forward and Frame Advance.

Frame Advance
Fast Forward (1x, 2x, 4x, 8X)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Rewind (1x, 2x, 4x) -8
simultaneously

Live & Playback
Yes

Yes
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When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile remains paused until the user clicks the
Live button in the Controller. No other playback
controls will work until the Live button is selected.
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Feature Support Notes

Instant Replay Yes

Disk Analysis Alarm Video Loss is not supported in disk analysis.

Motion Disk analysis takes approximately 15-45 seconds

Recorded depending on the amount of recorded data on the
device.

Untagged

Timeline Disk Yes

Analysis

Video Export Yes There will be approximately four seconds of
additional video exported prior to the specified start
time.

TruVision Yes .mp4 proprietary file format.

Navigator Player

PTZ Control Yes

Focus, Iris, Zoom Yes

Presets Yes

Tours GoTo Only one tour is supported (which is hard coded to

Record Tour 1 on the PTZ camera).

Camera Search ~ Alarm

Event
Motion
Text

Smart Search Yes Browser only

Point-of-Sale Text Yes

Motion Yes Get the configuration for this device via TruVision
Navigator and set the active zones on a per camera
basis via the Motion Configuration option
associated with each camera.

Audio Yes There are four audio inputs per device. That input
can be mapped to any camera on the device simply
by enabling audio on that camera. Access the
setting by going to the device configuration, and
enabling the audio option on the Recording tab for
each camera. If enabled, as soon as any camera
from the device is added in the TruVision Navigator
Viewer and selected, the audio will play.

Bi-directional Yes

Audio
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Feature

Support

Notes

Notifications

Health
Diagnostics

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

Yes

Yes

Yes

TruVision Navigator 8.0 SP2 User Manual

To set up the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera tab’s
Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. On the Notification tab, for
each notification type, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.

Restart the Notification Processor service for
TruVision Navigator to process the notifications.

Email naotification is not supported at the device-
level.
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Feature Support Notes
IP Camera N/A
Support

Device Log Yes
Support

Trigger Outputs Yes
Fisheye Dewarp  N/A
Get Thumbnail No
Change IP Yes
Activate No
Reset Password  Yes
Change Yes
Password

Excel No
Configuration

Push

HTTPS No
Reset Factory Yes

Default

TruVision TVR60 (Hybrid DVR)

Feature Support Notes
Supported 4.7a

Firmware Versions

Support H.265 No

Default Ports

Default Username
/ Password

Default IP Address

Network Discovery

Compression

Connection Types

Streaming Limits
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Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Noatifications = 5001 (editable)
Firmware Upload = 8000 (editable)

admin /1234

192.168.1.82
Supported
H.264

TCP
UDP
48 Live or Playback streams

simultaneously with a maximum of
six streams per channel.

We recommend changing this default password at
time of installation.

If users try to open more streams than a recorder
supports, they will get a black video tile containing
an error message.
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Feature

Support

Notes

Stream Overlay

High / Low
Bandwidth

Dual Streaming

Stream
Nomenclature

Playback Controls

Digital Zoom
Snapshot

Local Record

Camera Name
Date and Time

No

Yes

The Main stream is referred to as:
On-Screen-Display = Time Lapse

Web Browser = Time Lapse

TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = Alarm
Web Browser = Alarm

TruVision Navigator = Substream

The Event stream is referred to as:

On-Screen-Display = N/A
Web Browser = Event
TruVision Navigator = Event

The Schedule stream is referred to

as:
On-Screen-Display = Schedule
Web Browser = Schedule

TruVision Navigator = Schedule

Play

Pause

Frame Advance

Fast Forward (1x, 2x,4X, 8x,16Xx)

Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Live & Playback
Yes

Yes
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Frame Reverse, Rewind, and Playback Speeds
are not supported.

Video jumps back four seconds after resume
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile will remain paused until the user clicks
the Live button in the Controller. No other
playback controls will work until the Live button is
selected.

Pause during local record is not supported.
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Feature Support Notes

Instant Replay Yes There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. Once the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration in the TruVision Navigator
Settings window, Server tab. As a result, set this
time increment to greater than five minutes. If a
search is executed for video still in the buffer, Live
video appears.

Disk Analysis Alarm Video Loss is not supported in disk analysis.

Motion Disk analysis takes approximately 45 to 90

Recorded seconds depending on the amount of recorded
data on the device.

Untagged

Timeline Disk Yes

Analysis

Video Export Yes There will be approximately four seconds of
additional video exported prior to the specified
start time.

TruVision Yes .mp4 proprietary file format.

Navigator Player

PTZ Control Yes

Focus, Iris, Zoom  Yes PTZ protocol GE RS-485 does not support Focus
and Iris commands in this release.

Presets Yes

Tours Go To Only one tour is supported (which is hard coded to

Record Tour 1 on the PTZ camera).

Camera Search Alarm

Event
Motion

Smart Search No

Point-of-Sale Text No

Motion Yes Get the configuration for this device via TruVision
Navigator and set the active zones on a per
camera basis via the Motion Configuration option
associated with each camera.

Audio Yes There are 16 audio inputs per device (one per
channel). Enabling audio on the device is a per
channel setting. Access the settings by going to
the device configuration, and enabling the audio
option on the Recording tab for each camera. If
enabled, as soon as any camera from the device
is added in the TruVision Navigator Viewer and
selected, the audio will play.
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Feature

Support

Notes

Notifications

Health Diagnostics

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk Configuration
Remote Reboot
IP Camera Support

Device Log
Support

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

Yes

Yes
Yes
Yes

Yes
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To setup the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera
tab’s Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event
type. On the Notification tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To setup the device to send TCP natifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and
select Configure Device. On the Notification tab,
for each notification type, ensure that “notify me” is
selected. Repeat for each notification type and
click Save. Ensure the notification port on the
device matches that of TruVision Navigator Server
as described above.

Restart both the Notification Writer and Notification
Processor for TruVision Navigator to process the
notifications.

177



Appendix B: Device details

Feature Support Notes

Trigger Outputs Yes
Fisheye Dewarp N/A

Get Thumbnail No
Change IP Yes
Activate No

Reset Password Yes

Change Password Yes

Excel No
Configuration Push
HTTPS No
Reset Factory Yes
Default

TruVision TVN10/20/50 (NVR)

Feature Support Notes
Supported 2.1n (TVN 10, 10S, 10CS)
Firmware Versions 3 25 (TVN 20)
2.2i (TVN 50)
Support H.265 No
Default Ports Video = 8000 (editable)
Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

Default Username  admin / 1234 or no default We recommend changing this default password at

Default IP Address 192.168.1.82
Network Discovery Supported
Compression H.264

Connection Types TCP
UDP
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Feature Support Notes

Streaming Limits ~ TVN 10: 64 Live or Playback If users try to open more streams than a recorder
streams including those used by the supports, they will get a black video tile containing
web page. an error message.

TVN 20: 48 Live or Playback
streams simultaneously with a
maximum of six streams per
channel.

TVN 50: 128 Live or Playback
streams including those used by the

web page.
Stream Overlay Camera Name
Date and Time
High / Low No
Bandwidth
Dual Streaming Yes
Stream The Main stream is referred to as:
Nomenclature On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Main stream
The Substream is referred to as:
On-Screen-Display = Alarm
Web Browser = Alarm
TruVision Navigator = Substream
The Event stream is referred to as:
On-Screen-Display = N/A
Web Browser = Event
TruVision Navigator = Event
The Schedule stream is referred to
as:
On-Screen-Display = Schedule
Web Browser = Schedule
TruVision Navigator = Schedule
Playback Controls Play Frame Reverse and Rewind Speeds are not
Pause supported in TVN10 and TVN20 .
Frame Advance Video jumps back four seconds after resume
Fast Forward (2x,4x,8x,16x) playback from Fast Forward and Frame Advance.
Slow motion (1.0x, 0.5x, 0.25x, When fast forwaro_llng \_/ldeo and |t_catc_hes up to
0.125x, 0.0625x) present time (or Live video), the video in the
e viewing tile will automatically switch to Live view.
Rewind (1x, 2x 4x)
Digital Zoom Live & Playback
Snapshot Yes
Local Record Yes Pause during local record is not supported.
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Feature

Support

Notes

Instant Replay

Disk Analysis

Timeline Disk
Analysis

Video Export

TruVision
Navigator Player

PTZ Control

Focus, Iris, Zoom

Presets

Tours

Camera Search

Smart Search
Point-of-Sale Text

Motion

Audio

Bi-directional
Audio
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Yes

Alarm
Motion
Recorded

Untagged (TVN 10/TVN 20 only)

Yes

Yes

Yes

Yes

Yes

Yes

Go To
Record

Alarm
Event
Motion

Yes (TVN50 only)
Yes (TVN50 only)

Yes

Yes

Yes

There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. After the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those two features get their
time increment from the user-defined Instant
Replay configuration in the TruVision Navigator
Settings window, Server tab. As a result, set this
time increment to greater than five minutes. If a
search is executed for video still in the buffer, Live
video appears.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 45 to 90
seconds depending on the amount of recorded
data on the device.

There will be approximately four seconds of
additional video exported prior to the specified
start time.

.mp4 proprietary file format.

PTZ protocol GE RS-485 does not support Focus
and Iris commands in this release.

Only one tour is supported (which is hard coded to
Tour 1 on the PTZ camera).

Get the configuration for this device via TruVision
Navigator and set the active zones on a per
camera basis via the Motion Configuration option
associated with each camera.

There are 16 audio inputs per device (one per
channel). Enabling audio on the device is a per
channel setting. Access the settings by going to
the device configuration, and enabling the audio
option on the Recording tab for each camera. If
enabled, as soon as any camera from the device is
added in the TruVision Navigator Viewer and
selected, the audio will play.
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Feature

Support

Notes

Notifications

Health Diagnostics

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk Configuration
Remote Reboot
IP Camera Support

Device Log
Support

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

Yes

Yes
Yes
Yes

Yes
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To setup the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera
tab’s Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To setup the device to send TCP natifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. On the Notification tab, for
each notification type, ensure that “notify me” is
selected. Repeat for each notification type and
click Save. Ensure the notification port on the
device matches that of TruVision Navigator Server
as described above.

Restart both the Notification Writer and Notification
Processor for TruVision Navigator to process the
notifications.
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Feature Support Notes
Trigger Outputs Yes (TVN10 / TVN5O0 only)

Fisheye Dewarp Yes (TVN10 / TVN5O0 only)

Get Thumbnail No

Change IP Yes

Activate No

Reset Password Yes

Change Password Yes

Excel No

Configuration Push

HTTPS Yes (TVN10 only)

Reset Factory Yes

Default

TruVision TVN 11

Feature Support Notes
Supported 1.0e

Firmware

Versions

H.265 Support Yes

Default Ports

Default
Username /
Password

Default IP
address

Network
Discovery

Compression

Connection
Types

Streaming Limits

182

Video = 554 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
RTSP =554 (editable)

N/A Activation required

192.168.1.82

Supported

H.264, H.265

TCP
UDP

128 Live streams or Playback
streams
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Feature Support Notes
Stream Overlay =~ VCA Rules
Motion Rules

High / Low
Bandwidth

Dual Streaming

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot
Local Record
Instant Replay
Disk Analysis

Time Line Disk
Analysis

Camera Name
Date and Time

No

Yes

The Main stream is referred to as:
On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Main stream

The Sub stream is referred to as:
On-Screen-Display = Alarm

Web Browser = Alarm

TruVision Navigator = Sub stream

The Event stream is referred to as:
On-Screen-Display = N/A

Web Browser = Event

TruVision Navigator = Event

The Schedule stream is referred to
as:

On-Screen-Display = Schedule
Web Browser = Schedule
TruVision Navigator = Schedule

Play

Pause

Frame Advance

Fast Forward (1x, 2x, 4x, 8x)
Slow motion (1.0x, 0.5x, 0.25x,
0.125x, 0.0625x)

Live and Playback

Yes

Yes

Yes

Alarm
Motion
Recorded
VCA

Text

Yes

TruVision Navigator 8.0 SP2 User Manual

Frame reverse and rewind speeds not supported.

Video jumps back four seconds after resume
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile will automatically switch to live view.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 15-45 seconds
depending on the amount of recorded data on the
device.
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Feature Support Notes
Video Export Yes
TruVision Yes .mp4 proprietary file format.
Navigator Player
PTZ Control Yes
Focus, Iris, Zoom Yes
Presets Yes
Tours Yes Dependent on camera and device.
Camera Search  Alarm
Event
Motion
Text
VCA
Smart Search Yes
Point-of-Sale Text No
Motion Yes
Audio Yes
Bi-directional Yes
Audio
Notifications Alarm To set up the device to send TCP notifications for
Motion cameras, right-click on the device in the Navigator
VCA and select Configure Device. On the Camera tab’s
) Event Section, select the events and set the
Disk Full schedules as appropriate. On the Camera tab’s
Disk Failure Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.
To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. For each natification type on
the Notification tab, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.
Restart the Notification Processor for TruVision
Navigator to process the notifications.
Email notification is not supported at the device-
level.
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Feature Support Notes
Health IP Address
Diagnostics MAC Address

Model Name

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

IP Camera
Support

Device Log
Support

Trigger Outputs
Fisheye Dewarp
Sync Playback
Get Thumbnail
Change IP
Activate

Reset Password

Change
Password

Excel
Configuration
Push

HTTPS

Reset Factory
Default

Sync Time (NTP)

Network Storage

Serial Number

Firmware Version

Device Date/Time

Total Device Health

HDD Status

HDD Capacity

Cameras in Video Loss
Cameras in Alarm

Current Client Connections
Record Status

Yes Via browser page.

No

Yes Via browser page.

No

Yes

Yes (TruVision)
Onvif

Yes

Yes
Yes
Yes
No

Yes
Yes
Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Feature Support Notes
Backup & Yes

Restore System

Config

Dual NIC Yes

DDNS Yes

Mobile App Yes (TVRMobile)

RTSP Live Yes

RTSP Playback | Yes

DVSRxU

Feature Support Notes
Supported 2.31s

Firmware

Versions

H.265 Support No

Default Ports

Default
Username /
Password

Default IP
address

Network
Discovery

Compression

Connection
Types

Streaming Limits

Stream Overlay

High / Low
Bandwidth

Dual Streaming
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Video = 8000 (editable)

Command and Control = 8000
(editable)

Configuration = 8000 (editable)
Notifications = 5001 (editable)
Firmware Upload = 8000 (editable)

Administrator / 3477

192.168.1.10

Supported

H.264

TCP
UDP

24 Live or Playback streams
simultaneously with a maximum of
six streams per channel.

Camera Name
Date and Time

No

Yes

We recommend changing this default password at
time of installation.

If users try to open more streams than a recorder
supports, they will get a black video tile containing
an error message.
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Feature

Support

Notes

Stream
Nomenclature

Playback
Controls

Digital Zoom
Snapshot
Local Record

Instant Replay

Disk Analysis

The Main stream is referred to as:
On-Screen-Display = Schedule
Web Browser = Main stream
TruVision Navigator = Main stream

The Substream is referred to as:
On-Screen-Display = N/A

Web Browser = Substream
TruVision Navigator = Substream

The Event stream is referred to as:
On-Screen-Display = Event

Web Browser = Event

TruVision Navigator = Event

The Time Lapse stream is referred
to as:

On-Screen-Display = Time Lapse
Web Browser = Time Lapse
TruVision Navigator = Time Lapse

Play

Pause

Frame Advance

Fast Forward (2x, 4x)

Live and Playback
Yes
Yes

Yes

Alarm
Motion
Recorded
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The Substream, Event, and Time Lapse streams
are derivative configurations of the Main stream.

Typically, the Main stream is recorded on a
schedule, the Event stream is recorded on Event,
the Time Lapse stream is recorded continuously,
and the Substream can be viewed Live.

Frame reverse, rewind, and playback speeds are
not supported.

Video jumps back four seconds after resume
playback from Fast Forward and Frame Advance.

When fast forwarding video and it catches up to
present time (or Live video), the video in the
viewing tile will remain paused until the user clicks
the Live button in the Controller. No other playback
controls will work until the Live button is selected.

Pause during local record is not supported.

There is a two to five minute video buffer in the
device. While video is in the buffer, it cannot be
viewed. Once the buffer fills, the video is written to
the hard drive and is available for playback. This
affects Instant Replay and the Playback button in
TruVision Navigator. Those features get their time
increment from the user-defined Instant Replay
configuration in the TruVision Navigator Settings
window, Server tab. As a result, set this time
increment to greater than five minutes. If a search
is executed for video still in the buffer, Live video
appears.

Video Loss is not supported in disk analysis.

Disk analysis takes approximately 45-90 seconds
depending on the amount of recorded data on the
device.
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Feature Support Notes

Time Line Disk Yes

Analysis

Video Export Yes There will be approximately four seconds of
additional video exported prior to the specified start
time.

TruVision Yes .mp4 proprietary file format.

Navigator Player

PTZ Control Yes

Focus, Iris, Zoom Yes PTZ protocol GE RS-485 does not support Focus
and Iris commands in this release.

Presets Yes

Tours GoTo Only one tour is supported (which is hard coded to

Record Tour 1 on the PTZ camera)

Camera Search  Alarm

Event
Motion
Text

Smart Search No

Point-of-Sale Text Yes Overlay on video only. To display POS data on top
of the camera view, right-click on the POS-
configured camera’s video tile and select POS
Mode > In Band.

Motion Yes Get the configuration for this device via TruVision
Navigator and set the active zones on a per camera
basis via the Motion Configuration option
associated with each camera.

Audio Yes There are 16 audio inputs per device (one per
channel). Enabling audio on the device is a per
channel setting. Access the settings by going to the
device configuration and enabling the audio option
on the Recording tab for each camera. If enabled,
as soon as any camera from the device is added in
the TruVision Navigator Viewer and selected, the
audio will play.

Bi-directional Yes

Audio
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Feature

Support

Notes

Notifications

Health
Diagnostics

Firmware Upload

Bulk Firmware
Upload

Device
Configuration

Bulk
Configuration

Remote Reboot

Alarm
Video Loss
Motion

Disk Full
Disk Failure

IP Address

MAC Address

Model Name

Serial Number
Firmware Version
Device Date/Time
Total Device Health
HDD Status

HDD Capacity
Cameras in Video Loss
Cameras in Alarm
Current Client Connections
Record Status

Yes

Yes

Yes

Yes

Yes
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To set up the device to send TCP notifications for
cameras, right-click on the device in the Navigator
and select Configure Device. On the Camera tab’s
Event Section, select the events and set the
schedules as appropriate. On the Camera tab’s
Rules Section, for each event type, ensure that
“notify me” is selected. Repeat for each event type.
On the Notifications tab, the Notify IP Address
should be the IP address of where the TruVision
Navigator Server services are located (Notification
Writer and Notification Processor). The Notify Port
is defaulted to 5001 and is editable. Ensure this
port matches the one listed in the TruVision
Navigator Settings window, Notifications tab.

To set up the device to send TCP notifications for
the device itself (e.g., Disk Full and Disk Failure),
right-click on the device in the Navigator and select
Configure Device. For each natification type on
the Notification tab, ensure that “notify me” is
selected. Repeat for each natification type and click
Save. Ensure the notification port on the device
matches that of TruVision Navigator Server as
described above.

Restart both the Notification Writer and Notification
Processor for TruVision Navigator to process the
notifications.

Email naotification is not supported at the device-
level.
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Feature Support Notes
IP Camera N/A
Support

Device Log Yes
Support

Trigger Outputs Yes
Fisheye Dewarp  No
Get Thumbnail No
Change IP Yes
Activate No
Reset Password  Yes
Change Yes
Password

Excel No
Configuration

Push

HTTPS No
Reset Factory No

Default

Capabilities (Properties dialog)

Right-click on a first-generation recorder in the Navigator panel and select Properties

to display the Properties window.

The Capabilities tab contains a read-only list that indicates which video, camera, and
device controls as well which connection types are supported.
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Term

Definition

Access control

Address book

Bookmark

Bookmark manager

Dewarping

Digital output

DVR

Dwell time

Fisheye camera

Intrusion area

Intrusion sensor

IP camera

Logical event filtering

Physical restriction to access or entry. Requiring a security
badge to open a door is an example of access control.

A file containing the title, IP address, and credentials of
recorders and cameras in the Navigator panel. This data can be
imported or exported into Navigator as needed to save and
restore these settings.

Denotes a date and time on the timeline that can be returned to
quickly. Bookmarks contain editable information for describing
an event. See also “timeline” and “bookmark manager.”

The Bookmark Manager window is a central location that
contains all device-level bookmarks. See also “bookmark.”

Fisheye cameras produce an ultra-wide field of view image
which looks round and distorted. To make the image usable,
the image needs to be flattened out (dewarped).

Alarm output icons for recorders and cameras that appear in the
Configure Map window, can be dragged onto maps, and
triggered on or off.

Digital Video Recorder. A type of security footage recorder
connected to analog or coaxial cameras.

A user-selectable amount of time that a PTZ camera remains at
a preset before the camera moves to the next preset position.

Fisheye cameras produce an ultra-wide field of view image.

Icons that appear under the intrusion detection node in the
Navigator panel that indicate if an intrusion area defined in an
intrusion panel is disarmed, armed in stay mode, or armed in
away mode.

Intrusion sensors indicate the opened/closed state of a door or
window. For motion sensors, they appear as “opened” when
motion is being sensed.

A digital video camera that connects directly to the network with
its own IP address and has the ability to transmit images using
a standard communications protocols such as TCP/IP.

Logical event filtering provides a way to create customized,
interdependent notifications from cameras connected to
recorders as well as doors connected to TruPortal access
control systems.
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Main stream The video or audio stream that has priority. See also
"substream".
NTP Network Time Protocol. This synchronizes the time and date of

a device with an NTP server.

NVR Network Video Recorder. A type of security footage recorder
connected to IP cameras.

Object counting Refers to the number of people or objects detected passing
either direction across a virtual line drawn by the user in the
camera configuration Ul.

POS "Point-of-sale" as in a POS terminal. Examples: electronic cash
register or an ATM.

Preset A preconfigured action for a dome camera that will run
automatically after a defined dwell time.

ProBridge The ProBridge is a text translation device that captures an
ATM'’s transaction data and translates it to a format that can be
interpreted by a DVR.

PTZ Pan/Tilt/Zoom. A feature on cameras that can pan, tilt, and
zoom via computer control. PTZ allows for a larger viewing area
for a camera by allowing it to rotate in different directions.

Server offline mode Mode of operation in which the Navigator client can still operate
in a client/server configuration when the server is offline. Some
configuration options are not available in server offline mode.

Sequence A series of camera streams that are programmed to switch,
rotating one after another, in an individual video tile.

SMTP Simple Mail Transfer Protocol. A standard for e-mail
transmission across the network.

Substream A secondary video stream that is set at a lower quality setting to
reduce the amount of bandwidth needed. See also "main
stream".

Timeline A graphical view of video over an interval of time that allows
users to navigate through recorded videos.

Trigger alarm output A method used to notify when an alarm or event has occurred.
An external alarm output is triggered when an event occurs.

Tour A series of checkpoints assigned in a specific sequence with
times assigned to reach each point.

VCA Video Content Analytics. The intelligent analysis of video to
detect events of interest.

V-Stream When available bandwidth is limited, V-stream encoding allows
you to remotely view several channels in real time over the web
browser.
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Index

A

access control, 76

address book, 30

admin indicators, 11

assign to event monitor, 104, 124
audit history, 44

authentication complexity, 25

B

bookmark manager, 47
bookmarks, 111
buttons
event monitor tab, 109
viewer tab, 108

C

camera information, 63
camera menu
assign to event monitor, 104
configure camera, 103
export video, 103
preset sequences, 103
search, 102
smart search, 102
camera tile menu
assign to event monitor, 124
dewarp views, 119
display analytics rules, 121
instant replay, 118
object counting, 124
POS mode, 123
search, 118
shapshot, 119
start local recording, 119
stream, 123
sync to this video, 118
trigger outputs, 124
cameras
adding a 360° camera, 70
adding to Navigator panel, 66
configure camera, 103
configuring, 69
manage IP cameras, 96

remove icon from navigator panel, 69
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client download URL, 28
client settings, 23
collector panel, 130
export video and snapshots, 130
menu, 131
sending video from timeline, 110
configuration
cameras, 69
configure camera, 103
download/upload configuration, 100
maps, 72, 83
PTZ, 116
recorders, 69
web page, 69
websites, 76
configure device, 99
connection details, 18
custom Help, 26
custom layout, 115
custom view, 113

D

database backup and restore, 27
date and time sync, 61
decoder menu
add scene, 104
configure scene, 105
default user name/password, 10
delete device, 101
device activation, 57
device configuration backup, 62
device manager
activate device, 57
add device to Navigator, 65
change IP address, 60
date and time sync, 61
device configuration backup, 62
device discovery, 53
firmware upgrade, 58
new system setup wizard, 54
tools, 60
upload camera information, 63
device report, 92
devices menu
import/export address book, 30
open exported video file, 91
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run health diagnostics, 91 client/server mode, 17
dewarp views prerequisites, 16
panoramic 180, 120 standalone mode, 17
panoramic 360, 120 instant replay, 118
PTZ, 120 duration, 26
dewarping, 119 intrusion area, 83
diagnostic polling, 33 status, 84
diagnostics intrusion detection, 81
devices menu, 91 intrusion notifications, 83
recorder menu, 93 intrusion panels
digital ouputs supported intrusion panels, 147
operating, 76 intrusion sensor, 83
discovery tool, 68, 78 IP address
disk analysis, 94 changing, 60
export video, 94 iris, 117
play back video, 94
display analytics rules, 121 K
motion, 122
thermal OSD, 123 keypad
VCA, 122 compatible models, 139

connecting, 139

download configuration, 100 )
functions, 143

E

email notifications
health diagnostics, 32
event center, 128
event monitor, 104, 109
export video, 130
camera menu, 103
recorder menu, 97
recurring schedule, 97

F M
factory defaults, 100 main stream, 123

filters, 128 manage IP cameras, 96
map tile menu

L

languages, 12

LDAP servers, 30

local record, 110

logical event filtering, 45
logical views, 89

login, initial, 19

logout, 50

firmware '
manual update, 61 zoom to fit, 125
upgrade, 58, 99 maps, 71
folders, 90 intrusion areas, 83
intrusion notifications, 83
G intrusion sensors, 83
motion analytics, 122
group
adding a user, 43 N
assigning permissions, 42 ) .
creating, 41 Nawgator main menu
permission override, 43 recurring tasks, 48
search, 43 Navigator main menu
bookmark manager, 47
H settings, 22
tasks, 47
health diagnostics, 32 Navigator main menu
email notifications, 32 Help, 49
polling, 33 Navigator main menu
Help, 26, 49 device manager, 51
Navigator main menu
| storage calculator, 59
) ] Navigator panel
installation
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add device, 65 R
adding a 360° camera, 70 )
adding a v-stream, 71 reboot device, 100
adding folders, 90 recorder menu
adding intrusion detection, 81 configure device, 99
adding logical views, 89 delete/rename dewce,_ 101 _
adding maps, 71 downloa_d/upload configuration, 100
adding network switches, 85 export video, 97
adding recorders and cameras, 66 manage IP cameras, 96
adding TruPortal, 76 properties, 101
adding websites, 76 reboot device, 100
port information, 86 restore factory defaults, 100
search, 90 run device report, 92
network statistics, 93 run disk analysis, 94
network switches, 85 run health diagnostics, 93
configuration, 88 run network statistics, 93
front panel, 87 run tampering monitor, 91
port information, 86 search, 96
statistics, 87 trigger ouf[puts, 95
new system setup wizard, 54 upgrade firmware, 99
notifications settings, 30 recorders _
notifier panel, 31, 127 addl_ng tp Navigator panel, 66
event center, 128 configuring, 69
filters, 128 supported recorders, 146
recurring schedule, 97
0 recurring tasks
Navigator main menu, 48
object counting, 124 rename device, 101
open exported video file, 91 restore factory defaults, 100
P S
password scene
change, 61 add, 104
default, 10 configure, 105
reset, 64 search
permissions camera menu, 102
assigning to group, 42 camera tile menu, 118
assigning to user, 34 group, 43
group override, 43 Navigator panel, 90
indicators, 35 recorder menu, 96
permission models, 36 user, 43
playback controls, 14 video tagged with text, 96
playback video sequences, 103
timeline, 110 server
player hardware guidelines, 145
TruVision Navigator, 136 offline mode, 132
POS software requirements, 144
ProBridge, 96 starting, 132
text, 96 server settings, 24
POS mode, 123 authentication complexity, 25
preset client download URL, 28
positions, 117 client software delivery, 28
sequences, 103 custom Help, 26
ProBridge, 96, 123 database backup and restore, 27
properties, 101 instant replay duration, 26
PTZ permission models, 36
controls, 116 SMTP setup, 25
dewarp views, 120 settings
push to talk, 14 audit history, 44
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smart search, 102

SMTP setup, 25

shapshot, 119
exporting, 130

software delivery, client, 28

start local recording, 119

status bars, 108

storage calculator, 59

stream, 123

substream, 123

sync to this video, 118

system requirements
client software, 144
Internet Explorer plug-in, 148
server hardware guidelines, 145
server software, 144
supported intrusion panels, 147
supported recorders, 146
Windows 8 installation, 150

T

tabbed viewer panels, 107
tampering monitor, 91
tasks

Navigator main menu, 47
thermal camera OSD, 123
timeline, 109

bookmarks, 111

local record, 110

playback video, 110

sending video to the collector, 110
tours, 117
trigger outputs, 95, 124
TruPortal, 76
TruVision Navigator Player, 136

U

uninstall Navigator, 20
upgrade

firmware, 99

Navigator software, 20
upload

configuration, 100
user

adding, 34

adding to group, 43
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assigning permissions, 34
deactivate, 40
reset after lockout, 41
restore deactivated, 40
search, 43

user interface, 10
admin indicators, 11
buttons, 12
languages, 12

user name
default, 10

Vv

VCA analytics, 122
video tiles, 106, 108
digital zoom, 116
viewer panel
custom layout, 115
custom view, 113
digital zoom, 116
event monitor, 109
populating video tiles, 106
tab button functions, 108
tabbed viewer panels, 107
timeline, 109
video tile properties, 108
v-stream, 71

w

web page

configuration, 69
website tile menu, 126
websites, 76
Windows 8 installation, 150
wizard

new system setup, 54

Z

zoom to fit, 125
zoom, digital, 116
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